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International Business Machines Corporation
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Poughkeepsie, NY 12601-5400

USA

When you send information to IBM, you grant IBM a nonexclusive right to use or distribute the
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In countries other than the United States, Canada, and Puerto Rico, dial the appropriate
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 Copyright International Business Machines Corporation 1999.  All rights reserved.

Note to U.S. Government Users - Documentation related to restricted rights - Use, duplication or
disclosure is subject to restrictions set forth in GSA ADP Schedule Contract with IBM Corporation.

Note

Before using this information and the product it supports, read the general information
under "Notices" on page xiii.
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Notices

References in this publication to IBM® products, programs, or services do not imply
IBM intends to make these available in all countries in which IBM operates.  Any
reference to an IBM product, program, or service is not intended to state or imply
only that IBM product, program, or service may be used. Any functionally equivalent
product, program, or service that does not infringe on intellectual property rights of
IBM may be used instead of the IBM product, program, or service. The evaluation
and verification of operation in conjunction with other products, except those
expressly designated by IBM, are the responsibility of the user.

IBM may have patents or pending patent applications covering subject matter in this
document. The furnishing by IBM of this document does not give you any license to
these patents.  Send license inquiries in writing to the IBM Director of Commercial
Relations, IBM Corporation, Purchase, NY 10577, U.S.A.

Laser Compliance

The IBM FL200 module is certified in the United States to conform to requirements
of DHHS 21 CFR, Subchapter J, for Class 1 laser products. Elsewhere, the FL200
module is certified to be compliant with IEC 825 (1st edition 1984) and CENELEC
HD 482 S1 as a Class 1 laser product. The FL200 module is tested and approved
in Sweden as a Class 1 laser product by Statens Provningsanstalt (Swedish National
Testing Institute), and assigned the approval number SP LA 1989:118.

Class 1 laser products are not considered hazardous. The FL200 Module contains
a Class 3b, 5.0 milliwatt (nominal) indium gallium arsenide phosphide laser operating
in the wavelength region from 1270 to 1340 nanometers. The module is designed
such that there is never human access to laser radiation above a Class 1 level during
normal operation, user maintenance, or prescribed service conditions.

FL200 laser ports are designed and certified for use only with singlemode
optical fiber and connectors with characteristics specified by IBM.  Use
of other connectors or optical fiber can result in emission of laser power
levels capable of producing injury to the eye if viewed directly. Use of
non-specified connectors or optical fiber can violate the Class 1 laser
classification.

CAUTION
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FL200-laserporte er kun fremstillet til brug sammen med ’singlemode’
lysledere og stik, der svarer til lBM’s krav.  Anvendes andre stik eller
lysledere kan det give laserstråling, der skader øjet, hvis man ser direkte
ind i strålerne.  Bruges uautoriserede stik eller lysledere, kan der være
risiko for laserstråling ud over klasse 1.

Die IBM FL200 Laseranschlüsse sind nur für die Verwendung mit von der
IBM vorgeschriebenen einadrigen Glasfaserkabeln und Steckern
ausgelegt. Die Verwendung anderer Stecker oder Glasfaserkabel kann zur
Freisetzung von solch starker Laserstrahlung führen, daß das Auge bei
direktem Hineinsehen verletzt werden kann. Die Verwendung von Steckern/
Glasfaserkabeln, die nicht die von IBM angegebenen Eigenschaften
aufweisen, kann die Sicherheitsregeln für Laser der Klasse 1 verletzen.

FL200-laserportit on suunniteltu ja luokiteltu vain yksitoimisia
valojohdekaapeleita ja liittimiä varten, joiden ominaisuudet IBM on
määrittänyt.  Muiden valojohdekaapeleiden ja liittimien käyttö saattaa
lisätä lasersäteilyä, joka suoraan säteeseen katsottaessa voi aiheuttaa
näkövamman.  Tällaiset johtimet ja liittimet eivät täytä laserluokan 1
vaatimuksia.

PAS På

ACHTUNG

VAROITUS
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Les produits à laser du module de communication FL200 sont conçus
et certifiés pour être utilisés avec des connecteurs et une fibre optique
monomode dont les caractéristiques ont été spécifiées par IBM.
L’utilisation de tout autre connecteur ou fibre optique peut entrainer un
rayonnement à des niveaux pouvant être dangereux pour l’oeil en cas
d’exposition directe. De même, l’utilisation d’autres connecteurs ou fibre
optique pourrait signifier que le produit excède les limites de la classe 1.

Le aperture laser dell’lBM FL200 sono progettate e certificate per essere
usate solamente con connettori e fibre ottiche monomodali che abbiano
caratteristiche specificate dall’lBM.  L’uso di qualsiasi altra fibra 0
connetiore può produrre un’emissione con livelli di potenza laser capace
di procurare danni agli occhi se guardata direttamente. L’uso di connettori
0 fibre non specificati può violare la classificazione di laser di Classe 1.

FL200-laserportene er bare utformet og godkjent for bruk sammen med de
optiske kablene og kabelkontaktene som oppfyller kravene til IBM.  Bruk
av andre kontakter eller kabler, kan medføre laserstråling som kan skade
øyet hvis du ser rett på laserstrålen, og er et brudd på reglene for
laserprodukter i klasse 1.

ATTENTION

ATTENZIONE

ADVARSEL
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Os produtos a laser do modulo FL200 foram concebidos e certificados para
serem utilizados unicamente com fibras ópticas mono-modo e com
conectores cujas caracteristicas sejam as especificadas pela IBM.  A
utilização de outros conectores ou fibras poderá ocasionar radiações laser
a níveis tais que, em caso de exposição directa, poderão ser nocivas para
os olhos. Outros conectores ou fibras não especificados poderao violar a
classificação de Classe 1 para produtos a laser.

Portarna på lasermodulen FL200 är konstruerade och godkända endast för
optokablar och kontakter enligt lBMs specifikationer.  Andra kablar eller
kontakter medför risk för laserstrålning som kan skada gonen och kan göra
att utrustningen inte uppfyller kraven för laserprodukter i klass 1.

Data processing environments can contain equipment transmitting data on
system links with laser modules operating at greater than Class 1 power
levels. For this reason, it is advised to never look into the end of an optical
fiber cable or open receptacle.  Inspection or repair of optical fiber cable
assemblies and receptacles should be performed by trained service
personnel only.

CUIDADO

VARNING - RISK för PERSONSKADA

CAUTION
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Edb-miljøet kan indeholde udstyr med lasermoduler, der opererer ved
højere strålingsniveauer end klasse 1.  Af den grund må man aldrig se
direkte ind i enden af et lyslederkabel eller i en åben stikkontakt. Eftersyn
og reparation af lyslederkabler og stik må kun foretages af serviceteknikere.

ln der Datenverarbeitung können Geräte eingesetzt werden, die auf
Systemleitungen mit Lasermodulen übertragen, die die Werte der
Klasse 1 überschreiten.  Aus diesem Grund nie in das offene Ende eines
‘Glasfaserkabels oder einer offenen Anschlußbuchse schauen.  Die
Überprüfung und/oder Reparatur von Glasfaserkabeln darf nur von
Fachpersonal durchgeführt werden.

Tietojenkäsittely-ympäristöissä saattaa olla lasermoduuleita, jotka
toimivat suuremmalla kuin luokan 1 voimakkuudlella.  Älä koskaan katso
valojohdekaapelin päähän tai kaapelin avoimeen pistokkeeseen.
Valojohdekaapelin ja sen pistokkeen huolto sekä korjaus on annettava
koulutetulle huoltoedustajalle.

PAS På

ACHTUNG

VAROITUS
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Les installations informatiques peuvent inclure des équipements qui
utilisent des réseaux communs, tels que des modules à laser. Ces derniers
peuvent fonctionner avec un niveau énergetique, superieur aux limites
prescrites pour la classe 1. Il est donc recommandé de ne pas examiner à
l’oeil nu la section d’un câble à fibres optiques ou une prise de fibres
optiques ouverte. L’inspection ou la réparation des câbles a fibres optiques
ou des prises de fibres optiques ne doit être faite que par une personne
qualifiée.

Gli ambienti di elaborazione dati possono contenere apparecchiature che
trasmettono sui collegamenti del sistema con moduli laser che operano a
livelli di potenza superiori alla Classe 1. Per questa ragione, si raccomanda
di non guardare nell’estremità del cavo a fibra ottica 0 in una presa aperta.
L’ispezione e/o la riparazione di cavi a fibra ottica e prese deve essere
effettuata solo da personale di manutenzione specializzato.

EDB-miljøet kan bestå av lasermoduler som brukes ved høyere
strålingsnivå enn klasse 1.  Du må derfor aldri se rett inn i enden av en
fiberoptiske kablel eller en åpen stikkontakt. lnspeksjon eller reparasjon av
fiberoptiske kabler og stikkontakter må bare utføres av kvalifisert
personale.

ATTENTION

ATTENZIONE

ADVARSEL
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Electronic Emission Notices

Federal Communications Commission (FCC) Statement

Note: This equipment is tested and found to comply with the limits for a Class A
digital device, pursuant to Part 15 of the FCC Rules. The limits are designed
to provide reasonable protection against harmful interference when the
equipment operates in a commercial environment.  The equipment
generates, uses, and can radiate radio frequency energy, and if not installed
and used in accordance with the instruction manual, may cause harmful
interference to radio communications.  Operation of the equipment in a
residential area is likely to cause harmful interference, in which case the
user is required to correct the interference at his own expense.

Properly shielded and grounded cables and connectors must be used to meet FCC
emission limits. IBM is not responsible for any radio or television interference caused
by using other than recommended cables and connectors, or by unauthorized
changes or modifications to this equipment. Unauthorized changes or modifications
can void the user’s authority to operate the equipment.

Nos ambientes informáticos, pode existir equipamento que utilize redes
cujos módulos a laser funcionam em niveis de energia superiores aos
prescritos para a Classe 1.  Por esta razão, não se deve nunca olhar para
a extremidade de um cabo de fibras ópticas nem para uma caixa de ligação
de fibras ópticas que esteja aberta.   A inspecção e/ou reparação de
módulos com cabos de fibras ópticas, e das respectivas caixas de ligação,
apenas deve ser efectuada por pessoal técnico especializado.

Datorutrustning kan innehålla lasermoduler som arbetar med högre
effektnivåer an de som gäller för laserklass 1. Därför ska du aldrig titta in
i en optokabel eller i ett uttag för en sådan.  lnspektion och reparation av
optokablar och uttag ska utföras av utbildad servicepersonal.

CUIDADO
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This device complies with Part 15 of the FCC Rules.  Operation is subject to the
following conditions: (1) the device may not cause harmful interference, and (2) the
device must accept any interference received, including interference that may cause
undesired operation.

Avis de conformité aux normes du ministère des Communications
du Canada

Cet équipement ne dépasse pas les limites de Classe A d’émlsslon des bruits
radioélectriques pour les appareils numériques, telles que prescrites par le
Règlement sur le brouillage radioélectrique établi par le ministère des
Communications du Canada.  L’exploitation faite en milieu résidentiel peut
entraîner le brouillage des réceptions radio et télé, ce qui obligerait le propriétaire
ou l’opérateur á prendre les dispositions nécessaires pour en éliminer les causes.
Voir le Guide d’instructions.

Canadian Department of Communications Compliance Statement

This equipment does not exceed Class A limits per radio noise emissions for digital
apparatus, set out in the Radio Interference Regulation of the Canadian Department
of Communications.  Operation in a residential area may cause unacceptable
interference to radio and television reception, requiring the owner or operator to take
steps necessary to correct the interference.  Refer to the instruction manual.

Japanese Voluntary Control Council for Interference Statement

United Kingdom Telecommunications Safety Requirements Notice to
Customers

This apparatus is approved under approval number NS/G/1234/J/100003 for indirect
connection to public telecommunications systems in the United Kingdom.

European Community for Information Technology Equipment
(ITE) Statement

This device meets the following regulatory requirements set forth by the European
community for Information Technology Equipment (ITE).

• EN55022, ITE-Generic Emission standard for domestic, commercial, and light
industrial environments (CISPR 22 Class A).
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• EN55082-1, ITE-Generic Immunity standard for domestic, commercial, and
light industrial environments (IEC 801-2 through 801-6).  The device meets
European Community Mark Immunity Performance Criteria A, with the
exception being IEC 801-2, Electrostatic Discharge Immunity, which meets
Performance Criteria B. The software automatically restores the device to full
operation if performance degradation occurs, with no operator intervention
required.

European Community Electromagnetic Compatibility
Directive (All Countries)

This product conforms with all protection requirements of European Community
Council Directive 89/336/EEC, on the approximation of the laws of the Member
States relating to electromagnetic compatibility.

IBM cannot accept responsibility for any failure to satisfy the protection requirements
resulting from a non-recommended modification to the product, including the fitting
of non-IBM option cards.

Trademarks and Service Marks

The following terms, indicated by a registered trademark symbol (®) or trademark
symbol (™) on first use in this publication, are trademarks of the IBM Corporation in
the United States or other countries or both:

Registered T rademarks Trademarks

ESCON® DCAF™

IBM® ESCON Manager™

Operating System/2® FICON™

Operating System/390® SA/MVS™

OS/2® SA OS/390™

OS/390® System Automation for OS/390™

S/390® S/390 Parallel Enterprise Server™

Sysplex Timer®

System/390®

Win-OS/2®

Attention!

This is a Class A device.  In a domestic environment the product may cause
radio interference, in which case the user may be required to take adequate
corrective measures.
Notices      xxi



Windows®, indicated by a registered trademark symbol on first use in this publication,
is a registered trademark of Microsoft Corporation in the United States or other
countries or both.
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About This Publication

This publication provides information required to operate the IBM 9032-003 and
9033-004 Enterprise Systems Connection (ESCON®) Directors running Licensed
Internal Code (LIC) version 4.3 (or later), and the IBM 9032-005 Director running
LIC version 5.0 (or later), with or without the Fibre Connection (FICON™) converter
feature.  You should be familiar with:

• The Director and its operation.

• Messages and  status codes that may appear at the Director Console.

• Navigating in the Windows®-Operating System/2® (Win-OS/2®)
environment.

Who Should Use This Publication

This publication should be used by personnel required to operate the Director
Console or being introduced to the Director Console’s user interface.

How To Use This Publication

This publication is used both as a tutorial (for those trained but requiring a refresher
before resuming work with a Director), and as a manual for those who operate the
Director Console.

What Is Included in This Publication

This publication includes five chapters and one appendix organized as follows:

• Chapter 1 - lntroduction. This chapter introduces the 9032-003, 9033-004,
and 9032-005 Directors and Director Console, and compares characteristics
of the different Director models (including a comparison of 9032-002 and
9033-001 Directors). The chapter describes system configurations, dynamic
connectivity, the FICON converter feature (9032-005 Director only), port cards,
logical partitioning capability, and Director components.

• Chapter 2 - The Director Console.   This chapter describes the Director
Console, Console platforms, and Console operation and navigation in the
OS/2 environment. The chapter describes the windows (Startup, Matrix, log,
Terminal, and Port Maintenance) available through the Console application,
and describes Startup window menu options.

• Chapte r 3 - Matrix Window Operations. This chapter describes the Matrix
window, Matrix window components, and Matrix window menu options.
Tasks described in the chapter do not directly relate to configuring port
connections within a configuration matrix.
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• Chapter 4 - Configuring Port Connections. This chapter describes
configuration matrices, including port attribute symbols and connectivity
hierarchy.  The chapter also provides instructions to configure, save, and
activate a matrix.

• Chapter 5 - Console Administrative Functions.   This chapter describes
Console administrative functions, including installing LIC and Loader/Monitor
Area (LMA) code, administering passwords, creating logical partitions,
changing Director local area network (LAN) addresses, migrating a Director
database, and maintaining and using a backup or replacement Console.

• Appendix A - Console Messages. This appendix provides a list of error
messages, informational messages, and alert dialog messages with error
codes that appear at the Director Console.

A Glossary  and an Index are provided at the back of the publication.

Related Publications

The following publication applies to all Director models:

• Programming the Interface for Enterprise Systems Connection
Directors (SA23-0356).

The following publications provide information required to plan for, use, and maintain
9032-003, 9033-004, and 9032-005 Directors:

• Planning for the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Enterprise
Systems Connection Directors (SA22-7295).

• Planning for the 9032 Model 5 Director with FICON Converter Feature
(SA22-7415).

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Connection Director (SY27-3601).

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Connection Director (SY27-2638).

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

• Console Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033
Model 4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex
Timer (GA22-7291).

• User’s Guide Reference Summary for the 9032 Model 3 ESCON Director, 9033
Model 4 ESCON Director, and 9032 Model 5 Director (SA22-7298).

• Operator Panel Reference Summary for the 9032 Model 3 Enterprise
Systems Connection Director (SA26-6103).
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• Operator Panel Reference Summary for the 9033 Model 4 Enterprise
Systems Connection Director (SA22-7211).

• Operator Panel Reference Summary for the 9032 Model 5 Director
(SA22-7297).

• Up and Running OS/2 Warp V4 (S84H-3090).

Notational Conventions

The following table lists notational conventions used in this publication.

Function How Shown Example

Menu options Italics Passwords menu option

Keys and key combinations Bold Enter  or Alt+H  keys

Menu names Italics Help menu

Dialog boxes Italics Select Timer Network dialog box

Buttons on dialog boxes Italics OK button on the Select Timer
Network dialog box

Console input or output Courier Font Type c:\prtdrvs  and click
the OK button

Operator panel indicators Bold Set the event to HISTORY
status
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Chapter 1.  lntroduction

This manual applies to Console Application Version 5.0 (or later), supporting IBM
9032-003 and 9033-004 Enterprise Systems Connection (ESCON) Directors running
Licensed Internal Code (LIC) version 4.3 (or later), IBM 9032-005 Directors running
LIC version 5.0 (or later), and Director Consoles using Operating System 2 (OS/2®)
Warp 4 and the personal computer (PC) platform described in the manual.

Enterprise Systems Connection Directors

The Director dynamically controls data paths between host channels and ESCON
input/output (I/O) control units. The host channels and control units connect to the
Director through fiber-optic cables.  A Console is required to monitor the Director
and perform administrative, operations, and maintenance tasks. Directors and the
Director Console described in this publication are shown in Figure 1.

Figure 1.  Directors and the Director Console

The Console connects to multiple Directors through a 4/16 megabit per second
(Mbps) Token Ring local area network (LAN). The Console is attached to the same
(or bridged or routed) LAN as the Directors, and can be located anywhere within the
physical limitations of the LAN.

9032 Model 5
ESCON Director

9032 Model 3

ESCON Director

9033 Model 4
ESCON Director

Director

Multistation

Access

Unit (MAU)

Console
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Director models described in this publication are:

• A 9032 Model 3 (9032-003) Director that provides a minimum of seven ESCON
Device Port (DVP) cards (28 external connections) and a maximum of 31 DVP
cards (124 external connections). Additional DVP cards provide connections
in four-port increments.

• A 9033 Model 4 (9033-004) Director that provides a minimum of two ESCON
DVP cards (eight external connections) and a maximum of four DVP cards (16
external connections). Additional DVP cards provide connections in four-port
increments.

• A 9032 Model 5 (9032-005) Director that provides both ESCON and Fibre
Connection (FICON) capability.  DVP cards provide ESCON connections.
Fibre Channel Converter (FCV) port cards provide a converter feature that
connects to FICON channels of an IBM System/390® (S/390®) Generation 5
(or later model) Parallel Enterprise Server™.  Additional DVP cards provide
ESCON connections in eight-port increments, while additional FCV Port
cards provide FICON connections in one-port increments.

— The Director provides a minimum of three ESCON DVP cards (24 external
connections). There is no minimum requirement for FCV port cards. An
increase in physical FICON connections results in a corresponding
decrease in physical ESCON connections.

— If no FCV port cards are installed, the Director supports a maximum of 31
DVP cards (248 ESCON connections).

— If one FCV port card and 30 DVP cards are installed, the Director supports
one FICON connection and 240 ESCON connections.

— The Director supports a maximum of 16 FCV port cards (16 FICON
connections).  If 16 FCV port cards are installed, the Director supports
15 DVP cards (120 ESCON connections).

Purpose of the Director

All Director models provide dynamic connections between switch ports that attach
to ESCON servers and ESCON control units. The 9032-005 Director also provides
dynamic connections between FICON servers and attached ESCON control units.
All Director models also provide dedicated ESCON-to-ESCON connections (for
example, to a 9034 ESCON Converter). Establishing a connection from one port to
another to transfer commands and data is functionally equivalent for all Director
models.  Director port connections are qualified by the following attributes:

• Blocked  - All communication is blocked through a port.  How the blocking is
done is a function of the connection type.

• Dedicated - A static connection between two ports is dedicated and restricts
two ports from communicating with any other ports.  Dedicated connections
are required to support communication through a Director to a 9034 ESCON
Converter and to support chained Directors.

Note: Dedicated connections between a FICON port and an ESCON port are
not allowed.
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• Prohibited  - A prohibited connection means two specific ports cannot be
dynamically connected. However, this attribute does not affect a port’s ability
to connect dynamically with other ports on the Director. A port can be prohibited
from communicating with only one other port, with several ports, or with all
ports on a Director.

• Allowed  - A dynamic connection is allowed through a port.  If blocked,
dedicated, or prohibited attributes are not assigned to a port, the port is open
for a connection to another port.

Comparing 9032-003, 9033-004, and 9032-005 Directors

The similarities and differences in the functional characteristics of the 9032-003,
9033-004, and 9032-005 Directors are listed in Table 1.

Table 1.  Comparing 9032-003, 9033-004, and 9032-005 Directors

Functional Characteristic 9032-003 9033-004 9032-005

Maximum number of ESCON
ports

124 ports
(up to 62
simultaneous
connections)

16 ports
(up to eight
simultaneous
connections)

248 ports
(up to 124
simultaneous
connections)

Number of ports per DVP card Four ports Four ports Eight ports

Maximum number of FICON
ports Not applicable Not applicable 16 ports

Number of ports per FCV port
card Not applicable Not applicable One port

Spare ports card feature
(ESCON only) No No Yes

Standard dual power supplies No No

Yes (standard
power supply or
FICON upgrade
feature with +3.3
Vdc output)

Enhanced availability features Yes No Yes

Size Floor-standing Desktop Floor-standing

Matrix Controller/Matrix Switch
(MXC/MXS) card set Two cards One card

Three cards
(standard MXC
card or FICON
MXC2 card
upgrade feature)
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Enhanced Availability Features

The 9032-003 and 9032-005 Directors can have enhanced availability features
(EAFs) installed. EAFs are backup field-replaceable units (FRUs) that can be ordered
and installed to provide redundancy and reduce operational disruption in case of
failure.  The Director automatically switches over to the backup FRU if the primary
FRU fails.  The 9033-004 Director does not support EAFs.

Spare Ports Card Feature

The 9032-005 Director supports an optional spare ports card feature that provides
four dedicated spare ESCON ports. The feature provides either four light-emitting
diode (LED) ports, or two LED ports and two Extended Distance feature (XDF)
ports. The spare ports do not increase the number of active Director connections,
but allow port swapping between a failed port and a spare port. This feature does
not provide spare FICON ports.

FICON Upgrade Features

FICON compatibility is required to attach the 9032-005 Director to FICON channels
of an IBM S/390 Generation 5 (or later model) Parallel Enterprise Server.  If the
Director is not delivered with this capability, a FICON upgrade feature must be
installed. The FICON upgrade feature is not available for the 9032-003 and
9033-004 Directors.   The upgrade feature includes one or more FCV port cards
that provide hardware interfaces for FICON fiber-optic media, an MXC2 card that
provides switching control for both ESCON DVP cards and FCV port cards, and
redundant power supplies that provide additional +3.3 Vdc outputs to support
FICON operation.

Comparing 9033-001 and 9033-004 Directors

The differences in functional characteristics between the 9033-001 and 9033-004
ESCON Directors are:

• An enhanced Console user interface for the 9033-004

• Concurrent (hot swappable) Token Ring (TKRG) Controller card for
the 9033-004.

The 9033-001 Director supports two to four DVP cards (eight to 16 ports in four-port
increments), beginning with logical port address C0 and ending with logical port
address CF.  The 9033-004 Director also supports two to four DVP cards (eight to
16 ports in four-port increments), beginning with logical port address C0 and ending
with logical port address CF.

The Console for the 9033-001 Director has a character-based, menu-driven user
interface. The Console for the 9033-004 Director has a graphical user interface that
uses a mouse and Windows-Operating System/2 (Win-OS/2).  The 9033-004
Director uses the same Console as the 9032-003 Director.
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Comparing 9032-002 and 9032-003 Directors

The differences in functional characteristics between the 9032-002 and 9032-003
ESCON Directors are:

• An enhanced Console user interface for the 9032-003

• An enhanced-availability hardware feature for the 9032-003

• An increase in the number of physical port connections (up to 124) for
the 9032-003.

The 9032-002 Director supports seven to 15 DVP cards (28 to 60 ports in four-port
increments), beginning with logical port address C0 and ending with logical port
address FB.  The 9032-003 Director supports seven to 31 DVP cards (28 to 124
ports in four-port increments), beginning with logical port address 80 and ending with
logical port address FB.

The 9032-003 Director can have EAFs installed to provide redundancy and reduce
operational disruption in case of failure. EAFs include power supplies, DVP cards,
and TKRG Controller cards. Redundant power supplies and TKRG Controller cards
can be removed and replaced without powering off the Director and disrupting
operation. Redundant DVP cards allow an operator to logically reroute a connection
for a failed port (or DVP card) to a spare port.  The 9032-002 Director does not
support EAFs.

The Console for the 9032-002 Director has a character-based, menu-driven user
interface.  Options for categories such as Utilities and Maintenance are provided
through full-screen menus. The Console for the 9032-003 Director has a graphical
user interface that uses a mouse and Win-OS/2.  Options for categories such as
Utilities and Maintenance are provided through pull-down menus at the top of the
Matrix window.

System Configuration and ESCON Directors

Host systems can have multiple fiber-optic channels connected to one or more
Directors.  System configurations also includes I/O control units connected to one
or more Directors by fiber-optic cables. Figure 2 illustrates a typical Director
configuration.

• Directors can be controlled from a host connectivity management program
such as a System Automation for Operating System/390™ (SA OS/390™).
Changes are processed more safely through integration with the host operating
system across multiple system images.

Note: The Director Console application must be active for changes made by
SA OS/390 to reflect on Director Console windows.

• Up to 16 Directors (any combination of 9032-003, 9033-004, or 9032-005
Models), and up to two 9037-002 Sysplex Timer® networks (up to two Timers
per network) can be controlled from the Director Console. The Timer Console
application must be installed on the Director Console to support Sysplex Timer
operation.
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Figure 2.  Typical Director Configuration

This publication describes the Director (9032-003, 9033-004, and 9032-005 Models)
and Director Console.  This publication also provides the instructions required to
control, monitor, and operate the Director, and to perform certain Director Console
administration functions. To perform Director console functions associated with the
OS/2 operating system, refer to the Console Installation and User’s Guide: 9032
Model 3 ESCON Director, 9033 Model 4 ESCON Director, 9032 Model 5 Director,
and 9037 Model 2 Sysplex Timer (GA22-7291).

Dynamic Connectivity and Directors

The task of a Director is to enable dynamic connections between external ports for
the purpose of transferring commands and data between host systems (ESCON or
FICON) and ESCON control units.  When the command and data transfers are
complete, the Director disables the connection (unless the connection is dedicated,
rather than dynamic).  When a FICON channel, ESCON channel, or control unit
sends a request to the Director:

• The Director reads the address header of the request and determines the
destination for the information

• Activates the necessary physical connection

Host A Host B

Channel Channel CTC CTCChannel Channel CTC CTC

Director

Host-Attached Console
(SA OS/390)

Director Console

Director

Token Ring
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• Transfers the information (in both directions)

• Reads the trailer, breaks the physical connection (if specified), and waits for
the next request.

Although each Director port is connected to only one other Director port at a time,
multiple port pairs (up to 124 on a fully-populated 9032-005 Director) are connected
simultaneously.  Directors can enable and disable multiple connections millions of
times per second.  Director operation (enabling port connections, disabling port
connections, and transferring data) is transparent to other application programs.
Figure 3 shows multiple connection paths through a pair of Directors.

The Director also provides dedicated (static) connectivity to support 9034 ESCON
Converters and chained ESCON Directors.

Figure 3.  Director Dynamic Connectivity

Dynamic Connectivity

Figure 4 shows how Director functions are performed.  Host 1 is connected to a
Director and illustrates the concept of dynamic connectivity. Host 2 is connected to
the same Director and illustrates the concept of a dedicated connection and chained
Directors.

Channel B of Host 1 is attached to port 94 of the Director.  The Director enables a
dynamic connection to port B6, which is attached to an external device.  As data
transmission to port B6 terminates, the Director disables the connection and enables
a new dynamic connection to port F8 (attached to a separate external device).

Channel B of Host 2 is attached to port D8 of the Director. A second Director (chained
Director) is attached to port D5. A dedicated connection is enabled between ports
D8 and D5 to establish the Director chain.

Host A Host B

Control
Unit 1

Control
Unit 2

Control
Unit 3

Control
Unit 4

Director Director
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Note: Ports D8 and D5 can only communicate with each other, and not with any
other ports in the Director.

Figure 4.  Performing Director Functions

Change Dynamic Connectivity

Changes to the Director’s dynamic connectivity capability are controlled from the
host (through SA OS/390) or the Director Console application.  An operator can
change, customize, or limit the capability of each port to dynamically connect to other
ports through:

• Blocking  a port so that no communication takes place with the device
externally connected to the port.  In Figure 4, port B9 is blocked.  The port
cannot communicate with any other Director port, and no other port (or
connected device) can communicate with it.

• Establishing a dedicated connection between two Director ports so the ports
communicate only with each other. Figure 4 shows a dedicated connection
between ports E4 and DB. These ports can communicate only with each other.

• Prohibiting  a dynamic connection between two ports.  In Figure 4, a
connection between ports AA and B3 is prohibited.  Port AA can connect to
any port except B3, and port B3 can connect to any port except AA.

Dynamic Connectivity Hierarchy

Assigning more than one connectivity attribute to a port (ESCON or FICON) creates
the following hierarchy.

94

B0B3 B9

E4
D5

DB D8DFE0

AA AF B6

B
Blocked

BF
C0

80

Prohibited

B6

Dedicated Dedicated

FB
F8

A B C

Host 1
Channels

A B C

Host 1
Channels

A B C

Host 2
Channels
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1. The Blocked  attribute has the highest precedence and overrides all other
attributes (dedicated, prohibited, allowed) assigned to a port.

2. The Dedicated  attribute has second precedence and overrides the
prohibited and allowed attributes.

3. The Prohibited  attribute has third precedence and overrides only the
allowed attribute.

4. The Allowed  attribute has the lowest precedence and does not override
any other attributes.

ESCON Director Description

The following paragraphs describe and illustrate 9032-003, 9033-004, and 9032-005
ESCON Directors.

9032-003 Director

The 9032-003 Director and Director Console are shown in Figure 5. The Director is
a floor-standing unit that contains a minimum of seven ESCON DVP cards (28
external ports) and a maximum of 31 DVP cards (124 external ports).  Each DVP
card provides either four LED ports or four XDF laser ports. Up to 62 simultaneous
internal connections (two ports per connection) are possible when each external port
attaches to an ESCON channel or control unit.  For a description of LED and XDF
laser ports, refer to "Port Cards" on page 17.

Figure 5.  9032-003 Director and Console

Director

Console

9032 Model 3
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Any valid combination of host and I/O port is supported. Each port allows attachment
of an ESCON channel, ESCON control unit, 9034 or 9035 ESCON Converter, or
another Director.

Note: The 9032-003 Director does not support FICON operation.

9033-004 Director

The 9033-004 Director and Director Console are shown in Figure 6. The Director is
a desktop unit that contains a minimum of two ESCON DVP cards (eight external
ports) and a maximum of four DVP cards (16 external ports). Each DVP card provides
either four LED ports or four XDF laser ports.  Up to eight simultaneous internal
connections (two ports per connection) are possible when each external port
attaches to an ESCON channel or control unit.  For a description of LED and XDF
laser ports, refer to "Port Cards" on page 17.

Figure 6.  9033-004 Director and Console

Any valid combination of host and I/O port is supported. Each port allows attachment
of an ESCON channel, ESCON control unit, 9034 or 9035 ESCON Converter, or
another Director.

Note: The 9033-004 Director does not support FICON operation.

9032-005 Director

The 9032-005 Director and Director Console are shown in Figure 7. The Director is
a floor-standing unit that can be configured for ESCON-only operation, or can be
configured with a FICON converter feature that connects to FICON channels of an
IBM S/390 Generation 5 (or later model) Parallel Enterprise Server.

9033 Model 4 Director

Console

MAU
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Figure 7.  9032-005 Director and Console

ESCON-Only Operation

When configured for ESCON-only operation, the 9032-005 Director contains a
minimum of three DVP cards (24 external ports) and a maximum of 31 DVP cards
(248 external ports). Each DVP card provides either eight LED ports or eight XDF
laser ports. Up to 124 simultaneous internal connections (two ports per connection)
are possible when each external port attaches to an ESCON channel or control unit.
For a description of LED and XDF laser ports, refer to "Port Cards" on page 17.

FICON Converter Feature

FCV port cards can be ordered and installed in the 9032-005 Director only as optional
FICON converter features. Each FCV port card provides one FICON port connection
that provides a link attachment to an IBM S/390 Generation 5 (or later model) Parallel
Enterprise Server.

The Director supports the installation of one to 16 FCV port cards.  The remaining
port cards must be ESCON DVP cards (LED or XDF laser). An increase in physical
FICON connections results in a corresponding decrease in physical ESCON
connections.  With the minimum or maximum number of FCV port cards installed,
the number of connections are as follows:

• If no FCV port cards and 31 DVP cards are installed, the Director supports 248
external ESCON connections.

• If one FCV port card and 30 DVP cards are installed, the Director supports one
external FICON connection and 240 external ESCON connections.
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• If 16 FCV port cards and 15 DVP cards are installed, the Director supports 16
external FICON connections and 120 external ESCON connections.

The FCV port card provides a function that multiplexes and converts eight ESCON
channels into one FICON channel. Therefore, the single FICON device port on the
card maps to eight internal ESCON ports on the same card. The FCV port card is
a converter between a FICON server and ESCON peripherals.

The Director provides non-blocking switching between the FICON device port and
enabled ESCON DVP ports. Any internal ESCON port on the FCV port card can be
dynamically connected to any other ESCON DVP port.  A dedicated connection
between an internal ESCON port and an ESCON DVP port is not allowed. An internal
ESCON port to internal ESCON port connection is also not allowed.

Any valid combination of host and I/O port is supported.  Each LED or XDF laser
port allows attachment of an ESCON channel, ESCON control unit, 9034 or 9035
ESCON Converter, or another Director. Each FCV port allows attachment of a FICON
channel. For a description of FCV, LED, and XDF laser ports, refer to "Port Cards"
on page 17.

Director Console

All Director models require an attached Console (shown in Figure 8) to perform
operations and maintenance tasks.  The Console is ordered separately or as an
optional feature. The Console is optional only if the customer has a PC platform that
meets the minimum specifications listed in the Console Installation and User’s Guide:
9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director, 9032 Model 5
Director, and 9037 Model 2 Sysplex Timer (GA22-7291).

Figure 8.  Director Console
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The Console communicates with the Director through a 4/16 Mbps Token Ring LAN
using shielded, twisted-pair cable.  The default LAN data rate is 16 Mbps, but can
be changed to 4 Mbps. The Console is installed anywhere up to the limit of the Token
Ring, or on a remote LAN that communicates with the Director (on a local LAN)
through a bridge or router. As shown in Figure 9, up to 16 Directors (any combination
of 9032-003, 9033-004, or 9032-005 Models), and up to two 9037-002 Sysplex Timer
networks (up to two Timers per network) can be controlled from the Director Console.

Figure 9.  Twelve Directors, Two Timer Networks, and Console Installed on LAN

A Console is required to configure the Director, change configurations (without the
system integrated change control of SA OS/390), and access logs. After a Director
is configured and operational, it performs connection tasks without Console
intervention.  A Console failure does not cause an operating Director to fail.

Although a single Console can control multiple Directors, two or more Consoles
cannot share control of a Director simultaneously.   For maximum availability, a
backup Console should be maintained on the LAN in case the primary Console fails.
The backup Console is maintained with current Director configuration matrices,
critical system or application data, and other Director information for immediate
access.

Through a customized version of Distributed Console Access Facility (DCAF™)
software, an operator on a remote PC can access the Director Console application
to perform administration and operator tasks.

The Console described in this publication does not support operation of 9033-001
or 9032-002 Directors.  Conversely, Consoles for the 9033-001 and 9032-002
Directors do not support operation of the 9032-003, 9033-004 or 9032-005 Director.
For additional information about which Consoles support Director operation, refer to
the Console Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033
Model 4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex Timer
(GA22-7291).

9037-002 Sysplex
Timer Networks (2)

9032-003
Directors (2)

9033-004
Directors (2)

Director Console
(with Timer Console

Application)

9032-005
Directors (8)

Token Ring
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Console Considerations

Consider the following when using the Director Console and Console application:

• The Director Console can be located at any distance from the Director, up to
the limit of the installed Token Ring.  The Console can attach to a local LAN
containing the Director, or through a remote LAN connected by a bridge or
router.

• A Console is required for Director installation and configuration, changing
configurations (without SA OS/390), and accessing logs. The Director can be
powered on and off without the Console. After the Director is configured and
operational, dynamic connectivity tasks are performed without Console
intervention.

• A Console failure does not cause an operating Director to fail.  However, a
Console is required to monitor Director operations, access critical system or
application data, and access logs. For maximum Console availability, consider
maintaining either a backup or replacement Console for installation on the
Token Ring LAN.

• When the Console manages multiple Directors, and a failure occurs, ensure
the  appropriate Director is selected for service.  Ensure the ID that appears
on the status display of the Director’s operator panel matches the ID that
appears on the Matrix window of the Console application.

• Selected Directors can be accessed by opening their respective Active Matrix
windows.  However, all defined Directors continue to communicate with the
Console while the Director Console application is running (even if their
respective Matrix windows are not open).  For example, defined Directors
continue to log incidents and provide status input to the Console.

• The Director Console application can be installed on the following PC platforms.
Hardware operational requirements vary for the different  Director models.
Refer to the Console Installation and User’s Guide: 9032 Model 3 ESCON
Director, 9033 Model 4 ESCON Director, 9032 Model 5 Director, and 9037
Model 2 Sysplex Timer (GA22-7291) for minimum requirements.

— A dedicated IBM PC supplied with the Director.  This platform provides
the hardware and software required to connect the PC to a Token Ring
LAN, perform Win-OS/2 administrative tasks, and operate the Director
Console application.

— The IBM PC supplied with the 9037-002 Sysplex Timer.  This platform
provides the hardware and software required to connect the PC to a Token
Ring LAN and perform Win-OS/2 administrative tasks.  The Director
Console application must be installed on the Console.

— The S/390 server’s Hardware Management Console.  This platform
provides the hardware and software required to connect the PC to a Token
Ring LAN and perform Win-OS/2 administrative tasks.  The Director
Console application must be installed on the Console.

— A customer-supplied PC.  The PC must meet minimum hardware
requirements and the Director Console application must be installed. Use
of a customer-supplied PC is not recommended.
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Automatic Backup of Data Files

Depending on the PC platform used, the Console provides software to back up
Director system libraries (stored on the Console fixed disk) to a tape cartridge or
rewriteable optical cartridge (ROC). If the Automatic Backup function is enabled from
Win-OS/2, configuration files, event logs, error logs, and other critical data are backed up
at the specified interval. The default backup interval is daily at midnight. The backup time
and interval can be changed or disabled. Refer to the Console Installation and User’s
Guide: 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director, 9032 Model
5 Director, and 9037 Model 2 Sysplex Timer (GA22-7291) for instructions.

If the Console is operated with the Automatic Backup option enabled:

• Console configuration files can be rebuilt after a primary Console failure,
including:

— All saved configuration data, including the most recently saved changes

— Accurate and up-to-date event, audit, and error logs

— The correct number and types of Directors managed by the Console.

If the Console is operated with the Automatic Backup option disabled:

• Console configuration files might not be accurately recovered if a Console
failure occurs and changes were made since the last manual backup. Missing
information may include:

— Saved configuration changes

— Event, audit, and error log information

— The number and types of Directors managed by the Console.

• Perform regular manual backups to keep backup information as current as
possible.

Regardless of the status of the Automatic Backup option (enabled or disabled),
manually back up the Console fixed disk when a Director is added to or removed
from the shared Console configuration. In addition, back up the Console fixed disk
immediately after installing a Director and configuring port connections, or if the
Director name is changed.

Storing Active Configuration Matrices

When changes are made to the Director’s active matrix (from the Console application)
and saved, the matrix is saved as a file on the Console fixed disk. When the matrix
is activated by selecting the Activate Configuration Matrix option from the File menu,
the Director:

• Stores the matrix in dynamic random access memory (DRAM) on the
Director’s Control Processor (CTP) card.

• Stores the matrix in the current  location in nonvolatile memory on the
Director’s CTP card.

Figure 10 illustrates this process.
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Figure 10.  Storing Active Configuration Matrix Data

Selecting the Active = Saved option from the Utility menu determines if matrix changes
are temporary or carried forward to the next Director power-on cycle. If the Active = Saved
option is set, changes to the current file are also written to the Initial Program Load (IPL)
location in nonvolatile memory to be active at the next power-on cycle.

IML and IPL Functions

The Initial Machine Load (IML), IPL, and power-cycle functions load active matrix
information from nonvolatile memory for use in controlling port connections.

IML Function

An IML forces those components not critical to FICON or ESCON port operation to
reset. An IML does not affect connections between channels and control units that
are routed through the Director.

After an IML, the Director loads matrix information from the current location in
nonvolatile memory to use as the active matrix for controlling port connections. This
information corresponds to the last active matrix downloaded from the Console. The
Internet Protocol (IP) address may appear as 0.0.0.0 on the status display of the
operator panel until the actual IP address is calculated and displayed.

Note: On a Director with only one CTP card installed, the IPL and IML functions
are identical.

IPL Function

Selecting the IPL Director option from the Utility menu resets a subset of hardware
components and reinitializes Director LIC.  During an IPL, the following events occur:

Attention!

It is recommended the IML button be used only by authorized service
personnel.

Nonvolatile Memory

Dynamic
RAM Active IPL Current

Active=SavedConsole

Activate Configuration Matrix

Director

Power On
Reset

IPL
IML
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• Functional logic on the TKRG Controller Adapter card and CTP card resets.
The MXC/MXS card set, FCV port cards, and DVP cards do not reset.

• The Service Required  status for FCV port cards and DVP cards resets.

• Director LIC loads from CTP FLASH memory to the central processing unit
(CPU), without cycling power to the Director.

An IPL forces those components not critical to FICON or ESCON port operation to
reset. An IPL does not affect connections between channels and control units that
are routed through the Director.

After an IML, the Director loads matrix information from the current location in
nonvolatile memory to use as the active matrix for controlling port connections. This
information corresponds to the last active matrix downloaded from the Console. The
IP address may appear as 0.0.0.0 on the status display of the operator panel until
the actual IP address is calculated and displayed.

Note: On a Director with only one CTP card installed, the IPL and IML functions
are identical.

Port Cards

Port cards support FICON or ESCON port connections.  FICON connections are
provided by FCV port cards, and ESCON connections are provided by DVP cards
(LED or XDF laser).

FCV Port Cards

FICON compatibility is required to attach the 9032-005 Director to a FICON channel
of an IBM S/390 Generation 5 (or later model) Parallel Enterprise Server.  If the
Director is not delivered with this capability, a FICON upgrade feature must be ordered
and installed.  FCV ports provide FICON channel connections only.  Chained
Directors, ESCON converters, and FICON-to-FICON connections are not
supported.

Note: An FCV port card cannot be installed in the 9032-003 or 9033-004 Director.
These Director models are not FICON capable.

An FCV port card provides one FICON port connection. The Director supports the
installation of one to 16 FCV port cards.  There is no minimum card installation
requirement. An increase in FCV port cards results in a corresponding decrease in
card cage slots for ESCON DVP cards.

Because each FCV port card contains only one port connection, one or more
additional cards must be installed (up to 16 total) if spare FICON ports are a
requirement.  The spare ports card does not provide spare FICON ports.

Either a Fibre Channel Standard or subscriber connector (FCS/SC) duplex connector
is required to attach optical fiber to an FCV port.  Either singlemode or multimode
fiber-optic cable is used. The exterior jacket of singlemode cable is typically yellow,
and the exterior jacket of multimode cable is typically orange.
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LED Port Cards

Depending on the Director model, an LED port card provides either four or eight
ESCON port connections.  Each port provides a link attachment to an ESCON-
compatible server, ESCON-compatible control unit, 9034 or 9035 ESCON Converter,
or another Director.  All Director models support installation of LED port cards.

A multimode duplex connector is required to attach optical fiber to an LED port, and
only multimode fiber-optic cable is used.  The exterior jacket of multimode cable is
typically orange.

For the 9032-003 ESCON Director, each LED port card provides four ESCON port
connections.  A minimum of seven port cards (28 ports) must be installed, and at
least four cards (16 ports) must be LED port cards. A maximum of 31 LED port cards
(124 ports) can be installed.

For the 9033-004 ESCON Director, each LED port card provides four ESCON port
connections.  A minimum of two port cards (eight ports) of any combination (LED
or XDF laser) must be installed. A maximum of four LED port cards (16 ports) can
be installed.

For the 9032-005 Director, each LED port card provides eight ESCON port
connections. A minimum of three ESCON port cards (24 ports) of any combination
(LED or XDF laser) must be installed. A maximum of 31 XDF laser port cards (248
ports) can be installed.

XDF Laser Port Cards

Depending on the Director model, an XDF laser port card provides either four or
eight ESCON port connections. Each port provides a link attachment to an ESCON-
compatible server, ESCON-compatible control unit, 9034 or 9035 ESCON Converter,
or another Director. All Director models support installation of XDF laser port cards.

An FCS/SC duplex connector is required to attach optical fiber to an XDF laser port.
Only singlemode fiber-optic cable is used. The exterior jacket of singlemode cable
is typically yellow.  XDF laser ports have FCS duplex connectors.  If cables from
control units have multimode connectors, an XDF adapter kit (part number 46H9223)
is required for each cable.

XDF ports allow the Director to be connected to a second Director or mode converter
at a distance of up to 20 kilometers. Any ESCON-capable control unit can then be
attached to the remote Director or mode converter.

For the 9032-003 Director, each XDF laser port card provides four ESCON port
connections.There is no minimum requirement for installation of XDF laser port
cards. However, a minimum of seven port cards (LED or XDF laser) must be installed,
and at least four cards must be LED port cards. A maximum of 27 LED port cards
(108 ports) can be installed. The remaining four card slots must be populated with
LED port cards.

For the 9033-004 Director, each XDF laser port card provides four ESCON port
connections.  A minimum of two port cards (eight ports) of any combination (LED
or XDF laser) must be installed. A maximum of four XDF laser port cards (16 ports)
can be installed.
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For the 9032-005 Director, each XDF laser port card provides eight ESCON port
connections. A minimum of three ESCON port cards (24 ports) of any combination
(LED or XDF laser) must be installed. A maximum of 31 XDF laser port cards (248
ports) can be installed.

Spare Ports Card

The spare ports card is a feature for the 9032-005 Director only that provides four
spare ESCON ports. These ports function only as spare ports and do not increase
the number of external connections available for the Director.  Depending on the
feature number, the spare ports card provides either four LED ports or two LED ports
and two XDF laser ports.

Note: The spare ports card feature does not provide spare FICON ports.

Determine Port Type

To determine if a port card is an FCV port card, LED port card, or XDF laser port
card, open the Director door and examine the card. Table 2 describes the physical
characteristics of and differences between port cards.

Table 2.  Physical Characteristics of FCV, LED, and XDF Laser Port Cards

• Do not insert a singlemode cable connector, XDF laser wrap plug, or XDF
laser protective plug into an LED port.

• Do not insert a multimode cable connector, LED wrap plug, or LED protective
plug into an FCV or XDF laser port.

• The ports on a DVP card are either all LED ports or all XDF laser ports
(if one port is LED, all ports are LED).

• The ports on a spare ports card (9032-005 Director only) are either all LED
ports or two LED ports and two XDF laser ports.  The spare ports card does
not provide FCV ports.

Physical Characteristic FCV LED XDF Laser

Director model compatibility 9032-005 only All models All models

Number of external port
connections One Four or eight Four or eight

Type of port connector FCS/SC
duplex

Multimode
duplex

FCS/SC
duplex

Color of fiber-optic cable
attached to port

Yellow
(singlemode)

Orange
(multimode)

Yellow
(singlemode)

Color of cable connector Light gray or
blue Black Light gray or

blue
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Logical Partition Capability

The Director has a logical partition (LPAR) capability that allows an administrator to
create port-level configuration access control unique to each defined operator.
Director port addresses are divided into distinct groups or logical regions with
operator-specific management authority.  This LPAR capability allows operators to
access only authorized ports, and restricts unauthorized operators from changing
the port connectivity configuration of any device or set of devices under control of
the Director. The administrator can also define groups of ports whose configuration
access is shared between operators.  The LPAR feature offers increased security
and maximizes the flexibility of system configuration.  An LPAR can be:

• One port up to the maximum number of ports (FICON and ESCON) available
on the Director.

• A set of contiguous or non-contiguous ports (any increment or location).

• A different size from another LPAR.

• Mutually exclusive to one operator or common to multiple operators.

• Easily changed or modified.

Logical partitioning is enabled by selecting the Port Authorization option from the
Utility pull-down menu. By default, port authorization is not enabled and all operators
have connectivity management authority for all ports.  For additional information
about creating logical partitions and granting port authorization, refer to "Creating
Logical Partitions" on page 178, and "Enable Operator" on page 91. The following
examples illustrate uses for logical partitions.

Example 1:

A test group and production group share use of a mainframe computer.  With the
Director, each group can access the mainframe through a set of ports allocated only
to that group. This allows the test group to complete its tests without interfering with
the production group’s computer access.

Example 2:

A service bureau owns a mainframe computer that processes data for many
businesses. Each business uses the mainframe only when required. During peak
periods for one business, the service bureau can allocate more port connectivity
management to that business and remove port connectivity management from the
other businesses.

Example 3:

A disaster recovery site controls several tape storage devices that manage data for
many businesses.  Each device is allocated to a different business. Through the
Director, access to each device is restricted so that only the operator in charge of a
specific business’s data can control port connectivity to that device.  For example,
one business may have authority to manage connectivity to ports 24, 64, A4, and
E4; and another business may have authority to manage connectivity to ports 25,
65, A5, and E5.
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Example 4:

The Information Systems (IS) department is responsible for a Director shared among
three departments. The IS department wants to grant port connectivity control to a
person in each department but retain overall control of the Director. In addition, the
Director is configured with more ports than are required. Using the logical partitioning
capabilities of the Director, the IS department dedicates 44 ports to software
engineering, 72 ports to business systems, and 52 ports to manufacturing.  The
remaining 80 ports are dedicated to the IS department for future use by other
departments.  Ports are reallocated to these departments as their needs increase.

Example 5:

In a manufacturing company, all operators require access to the printer, but the
remaining devices need to be restricted only to authorized personnel. Through the
Director, authority to manage connectivity to all ports except those attached to the
printer can be restricted.

Example 6:

A large bank recently acquired two small banks. The data centers for the small banks
are consolidated into the large bank’s data center, and the small banks’ workload is
added to the current set of Directors.  The workloads are segregated during this
process. The IS department uses logical partitioning to allocate 42 unused ports to
the workload of one small banks, and 30 ports to the workload of the other small
bank.  After workload consolidation, the IS department can change the logical
partition’s port authorization matrix as required.

9032-003 Director Components

The following paragraphs and supporting illustrations describe 9032-003 Director
components.

Power Switch

Setting the Director’s power switch to the on position ( | ) supplies ac power to the
dual power supplies and powers on the Director. Setting the power switch to the off
position (O) powers off the Director. The power switch is a non-concurrent FRU that
is removed and replaced only when the Director is powered off.

Operator Panel

The 9032-003 operator panel (Figure 11) includes a:

• Power Indicator  - The Power indicator is an LED that illuminates when
power is supplied to the Director.

• Status Display  - The status display is a liquid-crystal display (LCD) that
shows status and event messages on two 16-character lines.

• IML Button  - Pressing the IML button reloads LIC and resets all hardware,
except the MXC/MXS and DVP cards. The IML button is hidden when the front
door is closed.
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• Control Buttons - Four control buttons (Advance, Entry, Detail, and Clear)
control information shown on the status display.

• System Error Indicator - The System Error indicator is an LED that illuminates
when a software or hardware error occurs.

The operator panel is a concurrent FRU that can be removed and replaced while the
Director is operational.

Figure 11.  9032-003 Operator Panel

Power Supply and Fan Assemblies

As shown in Figure 12, the Director contains two power supply assemblies and three
fan assemblies. Power supplies are concurrent FRUs that slide into position at the
bottom front of the Director. Each 90 to 264 Vac variable-input power supply rectifies
and steps down the input power and provides +5 and +24 Vdc power to the Director.

Fan assemblies are concurrent FRUs that slide into position at the top front of the
Director. Fans provide cooling for internal components and redundancy for continued
operation if a fan fails.  The Director can operate with any two of the three fans
functioning.  Fan speeds and power supply outputs are monitored, and error
messages are generated if outputs deviate from a specified range.  If a failure is
severe, an offline signal is transmitted to each ESCON port and a controlled shutdown
of the Director occurs.

Logic Cards

The following paragraphs describe 9032-003 Director logic cards.  The cards are
illustrated in Figure 12. All cards are installed in slots identified with position numbers
engraved in the Director chassis.

• CTP Card - The CTP card contains a microprocessor and associated logic that
provides overall coordination for the Director. The card also initializes system
hardware components after power on or reset. During Director operation, the
CTP card controls the operator panel, ESCON port exception handling, error
recovery, maintenance port operation, and control unit port (CUP) operation.

Status Display

Power

System
Error

IML

Advance Entry Detail Clear

Status
IML Button

Power Indicator

System Error Indicator

Control Buttons
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It is recommended a backup CTP card (Feature Code #4600) be installed to
operate the Director if the primary CTP card fails.  The backup CTP card is
installed concurrently while the Director is operational.  With two CTP cards,
Loader/Monitor Area (LMA) code and LIC can be upgraded concurrently.  A
CTP card can also be removed and replaced concurrently.

Figure 12.  9032-003 Director Components (Fully-Configured Director)

• TKRG Controller Adapter Card - The TKRG Controller Adapter card provides
a serial connector (9-pin female, labeled CONS) that attaches the Director to
a 4/16 megabit per second (Mbps) Token Ring LAN.  The LAN connection
allows the Director to communicate with a Director Console.

The card also provides an RS-232-D asynchronous serial port (25-pin male,
labeled MAINTENANCE ) that attaches the Director to a maintenance terminal.
The terminal accesses maintenance utilities and functions through the
Director’s monitor subsystem, and is intended for use only by a service
representative.

Note: Always connect the maintenance terminal to the card installed in the
left-most slot (slot 0). Connect a terminal to the card in slot 1 only if it
is the only card installed, or if the card in slot 0 failed.
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It is recommended a backup TKRG Controller Adapter card (Feature Code
#4800) be installed for redundancy in case the primary card fails.  The card
can be installed while the Director is operational.  With two cards installed,
each card is a concurrent FRU that can be removed and replaced while the
Director is operational.

• DVP Card - The DVP card is the hardware interface for ESCON fiber optic
media.  Each port contains an optical transmitter and receiver that convert
signals from electrical to optical and vice versa. A minimum of seven DVP
cards (28 ports) must be installed, and a maximum of 31 DVP cards (124 ports)
can be installed. DVP cards can be removed and replaced concurrently. Each
DVP card contains either:

— Four LED port interfaces. Cables attach to the ports through multimode
duplex connectors. At least four DVP cards installed in the Director
(16 ports) must be LED port cards.

— Four XDF laser port interfaces.  Cables attach to the ports through
singlemode FCS/SC duplex connectors.

Note: New and replacement XDF port cards and those shipped with the
9032-003 Director since December 1995 have FCS receptacles.
An XDF adapter kit (part number 46H9223) is required for each
port if jumper cables from ESCON devices have IBM duplex
connectors.

• MXC/MXS Card Set - The MXC/MXS card is a two-card set that controls
dynamic connection requests and provides connection paths between
ports specified by port attributes configured through the Director Console or
SA OS/390. The card pair responds to connect and disconnect requests from
all ports and provides nonblocking, any-to-any connections for up to 124 ports
(full duplex).

It is recommended a backup MXC/MXS card set (Feature Code #4500) be
installed for redundancy in case the primary card set fails.  The card set can
be installed while the Director is operational. With two card sets installed, each
set is a concurrent FRU that can be removed and replaced while the Director
is operational.

Power Cables and Line Filters

Each power supply assembly receives facility ac power through a power cord
receptacle at the bottom front of the Director (Figure 12).  The ac power input can
range from 90 to 264 volts, an includes 110 and 208 Vac inputs (U.S.). Two separate
power circuits with line filters provide ac power to the power switch and the two power
supplies.

Fiber-Optic Cable Routing, Labels, Static Pad, and Storage

Figure 13 shows the cable restraints and guides inside the Director’s front door that
route fiber-optic cables to DVP cards. To comply with electrostatic discharge (ESD)
precautions, a static pad is provided on top of the left power supply (slot 0). A storage
compartment for publications, port wrap plugs, torque tool (for removing logic cards),
and other tools is provided at the upper right area of the Director.
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Figure 13.  9032-003 Cable Routing, Labels, Static Pad, and Storage

Cabling and Labels - Rear Access

Figure 14 shows cables and safety labels that are accessed through the rear door
of the Director. The cables illustrated include the power sense 0 and power sense
1 cable assemblies, power sense grounding wires, power sense bus bars, and
power cords.

Logic Board Assembly

The logic board assembly is located on the rear of the Director (Figure 14).  The
assembly provides power and logic connections for all logic cards installed in the
Director.  The logic board assembly is a non-concurrent FRU that is removed and
replaced only when the Director is powered off.
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Figure 14.  9032-003 Cable Routing and Labels (Rear of Director)

9033-004 Director Components

The following paragraphs and supporting illustrations describe 9033-004 Director
components.

Operator Panel

The 9033-004 operator panel (Figure 15) is integrated with a power supply and
cooling fans as a single FRU. The entire assembly slides in and out of the Director
chassis.  The operator panel includes a:

• Power Indicator  - The Power indicator is an LED that illuminates when
power is supplied to the Director.

• Status Display  - The status display is an LCD that shows status and event
messages on two 16-character lines.
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• IML Button  - Pressing the IML button reloads LIC and resets all hardware,
except the MXC/MXS and DVP cards.

• Control Buttons - Four control buttons (Advance, Entry, Detail, and Clear)
control information shown on the status display.

• System Error Indicator - The System Error indicator is an LED that illuminates
when a software or hardware error occurs.

• Power Switch - Setting the Director’s power switch to the on position ( | )
supplies ac power to the power supply and powers on the Director. Setting the
power switch to the off position (O) powers off the Director.

The operator panel is a non-concurrent FRU that is removed and replaced only
when the Director is powered off.

Figure 15.  9033-004 Operator Panel

Power Supply and Fan Assemblies

As shown in Figure 16, the power supply, fans, and operator panel are integrated
into one non-concurrent FRU that is removed and replaced only when the Director
is powered off.  The 90 to 264 Vac variable-input power supply rectifies and steps
down the input power and provides +5 and +24 Vdc power to the Director.

Two fans provide cooling for internal components. If one fan malfunctions, the other
fan provides adequate cooling until the FRU is replaced.  Fan speeds and power
supply outputs are monitored, and error messages are generated if outputs deviate
from a specified range. If a failure is severe, an offline signal is transmitted to each
ESCON port and a controlled shutdown of the Director occurs.
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Logic Cards

The following paragraphs describe 9033-004 Director logic cards.  The cards are
illustrated in Figure 16. All cards are installed in slots identified with position numbers
engraved in the Director chassis.

• CTP Card - The CTP card contains a microprocessor and associated logic that
provides overall coordination for the Director. The card also initializes system
hardware components after power on or reset. During Director operation, the
CTP card controls the operator panel, ESCON port exception handling, error
recovery, maintenance port operation, and CUP operation. The CTP card is
a non-concurrent FRU that is removed and replaced only when the Director is
powered off.

Figure 16.  9033-004 Director Components (Fully-Configured Director)

• TKRG Controller Adapter Card - The TKRG Controller Adapter card provides
a serial connector (9-pin female, labeled CONS) that attaches the Director to
a 4/16 megabit per second (Mbps) Token Ring LAN.  The LAN connection
allows the Director to communicate with a Director Console. The Token Ring
adapter cable routes through a radio frequency interference (RFI) shield and
through an access hole in the bottom or side of the chassis.

The card also provides an RS-232-D asynchronous serial port (25-pin male,
labeled MAINTENANCE ) that attaches the Director to a maintenance terminal.
The terminal accesses maintenance utilities and functions through the
Director’s monitor subsystem, and is intended for use only by a service
representative.  The card is a concurrent FRU that can be removed and
replaced while the Director is operational.
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• DVP Card - The DVP card is the hardware interface for ESCON fiber optic
media.  Each port contains an optical transmitter and receiver that convert
signals from electrical to optical and vice versa. A minimum of two DVP cards
(eight ports) must be installed, and a maximum of four DVP cards (16 ports)
can be installed. DVP cards can be removed and replaced concurrently. Each
DVP card contains either:

— Four LED port interfaces. Cables attach to the ports through multimode
duplex connectors.

— Four XDF laser port interfaces.  Cables attach to the ports through
singlemode FCS/SC duplex connectors.

Note: New and replacement XDF port cards and those shipped with the
9033-004 Director have FCS receptacles. An XDF adapter kit (part
number 46H9223) is required for each port if jumper cables from
ESCON devices have IBM duplex connectors.

• MXC/MXS Card - The MXC/MXS card controls dynamic connection requests
and provides connection paths between ports specified by port attributes
configured through the Director Console or SA OS/390. The card responds to
connect and disconnect requests from all ports and provides nonblocking, any-
to-any connections for up to 16 ports (full duplex).  The MXC/MXS card is a
non-concurrent FRU that is removed and replaced only when the Director is
powered off.

Logic Board Assembly

The logic board assembly is located on the rear of the Director (Figure 17).  The
assembly provides power and logic connections for all logic cards installed in the
Director.  The logic board assembly is a non-concurrent FRU that is removed and
replaced only when the Director is powered off.

Figure 17.  9033-004 Rear View
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Note: Do not use the handle attached to the logic board assembly to lift the Director.
Use the handle only to remove and replace the logic board assembly.

Storage Compartment

A storage compartment (Figure 17) for publications, port wrap plugs, torque tool
(for removing logic cards), and other tools is provided at the rear of the Director.

Power Cord and Line Filter

The power supply assembly receives facility ac power through a power cord
receptacle at the rear of the Director (Figure 17). The ac power input can range from
90 to 264 volts, an includes 110 and 208 Vac inputs (U.S.).

Cable Routing, ESD Ground Point, and Safety Label

Figure 18 illustrates LAN and fiber-optic cable routing inside the Director. Also shown
is the grounding point for connecting an ESD wrist strap and a safety label.  The
grounding point (marked GND) is on the front left edge of the chassis.  The safety
label is on the front of the operator panel.

Figure 18.  9033-004 Cable Routing, ESD Ground, and Safety Labels

9032-005 Director Components

The following paragraphs and supporting illustrations describe 9032-005 Director
components.
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Power Switch

Setting the Director’s power switch to the on position ( | ) supplies ac power to the
dual power supplies and powers on the Director. Setting the power switch to the off
position (O) powers off the Director. The power switch is a non-concurrent FRU that
is removed and replaced only when the Director is powered off.

Operator Panel

The 9032-005 operator panel (Figure 19) includes a:

• Power Indicator  - The Power indicator is an LED that illuminates when
power is supplied to the Director.

• Status Display  - The status display is an LCD that shows status and event
messages on two 16-character lines.

• IML Button  - Pressing the IML button reloads LIC and resets all hardware,
except the MXC/MXS and DVP cards. The IML button is hidden when the front
door is closed.

• Control Buttons - Four control buttons (Advance, Entry, Detail, and Clear)
control information shown on the status display.

• System Error Indicator - The System Error indicator is an LED that illuminates
when a software or hardware error occurs.

The operator panel is a concurrent FRU that can be removed and replaced while the
Director is operational.

Figure 19.  9032-005 Operator Panel

Power Supply and Fan Assemblies

As shown in Figure 20, the Director contains two power supply assemblies. Power
supplies are concurrent FRUs that slide into position at the bottom front of the
Director. Each 90 to 264 Vac variable-input power supply rectifies and steps down
the input power and provides dc power to the Director. There are two power supply
types:
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• The original power supply provides +5 and +24 Vdc power to Director
components. For identification, the face plate of this power supply is unfinished
aluminum (silver) with an appropriate label. This power supply does not
support operation of FCV port cards.

• The current power supply (Feature Code #5702) provides +3.3, +5, and +24
Vdc power to Director components and supports FCV port card operation. For
identification, the face plate of this power supply is anodized (black). This power
supply is required to support FICON operation.

Power supply outputs are monitored, and error messages are generated if outputs
deviate from a specified range. If a failure is severe, an offline signal is transmitted
to each ESCON and FICON port, and a controlled shutdown of the Director occurs.

As shown in Figure 21, the Director contains two fan assemblies.  Fan assemblies
are concurrent FRUs that slide into position at the top rear of the unit. Four fans (two
fans in each assembly) provide cooling for internal components and redundancy for
continued operation if a fan fails. With no FCV port cards installed, the Director can
operate with any two of the four fans operational. With FCV port cards installed, the
Director can operate with any three of the four fans operational.  Fan speeds are
monitored, and error messages are generated if outputs deviate from a specified
range.  If a failure is severe, an offline signal is transmitted to each ESCON and
FICON port, and a controlled shutdown of the Director occurs.

Logic Cards

The following paragraphs describe 9032-005 Director logic cards.  The cards are
illustrated in Figure 20. All cards are installed in slots identified with position numbers
engraved in the Director chassis.

• CTP Card - The CTP card contains a microprocessor and associated logic that
provides overall coordination for the Director. The card also initializes system
hardware components after power on or reset. During Director operation, the
CTP card controls the operator panel, port exception handling, error recovery,
thermal protection mechanisms, maintenance port operation, and CUP
operation.

It is recommended a backup CTP card (Feature Code #5600) be installed to
operate the Director if the primary CTP card fails.  The card can be installed
while the Director is operational.  With two cards installed, each card is a
concurrent FRU that can be removed and replaced while the Director is
operational.

• TKRG Controller Adapter card - The TKRG Controller Adapter card provides
a serial connector (9-pin female, labeled CONS) that attaches the Director to
a 4/16 megabit per second (Mbps) Token Ring LAN.  The LAN connection
allows the Director to communicate with a Director Console.  The card also
provides an RS-232-D asynchronous serial port (25-pin male, labeled
MAINTENANCE ) that attaches the Director to a maintenance terminal.  The
terminal accesses maintenance utilities and functions through the Director’s
monitor subsystem, and is intended for use only by a service representative.

Note: Always connect the maintenance terminal to the card installed in the
left-most slot (slot 0). Connect a terminal to the card in slot 1 only if it
is the only card installed, or if the card in slot 0 failed.
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It is recommended a backup TKRG Controller Adapter card (Feature Code
#5800) be installed for redundancy in case the primary card fails.  The card
can be installed while the Director is operational.  With two cards installed,
each card is a concurrent FRU that can be removed and replaced while the
Director is operational.

Figure 20.  9032-005 Director Components (Fully-Configured Director)

• DVP Card - The DVP card is the hardware interface for ESCON fiber optic
media.  Each port contains an optical transmitter and receiver that convert
signals from electrical to optical and vice versa. A minimum of three DVP cards
(24 ports) must be installed, and a maximum of 31 DVP cards (248 ports) can
be installed. DVP cards can be removed and replaced concurrently. Each DVP
card contains either:
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— Eight LED port interfaces (Feature Code #5240).  Cables attach to the
ports through multimode duplex connectors.

— Eight XDF laser port interfaces (Feature Code #5250). Cables attach to
the ports through singlemode FCS/SC duplex connectors.

Note: XDF port cards shipped with the 9032-005 Director have FCS
receptacles.  An XDF adapter kit (part number 46H9223) is
required for each port if jumper cables from ESCON devices have
IBM duplex connectors.

• FCV Port Card – The FCV port card (Feature Code #5260) is the hardware
interface for FICON fiber optic media. Up to 16 FCV port cards can be installed
in the Director. Each card contains one longwave laser port interface for FICON
fiber optic media. The port attaches to a FICON host channel (defined as FCV).
A singlemode or multimode fiber-optic cable attaches to the port through an
FCS/SC duplex connector.

The card provides a multiplexing and conversion function that maps one FICON
port to eight internal ESCON ports on the same card.  The card is a FICON-
to-ESCON converter.

• Spare Ports Card – The spare ports card is only used when ESCON ports on
a standard DVP card are swapped for spare ports. The card does not increase
the total number of active connections available. The spare ports card cannot
be used to swap a FICON port on an FCV port card.  The spare ports card
contains either:

— Four LED spare port interfaces for ESCON fiber optic media (Feature
Code #5245).  Cables attach to the ports through multimode duplex
connectors.

— Two LED and two XDF laser spare port interfaces for ESCON fiber optic
media (Feature Code #5255).  Cables attach to the LED ports through
multimode duplex connectors and to XDF ports through singlemode
FCS/SC duplex connectors. An XDF adapter kit (part number 46H9223)
is required for each port if cables from ESCON devices have multimode
duplex connectors.

• MXC/MXS Card Set - The MXC/MXS card is a three-card set that controls
dynamic connection requests and provides connection paths between
ports specified by port attributes configured through the Director Console or
SA OS/390. The card pair responds to connect and disconnect requests from
all ports and provides nonblocking, any-to-any connections for up to 248 ports
(full duplex). There are two MXC card types:

— The original card (labelled MXC) controls switching only for ESCON DVP
cards. This card does not support operation of FCV port cards.

— The current card (labelled MXC2, Feature Code #5703) controls switching
for both ESCON DVP cards and FCV port cards.
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It is recommended a backup MXC/MXS card set (Feature Code #5500) be
installed for redundancy in case the primary card set fails.  The card set can
be installed while the Director is operational. With two card sets installed, each
set is a concurrent FRU that can be removed and replaced while the Director
is operational.

Power Cables and Line Filters

Each power supply assembly receives facility ac power through a power cord
receptacle at the bottom rear of the Director (Figure 21).  The ac power input can
range from 180 to 264 volts, an includes 208 Vac input (U.S.). Two separate power
circuits with line filters provide ac power to the power switch and power supplies.

Figure 21.  9032-005 Rear View
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Logic Board Assembly

The logic board assembly is located on the rear of the Director (Figure 21).  The
assembly provides power and logic connections for all logic cards installed in the
Director.  The logic board assembly is a non-concurrent FRU that is removed and
replaced only when the Director is powered off.

Fiber-Optic Cable Routing, Labels, Static Pad, and Storage

Figure 22 shows the cable restraints and guides inside the Director’s front door that
route fiber-optic cables to DVP and FCV cards. To comply with ESD precautions, a
static pad is provided on top of the left power supply (slot 0). A storage compartment
for publications, port wrap plugs, torque tool (for removing logic cards), and other
tools is provided at the upper right area of the Director.

Figure 22.  9032-005 Cable Routing, Labels, Static Pad, and Storage
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Cabling and Labels - Rear Access

Figure 23 shows cables and safety labels that are accessed through the rear door
of the Director. The cables illustrated include the power sense cable assemblies and
power cords.

Figure 23.  9032-005 Cable Routing and Labels (Rear of Director)
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Chapter 2.  The Director Console

This chapter describes the Director Console, the Console application Startup
window, and Startup window menu options.  The chapter also describes how to
navigate within the Console application (using a mouse and navigation keys to move
within a window and select items).  The chapter specifically describes how to:

• Move between application menus and select menu options using a
mouse, keyboard, or navigation keys

• Identify window and menu types

• Use the Startup window, associated menu options, and
dialog boxes

• Open a new configuration matrix.

The chapter does not discuss Windows-Operating System/2 (Win-OS/2).  For
information about the Win-OS/2 environment, refer to the Console Installation and
User’s Guide: 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director, 9032
Model 5 Director, and 9037 Model 2 Sysplex Timer (GA22-7291).

Console Platforms

The Win-OS/2-based Director Console application is installed on a PC platform that
communicates with the Director through a 4/16 megabit per second (Mbps) Token
Ring local area network (LAN).  The application can be installed on three different
platforms:

1. The recommended platform is a dedicated IBM PC with appropriate
hardware and software (Figure 24).

Figure 24.  Director Console Application on a Dedicated PC

2. The IBM PC Console used with a 9037 Model 2 Sysplex Timer network
(Figure 25).
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Figure 25.  Director Console Application on a Sysplex Timer Console

3. The System/390 (S/390) Server’s Hardware Management Console
(Figure 26).  The S/390 Hardware Management Console must have a
Token Ring adapter card installed to support this configuration.

Figure 26. Director Console Application on a Hardware Management Console

An operator can also use a remote Console to assume functional control of the
Director Console application.  The remote Console can be a Director Console,
Sysplex Timer Console, or S/390 Hardware Management Console.

The remote Console communicates with the Director console through a bridged or
routed LAN, using a customized version of Distributed Console Access Facility
(DCAF) software and Transmission Control Protocol/Internet Protocol (TCP/IP)
software.  The customized version of DCAF is supported only for the Director and
Sysplex Timer Console applications.

Attention!

Operation of all Director models (9032-003, 9033-004, or 9032-005) is
supported through a bridged LAN.  Operation of all Director models
(9032-003, 9033-004, or 9032-005) is supported through a routed LAN only
if Licensed Internal Code (LIC) Version 4.3 or higher is installed.
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Figure 27 shows a remote Console attached to a Director Console through a LAN
and TCP/IP connection.  In this example, the remote Console controls 9032-003,
9033-004, and 9032-005 Directors.

Figure 27.  Remote Console Connection to the Director Console

For additional information on planning an installation for Director Console support,
refer to Planning for the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Enterprise
Systems Connection Director (SA22-7295) or Planning for the 9032 Model 5 Director
with FICON Converter Feature (SA22-7415).

Console Operations

The Director Console application operates in a Win-OS/2 environment where menus,
dialog boxes, and function keys operate as standard objects.  This publication
describes operation of the Director Console application and does not provide specific
information about Win-OS/2 operation.  For information about Win-OS/2, refer to

• Operating system-specific publications delivered with the PC platform

• Console Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033
Model 4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex
Timer (GA22-7291).

Only one instance of the Director Console application can be open and operating on
a PC platform at any time. In addition, only one instance of a defined Director can
exist for an open Console application, and only one Matrix window can be open per
Director.  However, multiple Matrix windows can be open within the Console
application, allowing monitoring and operation of multiple Directors.

It is recommended a backup or replacement Console be maintained in case the
primary Director Console fails.

• A replacement Console remains disconnected from the Token Ring LAN on
which the Director Console is attached. However, the Director and replacement
Consoles are maintained with identical Internet Protocol (IP) addresses.
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• A backup Console remains connected to the same Token Ring LAN on which
the Director Console is attached, but the Consoles are maintained with different
IP addresses.

Mouse

Within the Director Console application, use the mouse to navigate quickly through
windows, dialog boxes, and menus, or to select or modify data in windows and dialog
boxes.  The following operations are mouse supported:

• Scrolling through data in windows with horizontal and vertical scroll bars
(where scroll bars appear)

• Pulling down menu lists from the Startup, Terminal, Port Maintenance, Log,
and Matrix windows by clicking the menu title

• Selecting menu options by clicking the desired option

• Clicking radio buttons, check boxes, or push buttons, to enable, disable, or
select options that appear in dialog boxes

• Clicking (to position the cursor for editing) or selecting text that appears in
dialog boxes.

Keyboard

Although a mouse is used for most Director Console operations, the mouse is not
required. The keyboard is fully supported through navigation keys and accelerator
keys. The following key descriptions apply to all windows and menus in the Console
application.

Navigation Keys

• PgUp / PgDn - Scrolls the displayed window up or down one page (the amount
of data displayed). The key is not available for the Port Maintenance or Terminal
windows.

• Ctrl+PgUp / Ctrl+PgDn - Scrolls the displayed window left or right one page.
The key is not available for  the Port Maintenance or Terminal windows.

• Home / End - Moves the display to the leftmost (home) or the rightmost (end)
position without scrolling.  The key is not available for  the Port Maintenance
or Terminal windows.

• Ctrl+Home / Ctrl+End - Moves to the top or bottom of the displayed data. The
key is not available for  the Port Maintenance or Terminal windows.

Attention!

Operate the Director Console application on one Console only . Operating
the application on more than one Console at a time can result in loss of
event data or other critical data.  Refer to " Maintaining and Using a
Replacement or Backup Console " on page 190 for additional information.
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• Ctrl+Shift+Home / Ctrl+Shift+End  - Scrolls to the beginning or end of the
data. The key is not available for the Port Maintenance or Terminal windows.

• Arrow Keys - Each arrow key moves the highlight (selection indicator) in the
direction of the arrow, one position at a time. The key is not available for the
Port Maintenance or Terminal windows.

• Ctrl+F6 - Cycles through the display of other open Console windows. The next
window in sequence is brought fully into view.

• Alt+F6  - Selects an alternate dialog box (if multiple dialog boxes are open).
For example, if the Director Information dialog box is selected from the Select
Active Director dialog box; Alt+F6 alternates selection of the two dialog boxes,
allowing interaction.

• F10 or Alt - Selects the menu bar for the displayed window.  To select menu
options:

— Use the appropriate arrow key and the Enter  key

— Use the underlined letter mnemonic.

• F1 - Activates online help for the selected window. The key is not available for
the Port Maintenance or Terminal windows.

• F4 - At list boxes within dialog boxes, displays a list of all defined options. At
windows with no open dialog boxes, refreshes or rereads the display data.

Accelerator Keys

To assist experienced Console operators, accelerator keys are available to perform
frequently used operations without using menus. To learn the keystrokes, available
accelerators (usually a control or alternate key, like Ctrl+D ) are listed on pull-down
menus to the right of the associated menu option. The option’s function is performed
with the accelerator keystroke from the window without pulling down the menu.

To pull down a menu and select an option without the mouse, press and hold the Alt
key, then press the underlined letter for the menu option displayed.  When a menu
is displayed, press the underlined character for the menu option to perform the
selection.

Most dialog boxes contain letter mnemonics (underlined letters) displayed for buttons,
controls, and entry fields. Press the underlined letter to perform the function of the
selected option. When the cursor is in a data entry field, use Alt with the letter key
as the accelerator to select the desired control.  use the Enter  key to accept the
current selection in a dialog box. The default selection is always highlighted with a
heavy border around the button.

Menu and Window Types

Multiple Matrix windows (for such tasks as monitoring multiple Directors) can be kept
open at the Director Console, along with other windows like a Log or Terminal window.
Windows can be sized, moved, or minimized to icons on the Console application
window.  However, all windows are retained within the application window to avoid
confusion with windows from other PC applications.
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To monitor multiple Directors at the same screen, an Active Matrix window can be
opened for each Director and the windows can be tiled or cascaded to avoid
confusion.  Refer to "Window Menu" on page 67 for additional information.

Menu bar selections at the top of a window change depending on the window type.
Each type of window has a different set of menu options. The window types (Startup,
Matrix, Log, Terminal, and Port Maintenance) can be displayed when working in the
Console application.

Startup Window Menu Bar

When the Director Console application is opened or when all other windows within
the application are closed, the Startup window appears (Figure 28).  The Startup
window menu bar provides options to access to local Console functions not directly
related to a Director, such as adding a new software release or changing password
access.

Figure 28.  Startup Window

Matrix Window Menu Bar

When a Director configuration is selected from the Startup window File menu, the
Matrix window for that Director appears (Figure 29).  Menu bar options expand to
include Director-specific operations, includingcommands toconfigureandmaintain the
Director. Depending on the Director status and configuration, certain menu options may
be disabled (grayed out) and not available.
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Figure 29.  Matrix Window

Note: The appearance of the matrix may vary due to size variations in the working
window, number of logical port addresses shown, and type of Director.  In
addition, the 16-port 9033-004 Director matrix may appear with a gap
between the menu bar and matrix.

Log Windows

When a log or data display window is selected (Director Link Incident log in Figure 30),
menu bar options change to include operations specific to the open window.  The log
contents can be cleared, refreshed, copied to a disk file, and printed, or can be displayed
in a different font or character size.  Log and data display windows include the:

• Console Audit log

• Console Error log

• Director Link Incident (LIN) log

• Director Audit log

• Director Event log

• Hardware Configuration window

• Hardware Audit log

• Node Descriptor list.
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Figure 30.  Log Window (Director Link Incident Log)

Terminal Window

The Terminal window menu bar provides menu options specific to operation within the
Terminal window (Figure 31). Terminal window contents can be cleared, refreshed,
copied to a disk file, and printed, or can be displayed in a different font or character size.

Figure 31.  Terminal Window
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Port Maintenance Window

The Port Maintenance window displays a visual representation of the hardware
configuration and port address mapping of the selected Director. Menu bar options
expand to include Director-specific monitoring and diagnostic operations. The Utility
and Maintenance menus contain the options used to monitor functions of the selected
Director.

Window options allow the operator to swap logical port addresses, access Log
windows and associated functions, initial program load (IPL) the Director, set the
Director offline, access options such as the Terminal window and Loader/Monitor
Area (LMA) Versions, and collect maintenance information.

Figure 32 shows the Port Maintenance window for the 9032-003 Director (124 ports).
The illustration shows that Device Port (DVP) cards in card slots 1, 5, and 17 require
service, and DVP cards are not installed in card slots 21 and 23 through 30.

Figure 32.  Port Maintenance Window (9032-003 Director)

Figure 33 shows the Port Maintenance window for the 9033-004 Director (16 ports).
The illustration shows the DVP card in card slot 1 requires service, and a DVP card
is not installed in card slot 2.
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Figure 33.  Port Maintenance Window (9033-004 Director)

Figure 34 shows the Port Maintenance window for the 9032-005 Director (248 ports).
The illustration shows that DVP cards in card slots 5 and 17 require service, and a
DVP card is not installed in card slot 21. Fibre Channel Converter (FCV) Port cards
are installed in card slots 0, 1, and 2.

Figure 34.  Port Maintenance Window (9032-005 Director)
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Startup Window Menu Options

To start the Director Console application from the OS/2 desktop, double-click
the Director Console icon (Figure 35).

Figure 35.  Director Console Icon

The Startup window (Figure 36) appears. It may take up to 30 seconds for the Console
application to open.

Figure 36.  Startup Window

Note: It is assumed the Director Console application is properly installed on the PC
platform, the platform is powered on, and the OS/2 desktop is displayed prior
to double-clicking the Director Console icon. During installation, ensure the
Director Console icon is not placed in the OS/2 system’s Startup folder.

Startup window pull-down menus and associated menu options are listed in Table 3.
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Table 3.  Startup Window Menu Options

The menu commands allow an operator to:

• Create a new Director configuration matrix (File menu)

• Open a saved or active configuration matrix (File menu)

• Exit the Console application and return to the OS/2 desktop (File menu)

• Maintain up to three Licensed Internal Code (LIC) versions (Utility menu)

• Maintain Console application passwords (Utility menu)

• View and print Console Audit and Error logs (Utility menu)

• Perform window management  (Window menu)

• Access the online help facility (Help menu).

Startup File Menu

The Startup window File menu (Figure 37) provides operator entry to Directors and
associated configuration matrices. The same menu options also appear at the Matrix
window’s File menu (refer to "Matrix File Menu" on page 77 for information). File
menu options are:

• New Configuration Matrix - Opens a new Director definition or a new matrix
for a previously-defined Director (requires a maintenance-level password).

• Open Saved Configuration Matrix - Provides access to a library of previously-
configured matrices for each Director supported by the Console.

• Open Active Configuration Matrix - Opens the current settings (Active Matrix
window) for a selected Director.

• Exit  - Closes all windows and exits the Director Console application.

File Utility Window Help

New Configuration
Matrix LIC Versions Tile Contents
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Configuration Matrix Passwords Cascade Keyboard

Open Active
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Console Audit
Log Arrange Icons Mouse

Exit Console Error
Log Using Help

Product
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Figure 37.  File Menu (Startup Window)

New Configuration Matrix

When the New Configuration Matrix option is selected from the File menu, the Select
Director for New Matrix dialog box appears (Figure 38).

Figure 38.  Select Director for New Matrix Dialog Box
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To open a Director, select (double-click) the Director name in the list box, or highlight
the Director name with the up or down arrow keys and click the OK button. If a Matrix
window is already open for the selected Director, the window closes and a new (blank)
Matrix appears.  The following options are available at the dialog box.

• New Director  - This option allows an operator to add a new Director.
Information is entered through the Director Definition dialog box. A
maintenance authorization password is required.

• Modify Definition - This option allows an operator to modify the definition of
an existing Director.  Information is changed through the Director Definition
dialog box. A maintenance authorization password is required.

• Delete Definition  - This option allows an operator to delete a Director
definition from the Console fixed disk. A maintenance authorization
password is required.

• Director Info  - This option displays definition parameters at the Director
Information dialog box.

Director Definition Dialog Box

Select the New Director or Modify Definition option to open a blank Director Definition
dialog box (Figure 39).  The dialog box provides fields for the Director ID, Director
Model, default Control Unit Port (CUP) name (optional), Internet Protocol (IP)
address, and code page (for port address names). Up to 16 Director definitions can
be created and maintained in the Console library.

Figure 39.  Director Definition Dialog Box

Complete dialog box fields as follows:

• Director ID - Enter an ID (from one to eight characters) that uniquely identifies
the Director to the Console.  Valid characters are A through Z, 0 through 9,
underscore ( _ ), and hyphen ( - ).  The ID appears in Console window titles
and on the Window menu.  Characters typed in the field are automatically
converted to upper case. IDs cannot be duplicated, and disk operating system
(DOS) device names are invalid.
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• Model - This entry identifies the Director model to the Console. Click the arrow
button (adjacent to the list box) or press F4 to display a list of valid selections.

— The 9032-003 Director is defined to the Console as the 28 to 124
port Director.

— The 9033-004 Director is defined to the Console as the 8 to 16
port Director.

— The 9032-005 Director is defined to the Console as the 24 to 248
port Director.

• Default CUP Name - This entry is optional and can be used to assign the same
CUP name to multiple configuration matrices for a Director.  If a name is
entered, it appears in the CUP Name field at the bottom of the Matrix window.
When the matrix is saved, the name becomes the default for future matrix
definitions for that Director.  The name can be changed by modifying the
Director definition or using the CUP Name option from the Matrix window’s Edit
menu.

• IP Address  - The entry is the IP address for the Director on the Token Ring
LAN. Each IP address must be unique for devices on the LAN. The address
is in the form nnn.nnn.nnn.nnn , where nnn is a decimal byte in the range zero
through 255.  The address may not be all zeros or all 255s.

• Code Page - This entry selects the code page used for port address names.
Click the arrow button (adjacent to the list box) or press F4 to display a list of
valid selections. The default value is US/Canada.

• Open active window on Console start-up  - Enable this check box to open
the Active Matrix window for this Director each time the Console application is
started. If the box is checked for only one Director, that Director is the default
displayed when the Console application opens. If the box is checked for multiple
Directors, multiple active windows open (one for each Director with the box
enabled).

The Console application validates field length, IP address, and Director ID for
uniqueness when the OK button is clicked. Any error in these fields is indicated by
an error message with the invalid field highlighted.

Delete Definition

Select the Delete Definition option to open the dialog box shown in Figure 40. Select
the Delete button.  The Maintenance Authorization dialog box appears.  Type a
maintenance authorization password (default is LEVEL002 ) and click the OK button.
The selected Director definition is deleted from the Console.

Attention!

The default value for this field is the 24 to 248 port Director. The selection
can only be changed when a new Director is defined. The field cannot be
modified for an existing Director definition.
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Figure 40.  Delete Director Definition Dialog Box

Director Information Dialog Box

Select the Director Info button to open the Director Information dialog box
(Figure 41).   Basic information for the selected Director appears. The dialog
box can remain open to display information about each Director as a Director is
selected from the list box.

Figure 41.  Director Information Dialog Box

Information in this dialog box is generated from the Director definition (CUP name,
type and model, code page, and IP address) and from Director information supplied
to the Console (all other fields).
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The Feature Flags field is a 2-digit hexadecimal value that indicates support of
Fibre Connection (FICON) operation.  A feature flag of 00 indicates the Director
does not support FICON operation. 9032-003 and 9033-004 Directors always have
a feature flag of 00.  A feature flag of 01 indicates the Director supports FICON
operation.  A 9032-005 Director with one or more FCV Port cards installed has a
feature flag of 01.

Open Saved Configuration Matrix

When the Open Saved Configuration Matrix option is selected from the File menu,
the Select Saved Configuration Matrix dialog box appears (Figure 42).  To open a
saved matrix, select (double-click) a Director name from the Director list box, then
select a matrix name from the Matrix list box (or highlight the selections with the up
or down arrow keys and click the OK button). Use the Tab key to change between
the Director and Matrix list boxes.

Figure 42.  Select Saved Configuration Matrix Dialog Box

The following options are available at the dialog box.

• Delete  - This option allows an operator to delete a configuration matrix
from the Console fixed disk. An operator authorization password is
required.

• Matrix Info  - This option displays matrix information at the Saved Matrix
Information dialog box.

• Director Info  - This option displays definition parameters at the Director
Information dialog box.

Delete

Select the Delete option to open the dialog box shown in Figure 43.  Select the
Delete button.  The Operator Authorization dialog box appears.  Type an operator
authorization password (default is LEVEL003 ) and click the OK button. The selected
configuration matrix  is deleted from the Console.
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Figure 43.  Delete Configuration Matrix Dialog Box

Saved Matrix Information Dialog Box

Select the Matrix Info button to open the Saved Matrix Information dialog box
(Figure 44).  The dialog box displays information about the selected configuration
matrix. Selecting a different configuration matrix from the list box displays information
about that saved matrix.

Figure 44.  Saved Matrix Information Dialog Box

The following information appears in the dialog box.

• Description - A description of the configuration matrix specified when saved
using the Save Configuration Matrix As option from the Matrix window’s File
menu. Refer to "Save Configuration Matrix As" on page 81 for more information.

• Date and Time  - The date and time the configuration file was last saved or
updated.

• Status - The status for all files is Saved , because the dialog box displays only
saved files. Other status conditions may also be displayed next to the Saved
indicator. However, the file may be Locked if a host system is using the file or
if Active = Saved is set for the IPL file. An IPL file may also be Unavailable if
the Token Ring link to the Director is unavailable.
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Director Information Dialog Box

Select the Director Info button to open the Director Information dialog box
(Figure 41 on page 54). Basic information for the selected Director appears. Refer
to "Director Information Dialog Box" on page 54 for additional information.

Open Active Configuration Matrix

Changes made to a configuration matrix are not implemented for a Director until the
matrix is activated. Matrix activation transmits a copy of the current (new or saved)
matrix to the Director and enables changes to the active matrix for the Director.

When the Open Active Configuration Matrix option is selected from the File menu,
the Select Active Director dialog box appears (Figure 45). To open a Director (display
an active matrix), select (double-click) the Director name in the list box, or highlight
the Director name with the up or down arrow keys and click the OK button.

Figure 45.  Select Active Director Dialog Box

Options available at the dialog box are identical to those available at the Select
Director for New Matrix dialog box (Figure 38 on page 51). If the Open active window
on Console start-up check box at the Director Definition dialog box (Figure 39 on
page 52) is enabled, the Active Matrix window for each enabled Director appears
when the Console application opens.

When a Matrix window (new, saved, or active matrix) is selected and displayed,
the menu bar expands to include operations available only from the Matrix window.
This includes commands for configuring and maintaining the Director.  In addition,
expanded File and Utility menus with more options are available.  Refer to "Matrix
File Menu" on page 77 and "Matrix Utility Menu" on page 104 for information.

Exit

Select the Exit option from the File menu to close all windows and exit the Director
Console application.
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Startup Utility Menu

The Startup window Utility menu (Figure 46) provides tools required to monitor and
report on Console-level functions. The same menu options also appear at the Matrix
window’s Utility menu (refer to "Matrix Utility Menu" on page 104 for information).
Utility menu options are:

• LIC Versions - Lists all Director LIC versions (up to three versions) stored on
the Console fixed disk.

• Passwords - Allows an administrator to view or modify password identifications
and associated descriptions (requires password-level authorization).

• Console Audit Log - Displays a list of recent Console operator activities. The
activities are not specific to a Director.

• Console Error Log  - Displays a list of recent Console errors or exception
conditions.

Figure 46.  Utility Menu (Startup Window)

LIC Versions

The LIC Versions dialog box (Figure 47) displays a list of LIC versions stored on the
Console fixed disk.  Up to three LIC versions can be maintained.  From this dialog
box, new LIC versions are installed on the fixed disk, existing version descriptions
are edited, and unused versions are deleted.
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Figure 47.  LIC Versions Dialog Box

Dialog box buttons and functions are:

• New - Provides the ability to load a new LIC version from diskettes to the
Director Console fixed disk.

• Edit  - Allows the description (for a selected LIC version) to be edited.

• Delete  - Deletes the selected LIC version from the Console fixed disk.

• Set Offline  - Allows the operator to set the Director offline.

Note: When installing a LIC version to a Director without a redundant
Control Processor (CTP) card, ensure the Director is set offline
prior to installing the LIC version.

• Install  - Installs the selected LIC version to the Director.

• Close  - Closes the dialog box.

The six-digit LIC version number (XX.YY.ZZ) represents the following:

XX - LIC version level

YY - LIC release level

ZZ - LIC patch level.

Attention!

LIC version 5.0 (or later) and FICON operation are not supported by
9032-003 or 9033-004 Directors.  Attempts to install LIC version 5.0
(or later) to these Director models are prevented by the Director Console.
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Passwords

When the Passwords option is selected from the Utility menu, the View IDs and
Modify options are displayed.  The View IDs option opens the Passwords dialog
box shown in Figure 48.

The dialog box contains three radio buttons to select a password authorization level
for view.  The levels of password authorization are:

• Level 1 - Password (Administrative) Authorization  - This level of
authorization allows administrators to display, add, modify, and delete
passwords for all levels of authorization, and allows access to the port
authorization function.

• Level 2 - Maintenance Authorization  - This level of authorization allows
service personnel to access maintenance and diagnostic functions, and to
make changes to a Director definition.

• Level 3 - Operator Authorization - This level of authorization allows users to
change, save, and activate Director configuration matrices.

Figure 48.  Passwords Dialog Box (View IDs Option)

For each authorization level, the dialog box displays password identifications (such
as L101, L102, L201, and L301) and associated descriptions. The actual passwords
are not displayed.  A password description can be up to 24 characters long.  This
option provides access to password IDs and descriptions for review only.  Entry to
the dialog box does not require a password, and no modification to a password,
password ID, or description is allowed.
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The Modify option opens the Passwords dialog box shown in Figure 49.  This
option requires a valid administrative authorization password to add or modify a
password, and the task is usually performed by a system administrator.  Refer to
"Adding, Modifying, and Deleting Passwords" on page 174 for instructions.

Passwords are required to access or save changes to most Matrix window options.
Up to 30 passwords can be defined for each authorization level.  Error checking
ensures duplicate passwords are not entered.  All activities requiring password
access are logged (with the associated password ID) in the Console Audit log.

Password IDs are used in audit log files to identify who performed an operation.
The IDs appear in the leftmost column of the Director Audit and Console Audit
logs.  Password IDs appear as follows:

• If a password is not defined for an authorization level, the password ID is blank.

• If the change occurred at the Director, the password ID is Dixx .

• If the change occurred from a host-based application such as System
Automation for Operating System/390 (SA OS/390) the Password ID is H
with a host identifier.

Figure 49.  Passwords Dialog Box (Modify Option)

Password-protected Console features are listed below, arranged by the required
authorization level.  Menu option or button names are separated by an arrow to
indicate the command location in the user interface.  For example, the Password
option from the Utility menu is indicated by Utility > Passwords. A slash( / ) separates
multiple items that use the password. All changes made with password access are
logged to the Director Audit log, except those indicated as logged to the Console
Audit log.
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Password (Administrative) Authorization

The following menu items require password (administrative) authorization.  The
default password is LEVEL001 .

• Utility > Passwords - Define and maintain passwords (Console Audit log)

• Utility > Port Authorization - Authorize operators to configure ports.

Maintenance Authorization

The following menu items require maintenance authorization. The default password
is LEVEL002 .

• File > New Configuration Matrix / New / Modify / Delete - Perform Director
definition operations (Console Audit log)

• File > Open Active Configuration Matrix / New / Modify / Delete - Perform
Director definition operations (Console Audit log)

• Utility > LIC Versions - Add or delete LIC versions (Console Audit log)

• Utility > Clear System Error - Clear the System Error indicator

• Utility > Reset Installation Defaults - Reset non-volatile information to
installation default values

• Maintenance > Director Event Log - Log hardware and software incidents

• Maintenance > Swap Ports - Modify physical port mapping (accessed from the
Port Maintenance window)

• Maintenance > Port Diagnostics / ESCON - Perform port diagnostics for an
ESCON device port (accessed from the Port Maintenance window)

• Maintenance > Port Diagnostics / FICON - Perform port diagnostics for an FCV
port (accessed from the Port Maintenance window)

• Maintenance > Advanced / Terminal - Opens a Terminal window

• Maintenance > Advanced / LMA Versions - Install Loader/Monitor Area
(LMA) versions.

Operator Authorization

The following menu items require operator authorization.  The default password is
LEVEL003 .

• File > Open Saved Configuration Matrix / Delete - Delete a saved
configuration file

• File > Activate Configuration Matrix - Activate a Director configuration

• File > Save Configuration Matrix - Save a Director configuration

• File > Save Configuration Matrix As - Save a Director configuration under
a new name

• Edit > Enable Operator - Use the enable operator function
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• Edit > Command Lists - Use the command list function

• Utility > Time/Date / Console Sync / OK - Modify the Director time and date

• Utility > Active = Saved - Toggle the Active = Saved state

• Utility > Remote Offline Control - Toggle the Remote Offline Control state

• Utility > IPL Director - Reload Director software from the last configuration

• Utility > Set Director Offline - Set the Director offline (must be manually
powered on).

Console Audit Log

The Console Audit log (Figure 50) automatically tracks and records Console
operator activities not specific to a Director, including:

• Changing passwords

• Installing or deleting LIC versions

• Adding or deleting a Director definition

• Entering or exiting the Console application.

Note: The Director Audit log is identical in format to the Console Audit log,
but records only Console operator activities specific to a Director.

Figure 50.  Console Audit Log
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When a log window (Console Audit, Console Error, Director LIN, Director Audit or
Director Event log) is selected, the menu bar changes to provide commands unique
to the log window. The logs can be refreshed (re-read), saved to a file, or printed.
The log text can also be displayed in different fonts and character sizes. Refer to
"Console Log Operation" on page 65 for additional information. The log contains the
following columns of information:

• ID - The Password ID of the Console operator performing the action.  If no
password is defined or applicable (Console start or exit), the field is blank.

• Action  - A brief description of the performed action.

• Name - An identifier whose content depends on the action.  For example, a
password ID for password actions, a Director ID for Director definition actions,
or a LIC version for microcode actions.

• Date - The date the action was performed.

• Time - The time the action was performed.

Console Error Log

The Console Error log (Figure 51) automatically tracks and records Console
exception conditions.  Exception conditions are errors that are potentially severe
enough to affect Console operations, such as:

• Insufficient memory or memory corruption

• File read/write errors

• Subsystem internal errors

• Inability to access a resource.

When a log window (Console Audit, Console Error, Director LIN, Director Audit or
Director Event log) is selected, the menu bar changes to provide commands unique
to the log window. The logs can be refreshed (re-read), saved to a file, or printed.
The log text can also be displayed in different fonts and character sizes. Refer to
"Console Log Operation" on page 65 for additional information. The log contains the
following columns of information:

• Error Message - A brief error message describing the exception condition

• Qualifier  - An internal code identifying the failed component

• Date - The date the exception condition occurred

• Time - The time the exception condition occurred.

Information in the Console Error log is typically of use only to qualified service
technicians fault isolating a Console problem.
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Figure 51.  Console Error Log

Console Log Operation

The Console Error and Console Audit logs store up to 128 entries. After the maximum
number of entries has been stored, new entries overwrite the oldest entries.

When a log window is first opened, the entire contents of the log file are available
for display (scrolling may be required). New log events that occur while the window
is open are not displayed until the Refresh option is selected from the File menu.

Menu options specific to log windows are available from the File and Font menus.
Options available from the Window and Help menus are identical to those options
available from the Startup window. Refer to "Window Menu" on page 67 and "Help
Menu" on page 69 for information.

Console Log Window File Menu

File menu options (Figure 52) available from the Console Error and Console Audit
logs are:

• New Configuration Matrix - This option is identical to the same option at the
Startup window File menu.  Refer to "New Configuration Matrix" on page 51
for information.

• Open Saved Configuration Matrix - This option is identical to the same option
at the Startup window File menu. Refer to "Open Saved Configuration Matrix"
on page 55 for information.
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• Open Active Configuration Matrix - This option is identical to the same option
at the Startup window File menu. Refer to "Open Active Configuration Matrix"
on page 57 for information.

• Refresh  - Select this option to write the latest information to the log window
and refresh the display.

• Save to File - Select this option to open the Save As dialog box and save log
data to a user-specified file on diskette or the Console fixed disk.

• Print - Select this option to print the log window contents to a file or printer.

• Print Setup - Select this option to open the Print Setup dialog box and assign
print and printer parameters. Printer selection must be complete (from the Print
Setup dialog box) before using the Print option to print a log file.

• Close Window - Select this option to close the log window and return to
the Startup window.

• Exit - Select this option to close all windows and exit the Director Console
application.

Figure 52.  File Menu (Console Error and Audit Logs)
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Console Log Window Font Menu

The Font  menu available from the Console Error and Console Audit logs provides
only a Select option. Selecting this option opens the Font dialog box, where the font,
font style, and font size for the log window text are changed and saved.

Window Menu

The Startup window Window menu (Figure 53) provides the ability to simultaneously
arrange and manipulate open windows.

Figure 53.  Window Menu (Startup Window)

The Tile, Cascade, and Arrange Icons options appear in all instances of the Window
menu and are described as follows:

• Tile - This option arranges all windows (that are open and visible) to a
size small enough to simultaneously fit in the application window without
overlapping (Figure 54). The size and position of the tiles is a function of the
number of open windows.
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Figure 54.  Tiled Windows

• Cascade  - This option sizes all document windows to the same size and
overlaps the windows (Figure 55).  Link Status indictors and title bars for the
eight most recently viewed windows are visible.

Figure 55.  Cascaded Windows
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• Arrange Icons - This option organizes all windows that are minimized (shown
as icons) along the bottom of the application window (Figure 56).

Figure 56.  Arranged Icons

Each open window is listed in the list portion of the Window menu (not shown).
An operator can select an open window to be brought to the front by selecting
the window from this menu.

Help Menu

General help topics are available for all windows from the Help menu. Help menu
options are:

• Contents  - This option provides a list of high-level Console topics for which
help is available. Details are available by double-clicking the topic name with
the mouse, or by selecting the topic with the Tab key, then pressing the Enter
key. Displayed contents are contingent on the Director type open. If no Director
is open, a dialog box appears that allows an operator to select the Director
contents to display.

• Keyboard - This option describes how to navigate in the Console application
using the keyboard.

• Mouse - This option describes how to navigate in the Console application using
the mouse.

• Using Help  - This option describes how to use Help topics.
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• Product Information - The Product Information dialog box (Figure 57) displays
information about the Console application, including version number and
copyright notice. When contacting support personnel about problems with the
Console application, provide this version number.

Figure 57.  Product Information Dialog Box

Help buttons are available for most application dialog boxes. Alternatively, press the
F1 key from any window or the Alt+H from any dialog box to access Help topics for
the window or dialog box.  Related topics of interest are underlined.  Double-click
any underlined word or phrase to transfer to another window (or pop-up box) that
explains the selected topic.
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Chapter 3.  Matrix Window Operations

This chapter describes operation of the Director Matrix window. Matrix window
navigation and operation, pull-down menus, menu item operation, and commands
are discussed.  All operations apply only to a currently selected Director.

Matrix Window

The graphic display of the configuration matrix (Figure 58) provides a user with
an easy-to-recognize visual interface that displays configuration attributes of the
selected Director.

Figure 58.  Matrix Window and Components

Port Addresses and Names

Logical port addresses and associated user-defined port names are listed in rows
at the left side of the window.  Display and configuration operations in the window
relate to these addresses. By clicking a port address or name, the address selection
highlight (dashed box around a matrix row) moves to and selects that address line.
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Menu operations and port attribute changes affect the selected port. For example,
to modify a selected port address name and associated attributes, select the Name
and States option from the Edit menu (or use the Alt+N accelerator keys).  If an
asterisk appears between the port address and associated name, the port address
mapping is changed from the default value for the port. Refer to "Port Maintenance"
on page 127 for additional information.

Status Columns

To the right of the address names are two columns in graphic display mode (Hdwr
and Con ) or three columns in nongraphic display mode (H, B, and C), indicating
hardware status and connection status for each port address. These columns and
the connection matrix cells to the right relate to port address rows. Refer to "Graphic
Display" on page 102 for additional information.

The first column to the right of the port address name is the hardware column.  In
graphic display mode the column is titled Hdwr , and in nongraphic display mode
the column is titled H.  This column displays the hardware status of the port for
an active Director link, and cannot be modified by a user.  For a new or saved
matrix, only the NotInst  or N indicator appears (when appropriate). Table 4 lists
active matrix hardware status indicators.

Table 4.  Hardware Status Indicators

Graphic
Display Mode

Nongraphic
Display Mode

Status

(Blank) (Blank) Port is installed and operational.

NotInst N Port is not installed.

Maint M Port is set to maintenance mode.

Service S Service is required. Call a service representative
to clear the error.

Thrshld T Device error threshold was exceeded and the port
attached to the disruptive device was set offline.

Invalid A An attached device is invalid (sending unexpected
responses), or a wrap plug is installed in the port.

LnkFail L A link failure occurred.

Offline O Port is offline.

Degrad D Port card is degraded or not operating at peak
capacity (FCV Port card only).

Inactive I Port card is inactive or will not come online (FCV
Port card only).

Logout G Attached host system performed an explicit logout
from the port card (FCV Port card only).

Unaddr U Port is unaddressable (FCV Port card only).
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In graphic display mode, the Con  column displays a connectivity indicator that
represents blocked and dedicated connections for the associated port address.  If
the column contains an X, the port address is blocked. If the column contains a port
address, a dedicated connection to that port is indicated. Refer to Figure 92 on page
102 for an example of graphic display mode.

In nongraphic display mode, two columns appear to the right of the hardware status
column.  The B column displays a blocked status indicator.  If the column contains
a B, the port address is blocked. The C column displays a connectivity indicator. If
the column contains a port address, a dedicated connection to that port is indicated.
Refer to Figure 93 on page 103 for an example of nongraphic display mode.

Connectivity Matrix

In graphic display mode, the gray connectivity matrix graphically indicates all
connectivity attributes, including blocked, dedicated, and prohibited connections.
Refer to "Matrix Highlights and Symbols" on page 139 for information about the
display of connectivity attributes.  These visual indicators appear in addition to the
contents of the connectivity column (Con ).

In nongraphic display mode, a red P appears in a intersecting matrix cell to indicate
a prohibited connection (between the row port address at the left of the window and
the column port address at the top of the window). No other connectivity indicators
appear in nongraphic display mode.

Scrolling and Matrix Map

By default, 9032-003 and 9032-005 Director matrices displays 32 port addresses
horizontally and vertically.  However, the 9032-003 Director can support up to 124
ports and the 9032-005 Director can support up to 248 ports and a scrolling function
is provided to display connectivity attributes for remaining port addresses.  Scroll
bars and page keys are used to scroll up or down (PgUp or PgDn ) and left or right
(Ctrl+PgUp  or Ctrl+PgDn ).

Use a matrix map to view a designated section of the matrix (depending on display
options chosen).  To use a matrix map, select the Matrix Map option from the
View menu, or click the matrix map (M) button at the lower right corner of the Matrix
window.  The matrix map button is disabled for 9033-004 Matrix windows.  For
additional information, refer to "Matrix Map" on page 101.

Status Line

A status line (Figure 59) appears at the bottom of each Console window. For Matrix
and Port Maintenance windows, the status line provides:

• Link Status Indicator  -  Indicates the status of the Token Ring link between
the Director and Director Console.

• Director Status Indicator  - Indicates the operational status of the Director.

• System Error Indicator  - Illuminates when a system error occurs.

• Operator ID Area  - Displays the operator ID for port authorizations.

• Message Area  - Displays transient status, error, and other informational
messages.
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For Terminal and log windows, the status line provides only a Link Status indicator
and message area.  Other log windows provide only a message area.

Figure 59.  Status Line

Link Status Indicator

Three Director-to-Console link operational states are indicated by the Link Status
indicator (Figure 60):

• Link available and idle - Indicates the normal link condition (green lightning
bolt on a gray background), where the link is up but no traffic is exchanged.

• Data being exchanged  - Indicates a busy state (yellow circle on a gray
background), where data is transmitted to or received from the Director. This
is a transient state normally observed after completing a command.

• Link not operational  - Indicates an unavailable state (black slash on a red
background) where the connection cannot be made between the Director and
Console.

Figure 60.  Link Status Indicator Operational States

Director Status Indicator

Four Director operational states are indicated by the Director Status indicator
(Figure 61):

• Director is operational - Indicates the Director is fully operational and
operational status bytes are all zeros (0000).

• Director is offline - Indicates the Director received an offline command from
the host system or the Director Console.

• Director status is degraded  - Indicates the Director is operating, but the
operational status bytes are other than all zeros. To display values of Director
status bytes, double-click the Director Status indicator or select the Director
Operational Status option from the Utility menu.
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• Director status is unknown - Indicates the Director-to-Console link status is
unavailable and the Director operational status cannot be obtained.

Figure 61.  Director Status Indicator Operational States

System Error Indicator

Two states are indicated by the System Error indicator (Figure 62):

• Indicator extinguished - No system errors have occurred and the indicator is
off.  This is the normal operating condition.

• Indicator illuminated  - A system error occurred and the indicator is on
(yellow diamond on a gray background).

Figure 62.  System Error Indicator States

Message Area

The message area displays transient operator messages such as error conditions or
indications that operations are complete.  For example, any change to the Director
operational status displays a message indicating the change, and alters the contents of
the status indicator. Changes that could go unnoticed (such as updates to the hardware
status column from the host), are indicated in the status line message area.  Certain
user operational errors are also indicated in the message area.  Colors indicate the
priority of the message:

• Black text  indicates normal status (information message only).

• Yellow text indicates transient status (such as a command transmit state) or
notification messages (such as notification that the hardware status column
was updated).

• Red text indicates an error condition (operator command error, Director error,
or link error).

A status message is cleared by double-clicking the Matrix window (such as on the
message area of the status line), or by a keystroke received by the window.
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Matrix Window Menu Options

Matrix window pull-down menus and associated menu options are listed in Table 5.
The Window and Help menus are identical to those menus for the Startup window
and are not discussed in this chapter.  Refer to "Window Menu" on page 67 for
an explanation of Window menu options.  Refer to "Help Menu" on page 69 for an
explanation of Help menu options.

Table 5.  Matrix Window Menu Options

File Edit View Utility Maintenance

New Configuration
Matrix Copy Swap Axis Director

Operational Status Director LIN Log

Open Saved
Configuration
Matrix

Paste Matrix Map Node Descriptor Director Audit
Log

Open Active
Configuration
Matrix

Blocked Enter Position Time/Date Director Event
Log

Merge Saved
Configuration
Matrix

Dedicated Graphic Display Active = Saved Hardware
Configuration

Activate
Configuration
Matrix

Prohibited Display Options Remote Offline
Control

Hardware Audit
Log

Save Configuration
Matrix Prohibit Row LIC Versions Node Descriptor

List

Save Configuration
Matrix As Allow Row Passwords Port

Maintenance

Copy Matrix
Configuration File Prohibit Range Port Authorization Advanced

Print Matrix to Text
File Block Range Console Audit Log

Collect
Maintenance
Information

Close Window Name and states Console Error Log Console Link
Statistics

Exit CUP Name IPL Director

Names Set Director Offline

Enable Operator Clear System Error

Command Lists Reset Installation
Defaults
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Monitoring Multiple Directors

A user can visually monitor all Directors attached to the Console by opening Matrix
windows for the Directors and tiling them (Tile option from the Window menu) on a
full screen. Indicators on the status lines of all Matrix windows appear. Status messages
andcolorandshapechangesquickly indicateconditionsthat requireactionsbyoperations
or service personnel.

Matrix File Menu

The Matrix window File menu (Figure 63) provides operator entry to Directors and
associated configuration matrices. The menu contains the same options to create
and open saved or active configuration matrices as the Startup window File menu.
These options function identically and are not discussed in this chapter.  However,
the Matrix window File menu is expanded to include additional functions that are
unavailable at the Startup window File menu. File menu options are:

• New Configuration Matrix - Identical to the same option at the Startup window
File menu.  Refer to "New Configuration Matrix" on page 51 for information.

• Open Saved Configuration Matrix - Identical to the same option at the Startup
window File menu.  Refer to "Open Saved Configuration Matrix" on page 55
for information.

• Open Active Configuration Matrix - Identical to the same option at the Startup
window File menu.  Refer to "Open Active Configuration Matrix" on page 57
for information.

• Merge Saved Configuration - Allows a user to merge a saved configuration
matrix with the active configuration matrix. If there are conflicting port address
attributes, active port address attributes prevail. This option is valid only for an
attached Director (active matrix).  The menu option is grayed out in Saved
Matrix or New Matrix windows.

• Activate Configuration Matrix - Overlays the current (active) set of Director
port attributes with a new configuration matrix.

• Save Configuration Matrix - Saves the displayed saved matrix with the same
file name.

• Save Configuration Matrix As  - Allows a user to save the displayed new,
saved, or active matrix under a different file name.

• Copy Matrix Configuration File  - Allows a user to copy a selected
configuration matrix file to and from a diskette (in the disk drive of the Director
Console), or to and from a Director library (on the Director Console fixed disk).
Chapter 3.  Matrix Window Operations      77



• Print Matrix to Text File  - Saves (prints) the matrix to a specified American
National Standard Code for Information Interchange (ASCII) text file.

• Close Window  - Closes the open Matrix window.

• Exit  - Closes all windows and exits the Director Console application.

Figure 63.  File Menu (Matrix Window)

Matrix Types

The Director uses two separate and distinct types of matrices. The first type is the
active matrix. The active matrix is resident on the Director and displays the operating
set of Director port assignments.  Each Director has only one active matrix.

The second type is the saved matrix.  Multiple saved matrices comprise a set of
specific configuration attributes (stored on the Console fixed disk) that can be copied
to the working matrix image (activated).  Saved matrices act as templates to store
configuration options for the Director.  When a saved matrix is activated, the
configuration attributes of the saved matrix are copied to the working matrix image
and become the current configuration attributes. A saved matrix is not affected when
activated.

Note: When changes are made to a Matrix window but not saved or activated, an
attempt to close the window or exit causes the Console to display the following
verification dialog box (Figure 64).
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Figure 64.  Changes Pending Dialog Box

Merge Saved Configuration

Select the Merge Saved Configuration option from the File menu. The Merge Saved
Configuration Matrix dialog box appears (Figure 65). This option allows an operator
to select a saved configuration matrix and merge it onto the active matrix.

Figure 65.  Merge Saved Configuration Matrix Dialog Box

The dialog box prompts the user to select a saved matrix from the Matrix list box.
The IPL (initial program load) configuration is not included in the list because it is a
special saved matrix. The IPL matrix is stored in non-volatile memory at the Director,
not on the Console fixed disk.  To merge configuration matrices, double-click the
desired configuration name from the list of saved configurations, or select the desired
configuration name and click the OK button.
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When a saved matrix is merged onto the active matrix, the active matrix highlights
the changes between the matrices in the same manner as if the operator had entered
the changes. When port authorization is enabled, the merge function adheres to the
port address authorization restrictions.  Refer to "Port Authorization" on page 109
for additional information.

Activate Configuration Matrix

Changes made to a configuration matrix do not take effect for a Director until the
matrix is activated.  Activation transmits the contents of the matrix to the selected
Director, enabling the changes. Select the Activate Configuration Matrix option from
the File menu.  The Operator Authorization dialog box appears.  Type an operator
authorization password (default is LEVEL003 ) and click the OK button. The Activate
Configuration Matrix dialog box appears (Figure 66).

Figure 66.  Activate Configuration Matrix Dialog Box

The dialog box provides check boxes associated with attributes for the current
configuration matrix.  These attributes specify port connection types (blocked,
dedicated, prohibited), port address names, and the Control Unit Port (CUP) name
that are to be changed upon activation of the configuration matrix. Changes to the
matrix are indicated as checked (enabled) items in the attribute list. The Activate All
button (default) activates all attributes. The Activate Selected button transmits only
the checked (enabled) attributes to the active matrix.

If the Active = Saved option is enabled, the activated matrix is also stored as the IPL
configuration for the Director.  The Active = Saved option is enabled by this dialog
box (immediately prior to sending the activation command) or by the Active = Saved
option from the Utility menu.  Refer to "Active = Saved" on page 109 for additional
information.

Attention!

The default is Active = Saved enabled.  It is recommended to leave the
option enabled.
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Save Configuration Matrix

Select the Save Configuration Matrix option from the File menu.  The Operator
Authorization dialog box appears. Type an operator authorization password (default
is LEVEL003 ) and click the OK button.  The displayed configuration is saved with
the same name as currently defined configuration (overwrites the existing file on the
Console fixed disk) with no additional prompting.

Save Configuration Matrix As

Select the Save Configuration Matrix As option from the File menu.  The Operator
Authorization dialog box appears. Type an operator authorization password (default
is LEVEL003 ) and click the OK button. The Save Configuration Matrix As dialog box
(Figure 67) appears.  This dialog box also appears when a new or active matrix is
saved using the Save Configuration Matrix option. New and active matrices require
a file name to be saved.

Figure 67.  Save Configuration Matrix As Dialog Box

The dialog box prompts for a new name and description of the matrix to be saved.
Up to32configurations (including the IPL matrixfile) canbedefined foreachDirector.
The IPL file comprises the set of configuration attributes loaded to the Director’s
active matrix after an IPL or power cycle.  This file is saved to nonvolatile memory
on the Director’s Control Processor (CTP) card, not to the Director Console fixed
disk. To preserve configuration attributes, the IPL file is overwritten with the Director’s
current active matrix when the Active = Saved option is set on during activation.

To save the configuration to the Console fixed disk, double-click the desired
configuration name from the list box (or use the Copy Name/ Description button) to
copy information to the Name and Description entry fields, make any desired
changes, and click the OK button.  Available dialog box fields and options are:
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• Name - The name under which the configuration matrix is stored. Up to eight
alphanumeric characters are allowed, including letters (A through Z), numbers
(0 through 9), underscores, and hyphens. If the entered name is the same as
an existing matrix name, a prompt appears warning that the previous matrix
will be overwritten.

• Description - The matrix description can be up to 24 alphanumeric characters
in length (same character rules as the name), and is stored with the matrix file
for reference.  The matrix description appears in Saved Matrix windows only
(in parentheses), and on the same message line as the CUP name.

• Matrix Info - Highlight a desired matrix name and click the Matrix Info button
to open the Saved Matrix Information dialog box (Figure 68). The dialog box
displays information about the selected configuration matrix, and can be
retained for viewing information on other matrix files by clicking the desired
name in the list box at the Save Configuration Matrix As dialog box.

Figure 68.  Saved Matrix information Dialog Box

• Copy Name/Description  - Highlight a matrix name in the list box and click
the Copy Name/Description button (or double-click the matrix name) to copy
the matrix name and description into the Name and Description fields at the
top of the dialog box.  This provides a quick method to replace an existing
matrix, or to save a new matrix with a name and description similar to an
existing matrix.

• Delete  - To delete a configuration, highlight a desired matrix name and click
the Delete button.  The following dialog box appears (Figure 69).

Figure 69.  Delete Configuration Matrix Dialog Box
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Note: The IPL file cannot be deleted.  The Delete button is disabled when
the IPL file is highlighted.

Click the Delete button to  close the dialog box and remove the selected
configuration matrix from the Console fixed disk.

Copy Matrix Configuration File

Select the Copy Matrix Configuration File option from the File menu. The Operator
Authorization dialog box appears. Type an operator authorization password (default
is LEVEL003 ) and click the OK button. The Copy Matrix Configuration File dialog
box appears (Figure 70).

Figure 70.  Copy Matrix Configuration File Dialog Box

This option enables an operator to:

• Copy matrices from Director to Director

• Copy matrices from Director to diskette

• Copy matrices from diskette to Director.

Copied matrix files are saved with the current name or assigned a new configuration
name.  The Source section of the dialog box prompts for source Director and file
names, or a path to the source file. The Destination section of the dialog box prompts
for a destination Director and file names, or a path to the source file.
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Print Matrix to Text File

Select the Print Matrix to Text File option from the File menu to open a standard
Save As dialog box. The dialog box prompts for a valid file name. After verifying the
user-selected file name, click the Save button to write the configuration matrix data
to a file in American National Standard Code for Information Interchange (ASCII)
format.

Close Window

Select the Close option from the File menu to close the active window. This function
closes only the active window, and does not exit the Console application.  If other
windows are open, the most recently active window appears.

Exit

Select the Exit option from the File menu to close all windows and exit the Director
Console application.  If any open matrix windows have modified data, a prompt
appears asking if the modifications should be saved to the Console library.

Matrix Edit Menu

The Matrix window Edit menu (Figure 71) provides options to modify configuration
attributes and port names at the Matrix window.  Some menu options are disabled
(grayed out), depending on the cell cursor position. Check marks adjacent to certain
options indicate an attribute is currently set for the port or port intersection. Edit
menu options are:

• Copy  - Copies attributes from a port address.

• Paste  - Pastes previously copied attributes to a port address.

• Blocked  - Toggles the blocked attribute for a selected port address and cell.

• Dedicated - Toggles the dedicated attribute for a selected port address and cell.

• Prohibited  - Toggles the prohibited attribute for a selected port address
and cell.

• Prohibit Row  - Sets the prohibited attribute for all port intersections in a
selected port address row.

• Allow Row  - Sets the allowed attribute for all port intersections in a selected
port address row.

• Prohibit Range - Sets the prohibited or allowed attribute for a selected range
of port addresses.

• Block Range - Sets the blocked or unblocked attribute for a selected range of
port addresses.

• Name and States  - Allows a user to select multiple attributes for a selected
port address and intersection cell.

• CUP name  - Allows a user to modify the control unit port name.
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• Names  - Allows the user to assign a name or description to a port address.
The name or description appears on the Matrix window.

• Enable Operator - Selected when a user requires port authorization privileges
to edit a configuration matrix. This option is used after the Port Authorization
option from the Utility menu is enabled.

• Command Lists - Allows a user to compile a series of frequently-used attribute
commands into a file for batch execution.

Figure 71.  Edit Menu (Matrix Window)

Copy and Paste

The Copy and Paste options provide the ability to duplicate the allow and prohibit
attributes from a selected port address to another port address in the same Matrix
window, or to a port address in another Matrix window.  To copy attributes from a
source port address, select (highlight) the address and click the Copy option.  To
paste the selection to another address, select (highlight) the destination address and
click the Paste option.

Note: This procedure copies and pastes allowed and prohibited attributes only.
Self-intersection values (the intersection of a port with itself) are undefined
and the procedure is invalid for the intersection.

The copy operation fills a buffer whose contents can be pasted to one or more
locations until the buffer is overwritten by the next copy operation. Data in the buffer
can be pasted to another port address in the same Matrix window, or to a port
address in any other Matrix window for any Director defined to the Console. Because
allowed and prohibited data are not pertinent to applications other than the Console,
copied data is not available to other applications.
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The Ctrl+Insert  and C accelerator keys are available for the copy operation.  The
Shift+Insert  and T accelerator keys are available for the paste operation.  The C
and T accelerator keys operate only in the Matrix window.

Text in dialog box fields can be copied and pasted within the Console application or
to and from other applications. Highlight text in a dialog box using the Shift and the
arrow keys (or drag the mouse cursor over the desired text), and copy the text to the
clipboard by pressing the Ctrl+Insert keys. Pasted the data into another dialog box
field (or another Win-OS/2 application) by pressing the Shift+Insert  keys.

Text copied to the clipboard from another application can also be pasted to Console
application dialog box fields.  However, the clipboard operation must occur in the
same Win-OS/2 session for inter-application copy and paste functions to work.

Blocked, Dedicated, and Prohibited

The Blocked, Dedicated, and Prohibited options toggle the associated port
attribute on or off for the selected (highlighted) port address and cell.  The state of
the selected cell (attribute on or off) is indicated by a check mark to the left of the
Blocked, Dedicated, or Prohibited menu option. If a check mark appears, the attribute
is set (on), and the appropriate port attribute symbol appears in the cell at the Matrix
window (refer to "Port Attribute Symbols" on page 140 for an explanation of the
symbols).  If a check mark does not appear, the attribute is not set (off) for the cell.

Prohibit Row and Allow Row

The Prohibit Row and Allow Row options toggle the associated port attribute on or
off for the selected (highlighted) port address row (including cells that do not appear
on the Matrix window). When the prohibit attribute is set, the prohibit port attribute
symbol appears in each cell of the selected row at the Matrix window (refer to "Port
Attribute Symbols" on page 140 for an explanation of the symbol).

Prohibit Range

Select the Prohibit Range option from the Edit menu to display the Prohibit Address
Range dialog box (Figure 72).  The dialog box is used to either allow or prohibit
connections to all Director ports or a selected range of Director ports.

Figure 72.  Prohibit Address Range Dialog Box
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Click the Allow button to enable the allow attribute for all Director port addresses or
a specified range of port addresses.

Click the Prohibit button to enable the prohibit attribute for all Director port addresses
or a specified range of port addresses. When the prohibit attribute is set, the prohibit
port attribute symbol appears in each selected cell (all or a specified range) at the
Matrix window (refer to "Port Attribute Symbols" on page 140 for an explanation of
the symbol).

Block Range

Select the Block Range option from the Edit menu to display the Block Address
Range dialog box (Figure 73). The dialog box is used to either block or unblock all
Director ports or a selected range of Director ports.

Figure 73.  Block Address Range Dialog Box

Click the Unblock button to unblock all Director port addresses or a specified range
of port addresses.

Click the Block button to block all Director port addresses or a specified range of port
addresses. When the block attribute is set, the block port attribute symbol appears
in each selected cell (all or a specified range) at the Matrix window (refer to "Port
Attribute Symbols" on page 140 for an explanation of the symbol).

Name and States

Select the Name and States option from the Edit menu to display the Name and
States dialog box (Figure 74).

The dialog box is used to select multiple attributes for the selected port address and
intersection address cell. The dialog box title indicates the selected port address.
Attributes for the selected address and intersection appear in the dialog box.
Complete dialog box fields as follows:

• Name - The port name can be up to 24 alphanumeric characters in length,
and must be unique to a Director (the same name can be used on separate
Directors).  However, it is recommended unique port names be used for all
Directors.  Any format for a name is acceptable, as long as 24 or fewer
characters are used and the name is not preceded by a space.
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Figure 74.  Name and States Dialog Box

If a System Automation for Multiple Virtual Storage (SA/MVS™), System
Automation for Operating System/390 (SA OS/390), or ESCON Manager™
Hardware Configuration Definition (HCD) controls the Director, port address
names should contain only:

— Upper and lower case characters (A through Z)

— Numbers (0 through 9)

— Periods ( . ), hyphens ( - ), and underscores ( _ ).

Port address names should not contain:

— Parenthesis at the start or end of the name

— Leading or embedded blanks

— Asterisks ( * )or commas ( , ).

Any format for a name is acceptable (subject to the listed restrictions), as
long as 24 or fewer characters are used and the name is not preceded by a
space. For additional information, refer to Planning for the Enterprise Systems
Connection Manager (GC23-0423) or System Automation for OS/390,
Planning and Installation (GC28-1549).

Note: ESCON Manager supports ESCON operation only.  SA OS/390 is
required to support FICON operation.
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• Prohibited - This check box displays and allows modification of the Prohibited
attribute for the selected intersection cell. The address adjacent to the check
box indicates the intersection address shown in the dialog box title. The check
box is disabled if the cell cursor is on an invalid cell.

• Blocked  - This check box displays and allows modification of the Blocked
attribute for the selected intersection cell.

• Dedicated to Address - This edit field allows a single address to be dedicated
to the selected port address (only a valid intersection port address can be
entered).  Deleting an address from the field clears the dedicated attribute.
The field is disabled on an active matrix if the selected port address is not
installed.

• Hardware Status - This field displays the hardware status of the selected port
address.  For inactive FCV ports, an offline reason code is appended to the
hardware status. The reason codes are listed in Table 6, and provide additional
information about the inactive status.  If several reason codes affect an FCV
port, the highest priority code appears in the Hardware Status field.

Table 6.  Offline Reason Codes for Inactive FCV Ports

CUP Name

To modify the control unit port  name, select the CUP Name option from the Edit
menu, or double-click the CUP Name area at the Matrix window (gray box below the
port address names). Either option opens the Name for CUP dialog box (Figure 75).

Figure 75.  Name for CUP Dialog Box

FCV Port Card Offline Reason Codes
(High to Low Priority)

FICON-Incompatible MXC Hardware

Port Exceeds FCV Card Limit

Invalid Configuration - Swap

Invalid Configuration - Dedicate

Awaiting Licensed Internal Code (LIC)
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The CUP name can be up to 24 alphanumeric characters in length, and can contain
only upper and lower case characters (A through Z), numbers (0 through 9), periods,
hyphens, and underscores. CUP names cannot contain leading or embedded blanks,
asterisks, or commas.

Editing the CUP name modifies the name for the current configuration matrix (new,
active, or saved).  The CUP name cannot be the same as any previously entered
port address name.

Default CUP Name

To keep CUP names the same for all configurations for a Director, a default CUP
name can be defined.  This name is entered in the Director Definition dialog box
(Figure 39 on page 52), which is displayed by selecting the New Director or Modify
Definition button from the New Configuration Matrix or Open Active Configuration
Matrix options at the File menu. A name entered in the Default CUP Name field is
automatically entered for configurations loaded into the Console for that Director.
This process is usually performed when the New Configuration Matrix option is
chosen for a Director, or if an active configuration is chosen for a Director that is not
configured.

The changed CUP name must be activated or saved to preserve it with the
configuration. To indicate the CUP name is modified (from a blank name), the name
appears in blue on the matrix (below the port address names).  Use of the default
CUP name does not affect CUP names that are not blank, or are defined. To prevent
the automatic completion of blank CUP names for a Director, leave the Default CUP
Name field blank at the Director Definition dialog box.

Names

To enter a port address name, select the Names option from the Edit menu or
double-click the selection in the Name column (adjacent to the port address). Either
option opens the Name for Address dialog box (Figure 76).

Figure 76.  Name for Address Dialog Box

Port address names can be up to 24 alphanumeric characters in length.  The port
address name usually describes the device attached to the associated port. The
Name for Address dialog box contains five buttons:

• OK - Accepts the entered address name and closes the dialog box.

• Cancel  - Closes the dialog box without taking action.
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• Help  - Opens a window to access online help for the dialog box.

• Previous  - Moves to the address name one port address back (up) in
sequence.  If the previous port is named, the name appears in the dialog
box, and appears at the Matrix window in blue letters.  Activating or saving
the matrix changes the name to black letters.

• Next  - Moves to the address name one port address forward (down) in
sequence, and operates like the Previous button.

Enable Operator

Select the Enable Operator option from the Edit menu to edit port authorization
privileges for a configuration matrix. The option is typically associated with creating
a logical partition (LPAR), and can be used only when the Port Authorization
option from the Utility menu is enabled (refer to "Port Authorization" on page 109).

When the Enable Operator option is selected, the Operator Authorization dialog box
appears.  Type the appropriate operator authorization password and click the OK
button. The operator is granted port authorization privileges assigned to the operator
ID associated with the password. A Matrix window with port authorization enabled
is shown in Figure 77.

Figure 77.  Matrix Window with Port Authorization Enabled
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Until the option is selected, the configuration matrix is set to a read-only state. Edit
menu options (Blocked, Dedicated, and Prohibited) are disabled and cannot be
applied, even to ports within the LPAR.  Operators not authorized to configure all
ports in the matrix can only activate an active matrix or save a saved matrix.  The
Activate Configuration Matrix and Save Configuration  Matrix As options (from the
File menu) are not available.  Operators defined for an LPAR typically do not have
authorization to configure all ports and are not allowed to:

• Activate a new matrix

• Activate a saved matrix

• Save an active matrix

• Edit a new matrix

• Copy a saved matrix

• Delete a saved matrix

• Save a saved matrix using a different name.

If an operator changes a configuration matrix and leaves the Console before
activating the matrix, and another operator attempts to activate or save the matrix,
the password supplied with the activate request is evaluated and rejected if it does
not authorize the operator to configure all matrix ports.

The Matrix window appears with a shading scheme that indicates ports for which
the operator is not authorized to modify attributes.  Unauthorized port rows and
columns appear in a dark gray color. The operator can view the state of unauthorized
ports, but cannot change port attributes.  When port authorization is enabled, an
identifier (L304 in the example) appears in the operator ID area (adjacent to the
System Error indicator).

To enable a different port authorization operator ID (i.e. another LPAR), select the
Enable Operator option again and enter the password assigned to that operator ID.
Pending changes for the previous operator ID are discarded (after a warning) before
the new operator ID is accepted.

Command Lists

The command list function allows an operator to compile a series of frequently-used
commands (block, dedicate, prohibit) into a file for batch execution.  The batch file
runs and assigns port connectivity attributes, rather than the operator assigning
attributes on an individual port basis. The list is developed independently of defined
Directors, but is associated with a desired set of Directors during execution. Up to
32 command lists can be saved to the Console fixed disk. Each command list can
provide up to 128 commands.  The 128-command limit can be exceeded by using
embedded (recursive) command lists.

During execution, a Director’s active matrix is opened and commands are applied to
that active matrix. The matrix can be automatically activated after all commands are
applied.  Commands are performed according to port authorization definitions for
each Director, as defined for the operator initiating execution of the command list.
The following configuration commands can be defined in a list:
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• Prohibit or Allow  - Port connections can be prohibited or allowed as port
address pairs or as a port address range.

• Block or Unblock - Ports can be blocked or unblocked by port address or port
address range.

• Dedicate or Undedicate  - Ports can be dedicated or undedicated by port
address pairs.

• Merge - A saved matrix can be merged into the active matrix according to port
authorizations for the operator.

• Port Name  - A port name can be specified.

• Command List - An embedded (recursive) command list can be executed as
part of a current command list.

Command lists can be defined and executed at any time.  However, command list
activation fails if the link between the Console and selected Directors is unavailable.
In addition, all commands are filtered against port authorization levels defined for
the Directors (for the operator executing the command list).

Because command list operations are applied to the active matrix for each selected
Director, an operator must have authorization to change ports for the Directors or
the operations are not applied. If an error occurs (during matrix activation), command
list execution terminates for the current Director, an error appears in the Command
List - Operational Status dialog box (Figure 80 on page 95). and the process
continues to the next selected Director.

Select the Command Lists option from the Edit menu. The Operator Authorization
dialog box appears. Type an operator authorization password (default is LEVEL003 )
and click the OK button.  The Command Lists dialog box appears (Figure 78).

Figure 78.  Command Lists Dialog Box

The dialog box provides the following options:
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• Execute List - When a list item is selected (highlighted) and the Execute List
button is clicked, the Command List - Execute dialog box appears (Figure 79).
The selected command list definition is part of the dialog box title.

Figure 79.  Command List - Execute Dialog Box

Select (highlight) the Director (or multiple Directors using the Ctrl+Shift keys)
for which the command list definition is to be applied. To automatically activate
the matrix after all commands are applied, click (enable) the Activate after
update check box.  When the Continue button is clicked, the command list
definition is applied and the following process occurs:

— The active matrix opens. The Instructions section of the dialog box
updates to reflect this action.  Click the Continue button to proceed.

— Port attributes are updated and activated. The Instructions section of
the dialog box updates to reflect this action.  Click the Continue button
to proceed.

— The command list executes and the Command List - Operational Status
dialog box appears (Figure 80).  Port attribute changes resulting from
application of the command list definition appear at the Active Matrix
window (if the Activate after update check box is enabled), and an entry
indicating command list execution is added to the Console Audit log.
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Figure 80.  Command List - Operational Status Dialog Box

— If a problem occurs during command list execution and the command list
does not complete, the message box shown in Figure 81 appears.

Figure 81.  Command List Incomplete Message Box

Click the OK button to close the message box, then review the error
messages that appear in the Command List - Operational Status dialog
box.  For a list of error messages and their explanations, refer to
"Command List Error Messages" in Appendix A.

— If required, click the Print to file button at the Command List - Operational
Status dialog box to save the status of the command list execution to a
file. The Save As dialog box appears (Figure 82). The dialog box allows
the operator to specify the file name, file type, and location (diskette or
Console fixed disk) under which to save the command list status.

Note: The Print to file button is disabled (grayed out) during command list
execution.
Chapter 3.  Matrix Window Operations      95



Figure 82.  Save As Dialog Box

— At the Command List - Operational Status dialog box, click the Close
button to complete the command list process and return to the Command
Lists dialog box.

Note: The Close button is disabled (grayed out) during command list
execution.

• Close  - Closes the dialog box.

• New List  - When the New List button is clicked, the Command List -
View/Modify dialog box opens (Figure 83).

Figure 83.  Command List - View/Modify Dialog Box
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The dialog box provides the following options:

— OK - After command parameters are entered, click the OK button
to save the new or modified command list.  The dialog box closes
and the command list name appears in the Command Lists dialog
box (Figure 78).

— Cancel  - Cancels the operation and closes the dialog box.

— Add Command  - When the Add Command button is clicked, the
Command List - Edit dialog box appears (Figure 84).

Figure 84.  Command List - Edit Dialog Box

Click the arrow adjacent to the Command list box.  A list of valid port
attributes (for command list creation) appears. Select (click) the attribute
to be added to the command list and complete parameters as required.

Note: Data entry fields change in the Command List - Edit dialog box to
reflect parameter inputs associated with the selected attribute.

Click the OK button to save the command and return to the Command
List - View/Modify dialog box. If a list item was selected at that dialog
box, the new command is inserted after the selected list item.

— Insert Command  - When a list item is selected (highlighted) and the
Insert Command button is clicked, the Command List - Edit dialog
box opens (Figure 84).  Dialog box functions are identical to functions
described for the Add Command button.  However, the new command
is inserted before the selected list item.
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— Modify Command  - When a list item is selected (highlighted) and
the Modify Command button is clicked, the Command List - Edit dialog
box opens (Figure 84).  Dialog box functions are identical to functions
described for the Add Command button.

— Delete Command  - When a list item is selected (highlighted) and
the Delete Command button is clicked, the following dialog box
appears (Figure 85).

Figure 85.  Delete Command Dialog Box

Click the Delete button to delete the selected command and return to the
Command List - View/Modify dialog box.

— Help  - Opens a window to access online help for the dialog box.

• Modify List  - When a list item is selected (highlighted) and the Modify
List button is clicked, the Command List - View/Modify dialog box opens
(Figure 83).  Dialog box functions are identical to functions described for
the New List button.

• Delete List  - When a list item is selected (highlighted) and the Delete List
button is clicked, the following dialog box appears (Figure 86).

Figure 86.  Delete Command List Dialog Box
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Click the Delete button to delete the selected command list definition from the
Console fixed disk and return to the Command Lists dialog box.

• Copy List  - When a list item is selected (highlighted) and the Copy List
button is clicked, the Command List - Copy dialog box appears (Figure 87).

Figure 87.  Command List - Copy Dialog Box

Enter a file name in the Copy To field. Click the OK button to copy (duplicate)
the selected command list, create a new command list with the specified
name (and identical commands), and return to the Command Lists dialog box.

• Help  - Opens a window to access online help for the dialog box.

• List Info  - When a list item is selected (highlighted) and the List Info button
is clicked, the Command List - Information dialog box appears (Figure 88).

Figure 88.  Command List - Information Dialog Box

The dialog box provides a description of the selected command list, with the
date and time the command list was created. Click the Close button to close
the box and return to the Command Lists dialog box.

Matrix View Menu

The Matrix window View menu (Figure 89) provides options to modify the visual
display of the Matrix window. View menu options are:

• Swap Axis  - Orients the matrix so that port addresses along the left side of
the matrix appear at the top of the matrix.

• Matrix Map - Allows a user to display and select a range of port addresses for
viewing.  The option is not available for the 9033-004 Director.
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• Enter Position  - Allows a user to specify a port intersection cell (pair of
port addresses).  The cell cursor moves to the cell location specified by the
addresses entered.

• Graphic Display  - Toggles between graphic display mode and nongraphic
display mode.

• Display Options - Allows a user to set preference options for viewing the Matrix
window.

Figure 89.  View Menu (Matrix Window)

Swap Axis

Select the Swap Axis option from the View menu to change the matrix orientation
so that:

• Logical port addresses displayed along the left side of the matrix now appear
at the top of the matrix.

• Logical port addresses displayed along the top of the matrix now appear at left
side of the matrix.

The swap axis function is also performed by double-clicking any port address above
the matrix area.  This option is useful to select port addresses and view or modify
port address names that formerly appeared at the top of the matrix (with the port
address name hidden).
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Matrix Map

The Matrix Map option allows an operator to quickly display and select a range of
port addresses for viewing.  Select the Matrix Map option from the View menu or
click the M button at the lower right corner of the matrix. The Matrix Map dialog box
appears (Figure 90).  The dialog box contains 64 buttons, each representing an
address block for the Director matrix. The address block that appears at the Matrix
window is indicated by a thick border on the corresponding button (2, A on Figure 90).

Note: This menu option is not available for a 9033-004 Director. The menu option
and the M button at the lower right corner of the matrix are grayed out.

When a button is selected, the portion of the matrix starting with addresses in the
address block range appears. The size of the displayed matrix depends on display
options chosen and the size of the monitor.  The default is a 32-by-32 port matrix.

Figure 90.  Matrix Map Dialog Box (9032-005 Director)

Only the first hexadecimal digit of the range (button) to be selected appears on the
axis of the Matrix Map dialog box.  Selection of a Matrix Map button displays the
matrix starting with the row and column of the button selected. For example, when
displaying 16 ports (vertically and horizontally), select row 6 and column 2 of the
Matrix Map of a 9032-005 Director to display a matrix with a row range of 60 through
6F (left side) and column range 20 through 2F (top).

Each button on the Matrix Map for a 9032-003 Director represents a port address
block of the matrix beginning with a 16-port address boundary. Each button on the
Matrix Map for a 9032-005 Director represents a port address block of the matrix
beginning with a 32-port address boundary.

Enter Position

Select the Enter Position option from the View menu to open the Enter Address
Position dialog box (Figure 91).

20
60

A0
20
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Figure 91.  Enter Address Position Dialog Box

Enter row and column port addresses and click the OK button, and the cell cursor
moves to the cell location specified by the two addresses. If necessary, the matrix
scrolls to display the new location (scrolling conforms to matrix map settings).  For
example, if [B7, 95] is entered, the cell cursor moves to that cell intersection and the
upper left cell intersection of the displayed matrix is [B0, 90].

Note: For a 9033-004 Director, the cell cursor moves to the specified cell location,
but the matrix does not change display coordinates.

Graphic Display

The Graphic Display option is a toggle that enables or disables graphic display mode
for the Matrix window.  In graphic display mode, all attributes (prohibited, allowed,
dedicated, and blocked) appear graphically on the configuration matrix. Figure 92
displays the matrix in graphic display mode.

Figure 92.   Graphic Display Mode
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Nongraphic display mode provides continuity for users of the 9033-001 Console,
9032-002 Console, and host applications (SA OS/390).  In nongraphic display
mode, a separate blocked column (B) appears, and the matrix section displays only
prohibited connections in matrix cells (P). The lined graphic display of the matrix appears
the same in either mode, but display of attributes is different. Figure 93 displays the
matrix in nongraphic display mode.

Note: In nongraphic display mode, the Matrix window display reacts in all ways as
a 9032-002 or a 9033-001 Director Console.

Figure 93.  Nongraphic Display Mode

Display Options

Select the Display Options selection from the View menu to open the Display
Options dialog box (Figure 94).  The dialog box provides preference options for viewing
the Matrix window.  Options can be set separately for each Matrix window. The dialog
box provides the following options:

• Number of addresses across  - This entry is the number of port addresses
that appear horizontally across the matrix. When sizing a Matrix window, the
number of horizontal addresses stays consistent, and the size of the cells and
matrix features change.  The default setting is 32 addresses.  The maximum
setting is 124 addresses.

• Percentage of names displayed - This entry is the percentage of the Name
field that appears at the left of the matrix.  One hundred percent displays all
24 characters of a name at the widest possible setting (usually excessive for
most names).
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Zero percent displays no names at all, saving screen space to allow for larger
matrix cells.  The default is 65 percent, which displays most
24-character names.

Figure 94.  Display Options Dialog Box

• Graphic display of matrix  - This check box performs the same function as
the Graphic Display menu option at the View menu.  With graphic display
on (box checked), the matrix appears in graphic display mode, providing the
greatest amount of visual feedback about the configuration of the Director.
With graphic display mode off, attributes appear similar to the 9032-002 and
9033-001 Console display.

• Highlight changes - If this box is checked, changes to attributes made since
the configuration was last read appear in a brighter color or intensity. Cleared
attributes appear in a more subdued color or intensity.  Changed text or port
address numbers appear in blue. Highlighted changes revert to normal after
the changes are saved or activated. The Highlight option is toggled from the
matrix display by the Ctrl+H  keys.

• Save settings as default - Parameters set at the Display Options dialog box are
saved to a Console initialization file as defaults for Console startup.  If this box is
checked, display settings are saved when the OK button is selected. The options
become the defaults the next time the Console application is opened.

Matrix Utility Menu

The Matrix window Utility menu (Figure 95) provides tools required to monitor and
report on Console and Director-level functions.  Some options are valid only for
an attached Director (active matrix).  Unavailable menu options are grayed out in
Saved Matrix or New Matrix windows. Utility menu options are:

• Director Operational Status  - Displays the status of the selected Director.

• Node Descriptor  - Displays information about the hardware and attached
device for a selected Director port.

• Time/Date - Allows a user to specify the date and time for an attached Director.
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• Active = Saved - Sets Active = Saved as the default condition for subsequent
activate configuration matrix commands.

• Remote Offline Control - Toggles an attribute that determines if an attached
host system can set the Director offline.

• LIC Versions - Identical to the same option at the Startup window Utility menu.
Refer to "LIC Versions" on page 58 for information.

• Passwords - Identical to the same option at the Startup window Utility menu.
Refer to "Passwords" on page 60 for information.

• Port Authorization - Allows an administrator to selectively authorize or deny
port access for operators.

• Console Audit Log - Identical to the same option at the Startup window Utility
menu.  Refer to "Console Audit Log" on page 63 for information.

• Console Error Log - Identical to the same option at the Startup window Utility
menu.  Refer to "Console Error Log" on page 64 for information.

• IPL Director  - Allows an operator to IPL a selected Director.

• Set Director Offline - Allows an operator to set the Director offline. The option
is available only if the Remote Offline Control option is enabled.

• Clear System Error  - Extinguishes the System Error indicator at the Matrix
window and associated Director operator panel.

• Reset Installation Defaults  - Allows a user to reset non-volatile information
to installation default values.

Figure 95.  Utility Menu (Matrix Window)
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Director Operational Status

Select the Director Operational Status option from the Utility menu or double-click
the Director Status Indicator (on the status line at the bottom of the Matrix window.
The Director Operational Status dialog box (Figure 96) appears.

Figure 96.  Director Operational Status Dialog Box

A Status Code and its meaning are displayed in the dialog box.  The first digit of
the Status Code is the operational condition of the Director, indicating the severity
of the failure (if any).  The remaining digits indicate a field-replaceable unit (FRU)
codes for up to three failed hardware components.

For information about status codes, refer to the Director-specific maintenance
publication listed below:

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

Node Descriptor

Select the Node Descriptor option from the Utility menu to open the Node Descriptor
dialog box (Figure 97).  The dialog box displays information about Director port
hardware and the device attached to the highlighted port. The information describes
the node descriptor (similar to vital product data) for the attached device, and is
provided by the attached device.

Adjacent port address information is viewed by using the Previous or Next buttons.
Fields in the dialog box are described as follows:

• Validity - The node descriptor reported by the device can be:

— Valid - A node descriptor (flagged as valid), was received from the node.
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— Not Current - A response was not received from the node for a descriptor.
The last valid descriptor is used, but is flagged as Not Current.

— Invalid  - A node descriptor (flagged as invalid), was received from the
node.

Figure 97.  Node Descriptor Dialog Box

• Node - The node is either a device type or channel subsystem type. The Class
field depends on the node type.

• Class  - If the node is a device type, the class describes the general device,
such as direct access storage device (DASD), printer, or magnetic tape drive.
If the node is a channel subsystem type, the class (if specified), is either a
channel path or integrated channel-to-channel adapter (CTCA).

• Type & Model - A six-character type number is followed by a three-character
model number.  These numbers correspond to the type and model numbers
indicated on the machine serial number plate.

• Manufacturer & Plant - A three-character manufacturer code is followed by a
two-character plant of manufacture code, identifying the manufacturer of the
device.

• Sequence Number - A 12-character code (usually preceded by the plant code)
that corresponds to the device serial number on the machine serial number
plate.

• Tag - The tag encodes the interface ID of the channel port or control unit port
supplying the node descriptor information.

• Port number & hardware  - This line displays the physical port number
mapped to the selected port address, followed by a port type indicator
(LED for an LED  port, Laser  for an XDF Laser or FCV port).
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Time/Date

Select the Time/Date option from the Utility menu to open the Set Director Time
and Date dialog box (Figure 98). The option is available only from an Active Matrix
window.

Figure 98.  Set Director Time and Date Dialog Box

The dialog box provides the following options:

• New Time - This field allows input of the current time. Click the OK button to
set the Director time to the entered time.

• New Date - This field allows input of the current date. Click the OK button to
set the Director date to the entered date.

Note: The New Date field accepts only a 2-digit year entry.  However, the
Director Console application correctly interprets the entry 00 as the
year 2000, 01 as the year 2001, etc.

• Read From Console  - When this button is clicked, the New Time and New
Date fields are updated with the Console PC time and date (set through the
operating system). Click the Console Sync button to set the Director time and
date to the Console time and date.

• Console Sync  - When this button is clicked, the Operator Authorization
dialog box appears.  Type an operator authorization password (default is
LEVEL003 ) and click the OK button. The Director time and date are
synchronized with the Console time and date.

• OK - After a time and date are entered, click the OK button. The Operator
Authorization dialog box appears.  Type an operator authorization password
(default is LEVEL003 ) and click the OK button. The Director time and date are
set to the entries typed in he New Time and New Date fields.

• Cancel  - Cancels the operation and closes the dialog box.

• Help  - Opens a window to access online help for the dialog box.
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Active = Saved

The Active = Saved option from the Utility menu sets the default condition (enabled
or disabled) for subsequent activate configuration matrix commands. The option is
available only from an Active Matrix window.

When the option is selected, the Operator Authorization dialog box appears.  Type
an operator authorization password (default is LEVEL003 ) and click the OK button.
When the option is enabled, a check mark appears adjacent to the menu item.
The default condition can also be set at the Activate Configuration Matrix dialog
box (Figure 66 on page 80).  When the option is enabled, an X appears in the
Active = Saved field at the dialog box.

If Active = Saved is enabled and an activate command is transmitted, the active
configuration for the Director is copied to the IPL configuration matrix file (saved to
the Director’s volatile memory), and is used the next time the Director is lPLed.

Remote Offline Control

The Remote Offline Control option from the Utility menu controls whether or not an
attached host system can set the Director offline. The option is available only from
an Active Matrix window.

When the option is selected, the Operator Authorization dialog box appears.  Type
an operator authorization password (default is LEVEL003 ) and click the OK button.
When the option is enabled, a check mark appears adjacent to the menu item, and
the attached host system is permitted to set the Director offline. When the option is
disabled, the check mark disappears and the host system command to set the
Director offline is rejected.

LIC Versions

This option is identical to the same option at the Startup window Utility menu. Refer
to "LIC Versions" on page 58 for information.

Passwords

This option is identical to the same option at the Startup window Utility menu. Refer
to "Passwords" on page 60 for information.

Port Authorization

Select the Port Authorization option from the Utility menu to open the Port
Authorization dialog box (Figure 99).  Port authorization changes require an
administrative authorization password (default is LEVEL001 ).

Attention!

The default is Active = Saved enabled.  It is recommended to leave the
option enabled.
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Figure 99.  Port Authorization Dialog Box

The port authorization function allows an administrator to create port-level
configuration access control unique to defined operators or operator groups,
which allows operators to access only authorized ports and restricts unauthorized
operators from changing the port connectivity configuration of any device or set of
devices under control of the Director. The dialog box provides the following options:

• OK - After port authorization changes are made, click the OK button to save
the changes and return to the Matrix window.

• Cancel  - Cancels the operation and closes the dialog box.

• Range - When this button is clicked, the Authorize Range dialog box appears
(Figure 100).  Use the dialog box functions to:

— Authorize or prohibit operator access to all logical port addresses

— Authorize or prohibit operator access to a specified range of logical
port addresses

— Authorize or prohibit operator access to all operator IDs

— Authorize or prohibit operator access to a specified range of
operator IDs.
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Figure 100.  Authorize Range Dialog Box

• Copy  - Select a intersection cell of a logical port address and operator ID to
copy the cell contents (enabled or disabled).

• Paste - Select an intersection cell of a logical port address and operator ID to
paste previously-copied cell contents (enabled or disabled).

• Help  - Opens a window to access online help for the dialog box.

After port authorizations are changed, the Matrix window is in a read-only state and
an operator must select the Enable Operator option from the Edit menu to enable
the changes.  For more information about port authorization refer to "Defining Port
Authorizations" on page 180.  For more information about the Enable Operator
option refer to "Enable Operator" on page 91.

Console Audit Log

This option is identical to the same option at the Startup window Utility menu. Refer
to "Console Audit Log" on page 63 for information.

Console Error Log

This option is identical to the same option at the Startup window Utility menu. Refer
to "Console Error Log" on page 64 for information.

IPL Director

When the IPL Director option is selected from the Utility menu, the dialog box on the
following page appears (Figure 101).

Click the OK button.  The Operator Authorization dialog box appears.  Type an
operator authorization password (default is LEVEL003 ) and click the OK button. An
IPL command is Transmitted to the Director to reinitialize Director Licensed Internal
Code (LIC) and cause the CTP card to initiate an IPL.  The latest LIC version is
loaded to the online CTP card, and that card and the Token Ring Controller (TKRG)
Adapter card are reset.  The active matrix remains online, and no Director
functionality is lost during the IPL.
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Figure 101.  Reset CTP Card Dialog Box

Note: The IPL Director menu option is available only from an Active Matrix window.

Set Director Offline

Perform the following prior to setting the Director offline:

• If the Director is not supported by SA OS/390, ensure the system operator
varies all Director-attached channels and control units offline.

• If the Director is supported by SA OS/390, ensure the system operator
applies the Remove Switch  command to vary Director-attached channels
and subchannels offline.

When the Set Director Offline option is selected from the Utility menu, the following
dialog box appears (Figure 102).

Figure 102.  Offline State Dialog Box

Click the OK button.  The Operator Authorization dialog box appears.  Type an
operator authorization password (default is LEVEL003 ) and click the OK button.

An offline command is transmitted to all Director ports. After the Director is set offline,
an IPL, Initial Machine Load (IML) or power cycle is required to clear the offline state.
Set the Director offline whenever maintenance is to be performed on a 9033-004
Director or a nonredundant 9032-003 or 9032-005 Director FRU.
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Note: The Set Director Offline menu option is available only if the Remote Offline
Control option is enabled.

Clear System Error

When the Clear System Error option is selected from the Utility menu, the following
dialog box appears (Figure 103).

Figure 103.  Extinguish System Error Light Dialog Box

Click the OK button.  The Maintenance Authorization dialog box appears.  Type a
maintenance authorization password (default is LEVEL002 ) and click the OK button.
The System Error indicator is extinguished at the status line of the Matrix window
and at the Director operator panel. Active events at the operator panel Status display
are set to History .

Note: The Clear System Error menu option is disabled (grayed out) if there is no
link established between the Director and Console.

Reset Installation Defaults

This option allows a user to reset non-volatile information to installation default
values. Upon receiving the Reset Installation Defaults command, the Director clears
host data, resets the key counter to zero, and resets the IPL file to the default state.
These values are not reset until a Director IPL, IML, or power cycle occurs.  The
Reset Installation Defaults menu option is disabled (grayed out) if:

• The Director-Console link is inactive or busy

• The Matrix window is locked

• The installed LIC version does not support the option (below Version 4.3).

If the Director is online and the Reset Installation Defaults option is selected from
the Utility menu, the message box on the following page appears (Figure 104).

Click the OK button, set the Director offline, and retry the operation. If the Director
contains only one CTP card, perform the following prior to setting the Director offline:
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• If the Director is not supported by SA OS/390, ensure the system operator
varies all Director-attached channels and control units offline.

• If the Director is supported by SA OS/390, ensure the system operator
applies the Remove Switch  command to vary Director-attached channels
and subchannels offline.

Figure 104.  Set Director Offline Message Box

If the Director is offline and the Reset Installation Defaults option is selected from
the Utility menu, the following dialog box appears (Figure 105).

Figure 105.  Reset Installation Defaults Dialog Box

Click the OK button.  The Maintenance Authorization dialog box appears.  Type
a maintenance authorization password (default is LEVEL002 ) and click the OK
button.  The dialog box closes, installation default values are reset, and an entry
corresponding to the action is added to the Director Audit log.

Matrix Maintenance Menu

The Matrix window Maintenance menu (Figure 106) provides access to diagnostic
and maintenance options for an attached Director. Some options are valid only for
an attached Director (active matrix).  Unavailable menu options are grayed out in
Saved Matrix or New Matrix windows. Maintenance menu options are:
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• Director LIN Log  - Displays the Link Incident (LIN) log for the selected
Director.

• Director Audit Log  - Displays the Audit log for the selected Director.

• Director Event Log  - Displays the Event log for the selected Director.

• Hardware Configuration  - Displays a log window containing information
about hardware installed on the Director.

• Hardware Audit Log - Displays a log window that summarizes the hardware
change history for the Director.

• Node Descriptor List  - Displays a log window that lists all Director port
addresses and describes the associated nodes.

• Port Maintenance  - Opens the Port Maintenance window.

• Advanced  - Provides access to the Terminal and LMA Versions options.
The Terminal option opens a scrolling window that lists terminal mode
commands.  The LMA Versions option allows a user to add, modify, or
delete a Loader/Monitor Area (LMA) version.

• Collect Maintenance Information  - Allows the transfer of maintenance
information to the Console fixed disk and subsequently to a diskette for use by
service personnel.

• Console Link Statistics  - Displays Token Ring local area network (LAN)
status and error counts to assist in fault isolation of link problems.

Figure 106.  Maintenance Menu (Matrix Window)
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Director Log Operation

The Director LIN log stores up to 128 entries, the Director Audit log stores up to 1,000
entries, and the Director Event log stores up to 256 entries.  After the maximum
number of entries has been stored, new entries overwrite the oldest entries.
Information in the Director LIN and Director Event logs is typically useful only to
qualified service technicians who are fault isolating a Director problem.

When a log window is first opened, the entire contents of the log file are available
for display (scrolling may be required). New log events that occur while the window
is open are not displayed until the Refresh option is selected from the File menu.

Note: When a log window is selected, the menu bar changes to provide commands
unique to the log window.  The logs can be refreshed (re-read), saved to a
file, or printed.  The log text can also be displayed in different fonts and
character sizes.

Menu options specific to log windows are available from the File and Font menus.
Options available from the Window and Help menus are identical to those options
available from the Startup window. Refer to "Window Menu" on page 67 and "Help
Menu" on page 69 for information.

Director Log Window File Menu

File menu options (Figure 107) available from the Director LIN, Director Audit, and
Director Event logs are:

• New Configuration Matrix - This option is identical to the same option at the
Startup window File menu.  Refer to "New Configuration Matrix" on page 51
for information.

• Open Saved Configuration Matrix - This option is identical to the same option
at the Startup window File menu. Refer to "Open Saved Configuration Matrix"
on page 55 for information.

• Open Active Configuration Matrix - This option is identical to the same option
at the Startup window File menu. Refer to "Open Active Configuration Matrix"
on page 57 for information.

• Director Matrix  - Select this option to exit the log window and return to the
associated Director matrix.

• Refresh  - Select this option to write the latest information to the log window
and refresh the display.

• Clear - Select this option to clear the log file. After prompting for verification,
the option clears the screen and log file. This function is available for Director
logs only (not Console logs).  However, an entry is placed in the Console
Audit log when a Director log is cleared.

• Save to File - Select this option to open the Save As dialog box and save log
data to a user-specified file on diskette or the Console fixed disk.

• Print - Select this option to print the log window contents to a file or printer.
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• Print Setup - Select this option to open the Print Setup dialog box and assign
print and printer parameters. Printer selection must be complete (from the Print
Setup dialog box) before using the Print option to print a log file.

• Close Window - Select this option to close the log window and return to
the Matrix window.

• Exit - Select this option to close all windows and exit the Director Console
application.

Figure 107.  File Menu (Director LIN, Audit, and Event Logs)

Director Log Window Font Menu

The Font  menu available from the Director LIN, Director Audit, and Director Event
logs provides only a Select option.  Selecting this option opens the Font dialog
box, where the font, font style, and font size for the log window text are changed
and saved.

Director LIN Log

The Director LIN log (Figure 108) contains link incident records reported to the
Console by the Director.  The Director LIN log stores up to 128 entries.
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Figure 108.  Director LIN Log

The first line of each three-line log entry contains the following columns of
information:

• Port  - The number of the port reporting the incident

• Addr  - The logical address of the port reporting the incident

• Incident (Qualifier)  - Incident information reported by the port (used by
engineering personnel)

• Date - The date the incident was logged

• Time  - The time the incident was logged.

Note: Entries in the LIN log Time field are set to Director time. If a link is not
established between the Console and Director (such as at power-on),
the Time field is blank.

The Node entry identifies hardware attached to the port. The hardware is described
in the same format as in the Node Descriptor List.  The Data entry lists raw sense
byte information.  All 32 sense bytes are displayed.
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Director LIN log information is typically useful only to qualified service technicians
that are fault isolating a fiber optic link problem. For additional information, refer to
Appendix A of the Director-specific maintenance publication listed below:

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

Director Audit Log

The Director Audit log (Figure 109) tracks and records Console operator activities
specific to a Director.  The Director Audit log stores up to 1,000 entries.  The
following are examples of operator activities that are logged:

• Changing the active matrix or the Active = Saved state

• Changing the Remote Offline Control state

• Changing the Director date and time

• Performing a remote IPL of a Director

• Transmitting a new LIC version to a Director.

Figure 109.  Director Audit Log
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The Director Audit log contains the following columns of information:

• ID - The password identification of the Console operator performing the
action, or the image identification and port address over which the action
was requested by a host application (such as SA/MVS, SA OS/390, or
ESCON Manager).

• Event  - A brief description of the action performed.

• Parameters  - Any identification parameters (such as port address or matrix
name) associated with the action.

• Date - The date the action was logged.

• Time  - The time the action was logged.

Note: Entries in the Director Audit log Time field are set to Director
time.  If a link is not established between the Console and Director
(such as at power-on), the Time field is blank.

Director Event Log

The Director Event log (Figure 110) contains Director hardware and software
incidents reported to the Console by the Director. The log also records changes to
the state of the Token Ring link between the Director and Console.  The Director
Event log stores up to 256 entries.

Figure 110.  Director Event Log
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Note: A maintenance authorization password (default is LEVEL002 ) is required to
open the Director Event log.

The first line of each two-line log entry contains the following columns of
information:

• Event - A brief message that describes the event and reflects the contents
of the event code.

• OP Panel - Information that mirrors the contents of the corresponding
Director’s operator panel status display.

• Date - The date the incident was logged.

• Time - The time the incident was logged. The Time field is blank for Console
link events.

The second line of the log entry contains lists raw sense byte information.  All 32
sense bytes are displayed.

Director Event log information is typically useful only to qualified service
technicians that are fault isolating a Director problem.  For additional information,
refer to Appendix A of the Director-specific maintenance publication listed below:

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

Hardware Configuration

Selecting the Hardware Configuration option displays a Director-specific log window
containing information about hardware installed in the Director. The option is
available only from an Active Matrix or Port Maintenance window.  The Hardware
Configuration window contains the following columns of information:

• FRU Name - An abbreviation or title that defines the installed FRU.

• Position - The number of the Director’s chassis slot (starting at 00) where
the FRU is installed.

• Status - The FRU operational status.

• Part Number  - The FRU part number.

• Serial Number  - The FRU serial number.

• Power-On Hours - The total number of hours the FRU has been powered on.
This value is not Director-specific.  For example, if a FRU is installed in a
Director, then removed and used in another Director, the value reflects the total
power-on hours in both Directors.

• FRU Data - The supplementary original equipment manufacturer (OEM)
part number.
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Figure 111 shows the Hardware Configuration window for the 9032-003 ESCON
Director.

Figure 111.  Hardware Configuration Window (9032-003 Director)

Figure 112 shows the Hardware Configuration window for the 9033-004 ESCON
Director.

Figure 112.  Hardware Configuration Window (9033-004 Director)
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Figure 113 shows the Hardware Configuration window for the 9032-005 Director.

Figure 113.  Hardware Configuration Window (9032-005 Director)

Hardware Audit Log

The Hardware Audit log (Figure 114) provides a hardware configuration change
history. The Director Console reevaluates hardware configuration information when
a FRU is removed or replaced. Changes that occur while the link between the Director
and Console is unavailable are detected only when the link is reestablished.

The Director cannot determine the difference between removal or failure of a fan
assembly, or removal or failure of the operator panel.  Changes made to a fan
assembly do not appear in the Hardware Audit log, and changes made to the operator
panel appear in the log only after power-on or IML.

The Hardware Audit log contains the following columns of information:

• FRU - An abbreviation or title that defines the changed FRU.

• Position  - The number of the Director’s chassis slot (starting at 00) where
the FRU is removed or replaced.

• Action  - Indicates if the FRU is added or removed.

• Part Number  - The FRU part number.

• Serial Number  - The FRU serial number.
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• Date - The date the change is detected.

• Time - The time the change is detected.

Figure 114.  Hardware Audit Log

Node Descriptor List

Selecting the Node Descriptor List  option displays a Director-specific log window
containing information about devices attached to Director ports. The option is available
only from an Active Matrix window.

The log lists all Director port addresses and associated node descriptions (refer to
"Node Descriptor" on page 106 for an explanation). Log information is provided to
the Director by the attached devices.

The Node Descriptor List  contains the following columns of information:

• Addr  - The assigned logical port address for the node.

• Validity  - The node descriptor reported by the attached device has one
of the following values:

— Valid  - A node descriptor flagged as Valid is received from
the node.

— Not Current  - A response is not received from the node for
a descriptor. The last valid descriptor is used, but flagged as
Not Current.
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— Invalid  - A flag is received with the node descriptor that identifies
the information received as Invalid.

• Node  - The node is either a device type or channel subsystem type.
The Class field is dependent on the node type.

• Class  - If the node is a device type, the class describes the general device,
such as direct access storage device (DASD), printer, or magnetic tape.

If the node is a channel subsystem type, the class (if specified) is either a
channel path or an integrated channel-to-channel adapter (CTCA).

• Type - Model  - A six-character type number is followed by a three-character
model number.  These numbers correspond to the type and model numbers
indicated on the machine serial number plate.

• Manufacturer - Plant  - A three-character manufacturer code is followed
by a two-character plant of manufacture code.  These numbers identify the
manufacturer of the device.

• Sequence Number  - This 12-character number (usually preceded by
the two-character plant code above) corresponds to the device serial
number on the machine serial number plate.

• Tag - The tag encodes the interface identification of the port originating
the node descriptor information.

Figure 115 shows the Node Descriptor List for the 9032-003 ESCON Director.

Figure 115.  Node Descriptor List (9032-003 Director)

Figure 116 shows the Node Descriptor List for the 9033-004 ESCON Director.
Chapter 3. Matrix Window Operations 125



Figure 116.  Node Descriptor List (9033-004 Director)

Figure 117 shows the Node Descriptor List for the 9032-005 Director.

Figure 117.  Node Descriptor List (9032-005 Director)
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Port Maintenance

Selecting the Port Maintenance option displays a Director-specific window that
displays a visual representation of the hardware configuration and port address
mapping of the selected Director.

Components of the Port Maintenance window indicate the status of represented
FRUs.  Indicated states for each FRU are:

• FRU is shaded black  - The FRU is not installed.

• FRU contains all diagonal lines  - The FRU is a redundant (backup)
component (9032-003 and 9032-005 Directors only).

• FRU is shaded yellow  - The FRU requires service.

Figure 118 shows the Port Maintenance window for the 9032-003 ESCON Director.

Figure 118.  Port Maintenance Window (9032-003 Director)

Figure 119 shows the Port Maintenance window for the 9033-004 ESCON Director.
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Figure 119.  Port Maintenance Window (9033-004 Director)

Figure 120 shows the Port Maintenance window for the 9032-005 Director.

Figure 120.  Port Maintenance Window (9032-005 Director)
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The type of port card (Fibre Channel Converter (FCV), light-emitting diode (LED),
or Extended Distance Feature (XDF) Laser) is indicated for each port card installed.
Type indicators are:

• FCV Port Card  - The port card display shows the top logical port address
as normal text, with the remaining seven port addresses grayed out
(indicating the ports are unaddressable).  FCV port cards are installed
only in the 9032-005 Director.

• XDF Laser Port Card  - The port card display has a black triangle in a
lower corner (lower right corner for the 9033-004 Director, lower left corner
for the 9032-003 and 9032-005 Directors).

• LED Port card  - The port card display shows no distinguishing
characteristics.

The status of logical port addresses appears for each Director port. Indicated states
for each port address are:

• Port address is underlined in blue  - The logical port address is
blocked

• Port address is crossed out with a backslash ( \ )  - The logical port
address requires service.

• Port address is green with a green asterisk - The logical port address
was swapped (physical port mapping was modified). Refer to "Swap Ports" on
page 129 for additional information.

When accessed from the Port Maintenance window, the Maintenance menu also
contains Swap Ports and Port Diagnostics options. Both options require a maintenance
authorization password for access.

Swap Ports

Select the Swap Ports option from the Port Maintenance window’s Maintenance
menu. The Maintenance Authorization dialog box appears.  Type a maintenance
authorization password (default is LEVEL002 ) and click the OK button. The Port
Swapping dialog box appears (Figure 121).

Options at the dialog box allow mapping of physical Director ports to be modified to
match logical addresses used on an attached host and on the Matrix window.  At
the Port Maintenance window, an asterisk appears adjacent to a logical port address
that is swapped.  Both the port address and asterisk are shaded green.

Note: An LED port can only be swapped with another LED port, an XDF Laser
port can only be swapped with another XDF Laser port, and an FCV port
can only be swapped with another FCV port. In addition, unaddressable FCV
ports cannot be swapped.

Port swapping is typically performed by qualified service technicians that are
removing and replacing a port card.  For additional information, refer to Chapter
3 of the Director-specific maintenance publication listed on the following page:
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• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

Figure 121.  Port Swapping Dialog Box

Port Diagnostics

When the Port Diagnostics option is selected from the Maintenance menu, a second
menu appears with the ESCON and FICON options.

Note: The ESCON option performs diagnostics only for LED or XDF Laser ports,
and does not perform diagnostics for FCV ports. The FICON option performs
diagnostics only for FCV ports, and does not perform diagnostics for LED or
XDF Laser ports.

ESCON

Select the Port Diagnostics and ESCON options from the Port Maintenance
window’s Maintenance menu. The Maintenance Authorization dialog box appears.
Type a maintenance authorization password (default is LEVEL002 ) and click the
OK button. The Online ESCON Port Diagnostics dialog box appears (Figure 122).

Options at the dialog box allow personnel to perform online ESCON port diagnostic
tests from the Director Console.  Internal loopback, external loopback, and matrix
diagnostic tests are available.  Test results appear in the dialog box.
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Figure 122.  Online ESCON Port Diagnostics Dialog Box

Note: The ESCON option performs diagnostics only for LED or XDF Laser ports.
If an attempt is made to perform FCV port diagnostics using the ESCON
option, the following message box appears (Figure 123).

Figure 123.  ESCON Diagnostics Message Box

Port diagnostics are typically performed by qualified service technicians who are fault
isolating a Director problem.  For additional information, refer to Chapter 2 of the
Director-specific maintenance publication listed on the following page:
Chapter 3. Matrix Window Operations 131



• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

FICON

Select the Port Diagnostics and FICON options from the Port Maintenance window’s
Maintenance menu. The Maintenance Authorization dialog box appears.  Type a
maintenance authorization password (default is LEVEL002 ) and click the OK button.
The Online FICON Port Diagnostics dialog box appears (Figure 124).

Figure 124.  Online FICON Port Diagnostics Dialog Box

Options at the dialog box allow personnel to perform online FCV port diagnostic tests
from the Director Console.  Test results appear in the dialog box.

Note: The FICON option performs diagnostics only for addressable FCV ports.
If an attempt is made to perform LED, XDF Laser, or unaddressable FCV
port diagnostics using the FICON option, the following message box
appears (Figure 125).

Port diagnostics are typically performed by qualified service technicians who are
fault isolating a Director problem.  For additional information, refer to Chapter 2
of Maintenance Information for the 9032 Model 5 Director (SY28-1158).
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Figure 125.  FICON Diagnostics Message Box

Advanced

When the Advanced option is selected from the Maintenance menu, a second menu
appears with the Terminal and LMA Versions options.

Terminal

Select the Advanced and Terminal options from the Maintenance menu. The
Maintenance Authorization dialog box appears.  Type a maintenance authorization
password (default is LEVEL002 ) and click the OK button. The Terminal window
appears (Figure 126).  The option is available only from an Active Matrix window.

Figure 126.  Terminal Window

The scrolling window part of the Terminal window displays the results of instructions
entered at the command line. Previously entered commands are recalled and displayed
by using the up and down arrow keys, clicking the arrow button at the right of the field, or
pressing the F4 key.

Scrolling
Window

Command
Line
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Commands entered at the Terminal window are transmitted to the selected Director
without interpretation by the Console. Corresponding results are transmitted directly
to the Console for display.

Unlike other log windows, the Terminal window File menu provides a Capture option.
When the option is selected, the Enter Filename dialog box appears (Figure 127). At the
dialogbox,entera filenameandpathunderwhich tostoreallsubsequentTerminalwindow
commands and responses for the selected Director (as long as the window remains
open).  Capture mode (enabled) is indicated by a check mark adjacent to the menu
option after the file name is specified.  Capture mode is disabled by selecting the
Capture option again.

Figure 127.  Enter Filename Dialog Box

For additional information about the Terminal window and associated commands,
refer to Appendix E of the Director-specific maintenance publication listed below:

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

LMA Versions

The LMA Versions dialog box (Figure 128) displays a list of LMA versions stored
on the Console fixed disk. Up to three LMA versions can be maintained. From this
dialog box, new LMA versions are installed on the fixed disk, existing version
descriptions are edited, and unused versions are deleted.
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Figure 128.  LMA Versions Dialog Box

Dialog box buttons and functions are:

• New - Provides the ability to load a new LMA version from diskettes to the
Director Console fixed disk.

• Edit  - Allows the description (for a selected LMA version) to be edited.

• Delete  - Deletes the selected LMA version from the Console fixed disk.

• Set Offline  - Allows the operator to set the Director offline.

Note: When installing a LMA version to a Director without a redundant
CTP card, ensure the Director is set offline prior to installing the
LMA version.

• Install  - Installs the selected LMA version to the Director.

• Close  - Closes the dialog box.

The six-digit LMA version number (XX.YY.ZZ) represents the following:

XX - LMA version level

YY - LMA release level

ZZ - LMA patch level.

Attention!

LMA version 5.0 (or later) and FICON operation are not supported by
9032-003 or 9033-004 Directors.  Attempts to install LMA version 5.0
(or later) to these Director models are prevented by the Director Console.
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Collect Maintenance Information

The Collect Maintenance Information option transfers information to the Console
fixed disk for later retrieval to a diskette through the data collection procedure. The
information collected is typically used by service personnel.

Select the option from the Maintenance menu. The Collect Maintenance Information
dialog box appears (Figure 129). The option is available only from an Active Matrix
window.

Figure 129.  Collect Maintenance Information Dialog Box

While maintenance information is collected, the dialog box describes the current
activity and the status of that activity. When information collection activities complete,
the dialog box closes and the following message box appears (Figure 130).

Figure 130.  Maintenance Information Message Box

To transfer maintenance information to a diskette for later analysis by qualified
maintenance personnel, perform the data collection procedure.  Refer to the
Console Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033
Model 4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex
Timer (GA22-7291) for instructions.
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Console Link Statistics

Select the Console Link Statistics  option from the Maintenance menu. The Console
Link Statistics dialog box (Figure 131) appears. The dialog box displays the status
of the Token Ring link between a selected Director and the Console, and data and
error counts to help diagnose problems associated with the link.  The counts are
separate for each Director-to-Console link.

Figure 131.  Console Link Statistics Dialog Box

The values displayed are not dynamically updated while the dialog box is open.
However, the Refresh button can be selected to update and redisplay the contents.
The contents of the dialog box can also be cleared (by selecting the Clear button)
to compare accumulated counts at a later time. When the Director-to-Console link
is unavailable, the link can be manually reset (by selecting the Reset Link button).
If a problem exists, the Director or Console usually resets the link automatically.

The Console Link Statistics dialog box provides a link identifier values section, a link
statistics data count values section, and control buttons.

Link Identifier Values

Link identifier values include:

• IP Address  - The Internet Protocol (IP) address of the Director for which the
Director-to-Console link statistics apply.  The IP address is defined in the
Director Definition dialog box (Figure 39 on page 52).

• Current State  - An Available state indicates the Director-to-Console link
is performing normally.  An Unavailable state indicates the link is down.
Although automatic recovery is normally in process, the link can be manually
reset with the Reset Link button. When the link is unavailable, the reason for
the condition also appears.
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Link Statistics Data Count Values

Link statistics data count values include:

• Transmit and Receive packets  - The displayed values are counts of
low-level User Datagram Protocol (UDP) data packets transmitted from
the Console to the selected Director, and received from the Director by the
Console application.

• Transmit and Receive errors  - The displayed values are counts of
automatically recoverable errors that are normally encountered with heavy
traffic on the link.  Some errors do not necessarily indicate a problem.

• Link resets  - The displayed value indicates the number of times the link
was brought down (unavailable), due to physical conditions (Director powered
off or cable removed) or link errors.  When the link becomes unavailable, it
automatically performs a recovery process.

• Link error  - The value indicates the last encountered communications error
between the Console application and the Token Ring application interface
software (socket error).  The value is not an error count.

• Frame errors  - The displayed value indicates the number of packets sent
that were corrupted and resent.  In case of multiple errors, several attempts
are made to force a retransmission of the data before the link is automatically
brought down and restarted.

Control Buttons

The dialog box provides the following control buttons:

• Refresh - Reads the latest data and error counts, and refreshes the dialog box
with current information. This function is useful because the dialog box does
not update dynamically.

• Close  - Closes the dialog box.

• Help  - Opens a window to access online help for the dialog box.

• Clear  - Clears all data and error counts and resets the values to zero.  This
function is useful when comparing counts over time, and helps to determine
which counters continue to increment.

• Reset Link  - This button is enabled only if the state is Unavailable, because
the link does not need to be reset otherwise. When the button is selected, the
link is reset and a restart is attempted by the Console.  This function is not
normally required, because link recovery is automatic.
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Chapter 4.  Configuring Port Connections

This chapter describes how to configure a Director matrix and set port attributes with
different states and priorities. Two configuration exercises, from opening a new matrix
through saving and activating the matrix, are included in the chapter.

Note: All descriptions of the matrix in this chapter, including Fibre Connection
(FICON) or Enterprise Systems Connection (ESCON) port attributes,
assume the matrix is in graphic display mode.  To enable graphic display
mode, enable (check) the Graphic Display option from the View pull-down
menu.  For a comparison between graphic display mode and nongraphic
display mode, refer to "Graphic Display" on page 102.

Matrix Highlights and Symbols

The Director matrix window (Figure 132) provides a visual interface that displays port
connection and configuration attributes for a selected Director, and allows an operator
to change those attributes. The window illustrates port selection (highlighting) and
port attribute symbols (blocked, dedicated, prohibited).

Figure 132.  Director Matrix Highlights and Symbols
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Address Selection Highlight

Each port address must be individually selected (highlighted) before performing a
connection change request.  The selected address is highlighted by a dashed box
that surrounds the port address, port name, status columns, and matrix cells for the
selected address (port address 12 in Figure 132).

Because prohibited and dedicated connection attributes affect the intersection of two
port addresses, a single cell cursor  is highlighted (as a white cell) for modification
of these attributes for the selected address.  Use the keyboard arrow keys or the
mouse to move the cell cursor as required.  The position of the cell cursor selects
the port address within highlight area. Figure 132 illustrates the cell cursor within
a port selection highlight area.

Invalid Cell Locations

Certain cell locations in the matrix are invalid for intersection connections (such as
allow, block, dedicate, or prohibit). Invalid locations include the intersection of a port
address with itself (such as the intersection of port C0 with C0).  Self-intersection
cells are indicated by a solid diagonal line through the matrix.

Fibre Channel Converter (FCV) Port cards cannot be dynamically connected.  An
FCV-to-FCV connection is automatically prohibited by the Console application
(indicated by a P in the cell intersection), and the connectivity attribute cannot be
changed.

The white cell cursor may be moved into an invalid cell because other operations
are valid for the port address, but connection attribute functions are restricted. The
matrix Edit menu indicates which operations are invalid for a selected cell.  Invalid
menu options are grayed out.

Port Attribute Symbols

The matrix window displays symbols for each connectivity attribute.  Prohibited
connections (Figure 135 on page 142) are displayed at the intersection of the
affected port addresses.  Blocked connections (Figure 133 on page 141) and
dedicated connections (Figure 134 on page 141) are displayed across all affected
port addresses, allowing quick visual identification even if an associated connection
does not appear in the visible portion of the matrix window.

When a matrix attribute is modified, the attribute is highlighted to identify changes
made to the configuration. Attributes changed since the configuration was last read
appear in a brighter color or intensity. Attributes changes that are cleared appear in
a more subdued color.  Changed text (or port address numbers affected by the
change) appear in blue. These highlights and color changes revert to normal after
the a change is activated (for an active matrix) or saved (for a saved matrix).

Note: Activating a modified (but not saved) attribute for a previously saved matrix
sets the attribute for the active matrix but not the saved matrix. For example,
if a prohibited port connection is added to a saved matrix and then activated,
the active matrix contains the prohibited connection.  The saved matrix
displays the highlighted port connection attribute (bright red) until the matrix
is saved again. Exiting the saved matrix (without saving the attribute change)
discards the highlighted attribute, but the change remains in effect in the
active matrix.
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Examples of attribute highlighting (blocked, dedicated, and prohibited) are shown in
the following figures. Figure 133 illustrates blocked symbol highlighting.

Figure 133.  Blocked Symbol Highlighting

Figure 134 illustrates dedicated symbol highlighting.

Figure 134.  Dedicated Symbol Highlighting

Currently Blocked:
Dark Bar with Red Stripes, Grey X in
Connections column. Port address is currently
blocked.

Blocked Symbol Highlighting

Unblocked to Blocked:
Dark Bar with Yellow Stripes, Blue X in
Connections column. Port address has been
blocked since the configuration was read. The
attribute changes to the Currently Blocked
appearance after activating or saving.

Blocked to Unblocked:
No Bar with Olive Stripes, Yellow X in
Connections column. Port address has been
unblocked since the configuration was read.
Attribute is cleared from the display after save
or activation.

Hdwr

Hdwr

Hdwr

Con

Con

Con

Currently Dedicated:
Dark Green Indicator bars with Black
address. Port address intersection is currently
dedicated.

Dedicated Symbol Highlighting

Not Dedicated to Dedicated:
Bright Green Indicator bars with Blue
address. Port address intersection has been
dedicated since the configuration was read.
Attribute changes to the Currently Dedicated
(dark green) appearance after activating or saving.

Dedicated to Not Dedicated:
Olive Indicator bars with Olive address. Port
address intersection had been dedicated and
has been cleared since the configuration was
read. Attribute will be cleared from the display
after save or activation.

Hdwr

Hdwr

Hdwr

Con

Con

Con

C0

C0

C0
Chapter 4. Configuring Port Connections 141



Figure 135 illustrates prohibited symbol highlighting.

Figure 135.  Prohibited Symbol Highlighting

Connectivity Hierarchy

Multiple connectivity attributes can be assigned to a single port address. With certain
exceptions (for example FICON-to-FICON), port addresses can be configured to be
simultaneously blocked, dedicated, and prohibited.  Assigning more than one
connectivity attribute to a port (ESCON or FICON) creates the following hierarchy.

1. The Blocked attribute has the highest precedence and overrides all other
attributes (dedicated, prohibited, allowed) assigned to a port.

2. The Dedicated attribute has second precedence and overrides the
prohibited and allowed attributes.

3. The Prohibited attribute has third precedence and overrides only the allowed
attribute.

4. The Allowed attribute has the lowest precedence and does not override any
other attributes.

Using the Mouse

Most areas of the matrix window are sensitized for mouse usage. Clicking with the
mouse selects a specific position on the matrix grid.  Double-clicking in one of the
sensitized mouse areas performs a task such as opening a dialog box or placing an
attribute symbol. The matrix window can be maximized or minimized as in normal
operations, and the matrix window scroll bars perform normal scrolling actions on
the matrix.

Currently Prohibited:
Dark Red symbol. Port address intersection is
currently prohibited and has not been modified.

Prohibited Symbol Highlighting

Allowed to :
Bright Red symbol. Port address intersection
has been prohibited since the configuration was
read. Attribute will change to the Prohibited
appearance after activating or saving.

Prohibited

Prohibited to Allowed:
Olive symbol. Port address intersection had
been prohibited and has been cleared
(allowed). Attribute will be cleared from the
display after save or activation.
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Actions within the matrix window are initiated with the mouse by positioning the
mouse cursor as indicated (refer to Figure 132 on page 139) and performing one of
the following operations:

• Single-click (left button) - Selects the address under the cursor. The dashed
highlight box is moved to the selected address.  If the mouse cursor is on a
port address, or name, or within the status columns for an address, that address
is selected and the intersection cell indicator (white box) is not changed.   If
the mouse click occurs within the gray matrix area, the intersection cell indicator
is positioned under the cursor as well.  If the mouse click occurs on the
intersection cell addresses (top row numbers above the matrix), only the
horizontal position of the intersection cell indicator will be affected.

• Double-click (left button)  - Performs a default action at the mouse cursor
position.

— Port Address, left side  - Displays the Node Descriptor dialog box,
showing information about the device attached to the port.

— Port Address, top of matrix grid - Swaps the axis of the matrix, providing
more information (address name, hardware status, connection status)
about the port by putting that port address number on the left side of the
matrix.  Highlights the row with the chosen port address.

— Port Address Name - The Name for Address dialog box is displayed to
change the selected port address name.

— Blocked Column  - Toggles the blocked attribute state of the port (B
column; graphic display off).

— Connections Column (Con or C column) - The Name and States dialog
box is displayed, to enter a dedicated connection intersection port address
and/or to modify the prohibited and/or blocked attributes.  Hold the Ctrl
key while double-clicking in the connections column to toggle the blocked
state of the port.

— Matrix Grid  - Toggles the prohibited state of the intersection cell.  Hold
the Ctrl key while double-clicking to toggle the dedicated attribute for the
intersection cell.  Single-clicking moves the address selection highlight
and cell cursor.

— CUP Name Region   - Displays the Name for CUP dialog box to modify
the Director’s Control Unit Port name.

— Link Status Indicator  - Displays the Console Link Statistics dialog box
to show current status and statistics for the Token Ring link between the
Director and the Console.

— Director Status Indicator  - Displays the Director Operational Status
dialog box, explaining any errors encountered on the Director.

Double-clicking any other area of the matrix (such as the Hardware Status
column) does not perform a function. However, double-clicking anywhere
on the matrix window clears any existing Status line message in addition
to performing the operation.
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• Ctrl + Double-click (left button) - When the Ctrl key on the keyboard is held
down while the left mouse button is double-clicked, an extended action is
performed at the mouse cursor position. If the mouse cursor is in the Con
column, the blocked attribute is toggled for the address.  If the mouse cursor
is in the matrix area, the dedicated attribute is toggled for the intersection
addresses in the cell under the cursor. For other areas, the action will be the
same as if the Ctrl  key was not held.

• Matrix Map button (single-click left button to select) - This button is in the
lower right corner of the matrix, below the vertical scroll bar. It is a fast method
of selecting the Matrix Map.

Note: The Matrix Map button is grayed out (unavailable) at a 9033-004 matrix
window.

Matrix Keyboard Support

This section describes the special keystrokes available for navigation through the
matrix windows.

• PgUp or F7 / PgDn or F8 - Scrolls the matrix up or down one page, respectively
(a page is defined as the number of addresses displayed on a single matrix
window).

• Shift+PgUp / Shift+PgDn  - Scrolls the matrix vertically to the minimum (80
for 9032-003, C0 for 9033, 04 for 9032-005) port address (Shift+PgUp) or to
the maximum (FB for 9032, CF for 9033) port address (Shift+PgDn)  without
changing the horizontal position.

• Ctrl+PgUp / Ctrl+PgDn - Scrolls the matrix left (Ctrl+PgUp ) or right
(Ctrl+PgDn)  one page.

• Home / End - Moves the cell cursor horizontally to the left-most displayed cell
(Home) or to the right-most displayed cell (End) .

• Shift+Home / Shift+End - Scrolls the matrix horizontally to the minimum (80
for 9032-003, C0 for 9033, 04 for 9032-005) port address (Shift+Home) or to
the maximum (FB for 9032, CF for 9033) port address (Shift+End)  without
changing the vertical position.

• Ctrl+Home / Ctrl+End - Moves the cell cursor to the upper left displayed cell
(Ctrl+Home) or to the lower right displayed cell (Ctrl+End) .

• Ctrl+Shift+Home / Ctrl+Shift+End - Scrolls the matrix both horizontally and
vertically to the minimum port address ([80, 80] for 9032-003, [C0, C0] for 9033,
[04, 04] for 9032-005) or to the maximum port address ([FB, FB] for 9032, [CF,
CF] for 9033).

• Ctrl+Ins or C - Copy all allow/prohibit attributes for the selected address row
into the clipboard for later paste operations. Equivalent to the Edit menu Copy
option.  This function will copy the attributes into the clipboard for use by the
matrix paste operation.
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• Shift+Ins or T - Inserts (pastes) allow/prohibit attributes from the clipboard into
the currently selected address row.  Equivalent to the Edit menu Paste
command.

• Arrow keys - The arrow keys move the cell cursor one cell in the direction of
the arrow. When the selected cell is on the edge of the displayed matrix page
(top, bottom, right, or left edge), continued use of the direction key scrolls the
matrix one cell, until the minimum or maximum (80 or FB for 9032-003, C0 or
CF for 9033, 04 or FB for 9032-005) port address is encountered.

• Tab / Shift+Tab (BackTab) - Moves the cell cursor one cell to the right or left,
respectively. From the edge of the displayed matrix, subsequent use of these
keys moves the selected cell (and the row selection indicator) to the next or
previous row, respectively, without changing the displayed matrix position. The
bottom right cell wraps to the upper left cell on a Tab, and the upper left cell
wraps to the lower right on a Shift+Tab .

• A / P - Theupperor lowercasealphacharacterA (Allow)clears theProhibitattribute
for the currently selected cell (intersection addresses), and P (upper or lower case)
sets the prohibit attribute for the currently selected cell. The cell cursor is advanced
to the next cell after either character. Hold the Shift key down while pressing either
key to move the cursor to the previous cell after setting the attribute. Scrolling may
occur at either end of the displayed matrix grid.

• B / U - The alpha character B (upper or lower case) sets the Blocked attribute
for the currently selected address, and U (upper or lower case) clears
(unblocks) the Blocked attribute for the currently selected address.  The
selection row is advanced down after either character. Hold the Shift key down
while pressing either key to move the selection row up after setting the attribute.
Scrolling may occur at the top or bottom of the displayed matrix grid.

• Space bar  - The space bar toggles the Prohibit attribute for the currently
selected intersection cell.  The selection cell is not moved.

• F4 - Use of this key on an active matrix rereads the current active matrix from
the Director.  This performs a Revert to last activated function.  The current
Director matrix overwrites any non-activated changes made to the active matrix
with the Director’s current active matrix.

Creating a New Configuration Matrix (ESCON Only)

This section provides a practical exercise that illustrates ESCON-only operation
of the Director Console.  It is assumed the Console application software is
installed on the PC platform, the Operating System/2 (OS/2) desktop is displayed,
and at least one ESCON Director is defined to the Console (refer to "Director
Definition Dialog Box" on page 52 for information).  The exercise illustrates how to
configure a new configuration matrix (including port connections) for a 9032-003
ESCON Director.

1. At the Director Console’s OS/2 desktop, double-click the Director Console
icon.  The Console application initializes and the Startup window appears. It
may take up to 30 seconds for the Console application to open.
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2. Select the New Configuration Matrix option from the File menu.  The Select
Director for New Matrix dialog box appears (Figure 136). The dialog box
contains a list of all configured Directors supported by the Console.

Figure 136.  Select Director for New Matrix Dialog Box

3. Select the Director for which the new configuration matrix is to be created
(9032-003 in this example) and click the OK button.  The New Matrix window
appears (Figure 137).

Figure 137.  Matrix Window (No Attributes Set)
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The Matrix window appears in graphic display mode with the cell cursor at the
first address intersection for the Director type (80, 80 for a 9032-003, C0, C0
for a 9033-004, and 04, 04 for a 9032-005).  The Director name (9032-003)
and the type of matrix (New Matrix ) appear in the title bar at the top of the
window.  The matrix is ready to have configuration attributes assigned to
port addresses.

4. Select the Matrix Map option from the View menu or click the M button at the
lower right corner of the matrix.  The Matrix Map dialog box appears (Figure
90 on page 101).   Select the C, C intersection.  The cell cursor moves to the
C0, C0 address intersection.

Configure Prohibit Attribute  - The prohibit attribute is configured first.  This
attribute only affects a connection between two configured ports.

5. Double-click the white cell cursor (or press the P key) and observe the status
line at the bottom of the Matrix window.  The error message Address self-
intersection prohibited or dedicated connections are not allowed.  appears
in bright red characters.  This is an example of a displayed error condition.

6. Move the mouse cursor to the Name column for port address C0. Select the
Names option from the Edit menu or double-click the mouse.  The Name for
Address dialog box appears (Figure 138).

Figure 138.  Name for Address Dialog Box

Using facility port naming rules and conventions, enter a name for the port
address and click the OK button.  The port address name (CHPID.001 in
the example) appears in blue characters in the Name column.

7. Repeat step 6 for port addresses C1 and C2.  Port address names
CHPID.002 and CHPID.003 are used in the example.

8. Move the white cell cursor one cell (port) to the right.  Use the arrow key
or click the cell with the mouse cursor.  Set the prohibit attribute for the
connection between port addresses C0 and C1 using one of the following:

— Select the Prohibited option from the Edit menu

— Double-click the cell with the mouse

— Press the P key

— Press the space bar.
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A bright red prohibit symbol appears, overlaying the cell cursor.  If the P key
option was used to prohibit the C0 to C1 connection, the cell cursor moves one
port address to the right.

9. Move the white cell cursor one cell (port) to the right (to C0, C2). The cursor
is already placed correctly if the P key option was used to prohibit the C0 to
C1 connection.  Set the prohibit attribute for the connection between port
addresses C0 and C2 using one of the options in step 8.

Port address C0 is now prohibited from a connection with port addresses
C1 and C2.  Any other address connection for port address C0 is allowed.
Figure 139 shows the New Matrix window with the prohibit attribute set.

Figure 139.  Matrix Window (Prohibit Attribute)

Configure Dedicate Attribute - The dedicate attribute (sometimes referred to as a
static connection) is configured next.  This attribute disallows all communication,
except with the configured port address.

10. Repeat step 6 for port addresses C3, C4, C5, and CF.  Port address
names CHPID.004, CHPID.005, DASD.001, and DASD.002 are used in
the example.

11. Press the End  key to change the position of the white cell cursor to the CF
column and move the cursor down to port address C3 (use the arrow key or
click the cell with the mouse cursor).

12. Set the dedicate attribute for the connection between port addresses C3 and
CF using one of the following:
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— Select the Dedicated option from the Edit menu

— Simultaneously press the Ctrl  and D keys

— Simultaneously press the Ctrl  key and double-click the cell cursor
(with the cursor in the matrix)

— Set the attribute from the Name and States dialog box (Figure 140). Open
the dialog box by selecting the Name and States option from the Edit
menu, or by moving the cursor to the Con column (for port address C3)
and double-clicking the mouse.  Enter port address CF in the Dedicated to
Address field and click the OK button.

Note: Prohibit and block attributes can also be set from the dialog box.

Figure 140.  Name and States Dialog Box

The dedicated attribute (green bar) appears, and port addresses CF and
C3 appear in the Con column in blue characters.

13. Set the dedicate attribute for the connection between port addresses C4 and
C5 using one of the options in step 12.

The dedicated attribute (green bar) appears, and port addresses C4 and C5
appear in the Con column in blue characters. Any other address connections
for port addresses C3, C4, C5, and CF are not allowed. Figure 141 shows the
New Matrix window with both the prohibit and dedicate attributes set.
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Figure 141.  Matrix Window (Prohibit and Dedicate Attributes)

Configure Block Attribute  - The block attribute is configured next.  This attribute
disallows all communication with the blocked port address.

14. Repeat step 6 for port addresses C6, C8, CA, and CB.  Port address
names PRINTER.001, PRINTER.002, TAPE.001, and TAPE.002 are used
in the example.

15. Move the cursor to the Con column for port address C6. Set the block attribute
for port address C6 using one of the following:

— Select the Blocked option from the Edit menu

— Press the B key

— Simultaneously press the Ctrl  and B keys

— Simultaneously press the Ctrl  key and double-click the cell cursor
(with the cursor in the Con column)

— Set the attribute from the Name and States dialog box (Figure 140). Open
the dialog box by selecting the Name and States option from the Edit
menu or double-clicking the mouse.  Enter port address C6 in the Blocked
field and click the OK button.

Note: Prohibit and dedicate attributes can also be set from the dialog box.

— Set the attribute for a range of port addresses from the Block Address
Range dialog box (Figure 142).  Open the dialog box by selecting the
Block Range option from the Edit menu or simultaneously pressing the
Ctrl  and R keys.  Click the Range radio button, enter From and To port
address values, and click the Block button.
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Figure 142.  Block Address Range Dialog Box

The cell cursor remains in the Con column and port address C6 is blocked.
Both axes for the port address are highlighted and a blue X appears in
the Con column.

16. Set the block attribute for port addresses C8, CA, and CB using one of the
options in step 15.

Port addresses C6, C8, CA, and CB are blocked.  Both axes for all four port
address are highlighted and a blue X appears in the Con column for each port.

17. Select the Save Configuration Matrix option from the File menu. The Operator
Authorization dialog box appears.  Type an operator authorization password
(default is LEVEL003 ) and click the OK button.  The Save Configuration
Matrix As dialog box appears. Enter a name for the new matrix (STANDARD
is used in the example) and select the OK button. Figure 143 displays the
matrix as it is now configured.

Figure 143.  Matrix Window (All Attributes Saved)
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The title bar at the top of the window changes to reflect the matrix name
(STANDARD ) and the change of state from a New Matrix to a Saved Matrix.
Port attributes change color as described under "Port Attribute Symbols" on
page 140, and all port names and connections (in the Con column) change
from blue to black.

18. To install port attributes, select the Activate Configuration Matrix option from
the File menu or press the F6 key. The Operator Authorization dialog box
appears.  Type an operator authorization password (default is LEVEL003 )
and click the OK button.  The Activate Configuration Matrix dialog box
appears (Figure 144).

Figure 144.  Activate Configuration Matrix Dialog Box

Note: None of the check boxes are selected because the matrix was just
saved.

19. Select the Activate All button to activate the configuration matrix with the port
attributes established in this example.

20. To view the Active Matrix for the selected Director:

— Select the Open Active Configuration Matrix option from the File menu. The
Select Active Director dialog box appears.

— Select (double-click) the Director name in the list box, or highlight the
Director name with the up or down arrow keys and click the OK button.

— The Active Matrix for the selected Director appears with the port
attributes established in this example (identical to those displayed in
Figure 143).

Opening the Active Matrix for the selected Director (there can be only one
Active Matrix open per Director) automatically closes the Saved Matrix, and
any unsaved attributes are lost. An operator can close the Matrix window and
exit the Console application without affecting the selected Director’s Active
Matrix.
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Creating a New Configuration Matrix (ESCON and FICON)

This section provides a practical exercise that illustrates ESCON and FICON
operation of the Director Console.  It is assumed the Console application software
is installed on the PC platform, the OS/2 desktop is displayed, and at least one
9032-005 Director (with FCV Port cards installed) is defined to the Console (refer to
"Director Definition Dialog Box" on page 52 for information). The exercise illustrates
how to configure a new configuration matrix (including ESCON and FICON port
connections) for the Director.

Note: FICON operation is supported only by a 9032-005 Director with a FICON
upgrade feature installed. A FICON port connection provides link attachment
only to an IBM System/390 (S/390) Generation 5 (or later model) Parallel
Enterprise Server.

1. At the Director Console’s OS/2 desktop, double-click the Director Console
icon.  The Console application initializes and the Startup window appears. It
may take up to 30 seconds for the Console application to open.

2. Select the New Configuration Matrix option from the File menu.  The Select
Director for New Matrix dialog box appears (Figure 145). The dialog box
contains a list of all configured Directors supported by the Console.

Figure 145.  Select Director for New Matrix Dialog Box

3. Select the Director for which the new configuration matrix is to be created
(9032-005 in this example) and click the OK button.  The Matrix window
appears.

Display More Port Addresses  - An insufficient  number of port addresses
(default is 16) appear at the Matrix window to illustrate the configuration. Configure
the window so more port addresses appear.
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4. Select the Display Options option from the View menu.  The Display Options
dialog box appears (Figure 146).

Figure 146.  Display Options Dialog Box

5. Enter a value of 22 in the Number of addresses across field and click the OK
button.  The New Matrix window appears (Figure 147) with 22 rows and columns
displayed in the matrix.

Figure 147.  Matrix Window (FICON, No User-Selected Attributes Set)
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The Matrix window appears in graphic display mode with the cell cursor at the
first address intersection for the Director type (80, 80 for a 9032-003, C0, C0
for a 9033-004, and 04, 04 for a 9032-005).  The Director name (9032-005)
and the type of matrix (New Matrix ) appear in the title bar at the top of the
window. The matrix is ready to have configuration attributes assigned to port
addresses.

FCV Port cards are installed in the first two slots of the Director (logical port
addresses 04 and 0C). Setting port attributes for a 9032-005 Director with FCV
Port cards installed is subject to the following constraints:

— An FCV Port card uses one logical port address and eight port numbers.
For each port card, seven consecutive port addresses are rendered
unaddressable, indicated by Unaddr  (graphic display mode) or U
(nongraphic display mode) in the Hdwr column.

— A dedicated connection to an FCV Port card is invalid.

— A dynamic connection between two FCV Port cards is prohibited. When
a matrix is activated, the prohibit attribute is set without user intervention
(refer to step 14 of this example).

If an FCV Port card is improperly configured, the Director prevents the card
from coming online, and Inactive  (graphic display mode) or I (nongraphic
display mode) appears in the Hdwr column.  The following invalid
configurations cause an inactive status for an FCV Port card:

— The maximum number of FCV Port cards (16) supported by the Director
is exceeded.

— Hardware upgrades required for FICON operation are not detected.

— The FCV Port card is placed offline to perform a nonconcurrent LIC install
(refer to "Installing a LIC Version" on page 167 for information).

— A dedicated connection is configured for an internal ESCON port.

— An FCV Port card is swapped with an ESCON port.

— An unaddressable FCV port is swapped with any other port.

6. Move the mouse cursor to the Name column for port address 04. Select the
Names option from the Edit menu or double-click the mouse.  The Name for
Address dialog box appears (Figure 148).

Figure 148.  Name for Address Dialog Box
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Using facility port naming rules and conventions, enter a name for the port
address and click the OK button. The port address name (SYSA.CHPID.001
(FICON) in the example) appears in blue characters in the Name column.

7. Repeat step 6 for port addresses 0C, 14, 15, 16, 17, 18, and 19.  Example
port address names appear in Figure 150. Unaddressable ports associated
with FCV Port cards are typically not named.

Configure Dedicate Attribute - The dedicate attribute (sometimes referred to as a
static connection) is configured first.  This attribute disallows all communication,
except with the configured port address.

8. Configure a dedicated connection between SYSA.CHPID.002 (ESCON)
and DASD.003.  Move the cursor down to port address 14 and over to matrix
column 18 (use the arrow keys or click the cell with the mouse cursor).

9. Set the dedicate attribute for the connection between port addresses 14 and 18
using one of the following:

— Select the Dedicated option from the Edit menu

— Simultaneously press the Ctrl  and D keys

— Simultaneously press the Ctrl  key and double-click the cell cursor
(with the cursor in the matrix)

— Set the attribute from the Name and States dialog box (Figure 149). Open
the dialog box by selecting the Name and States option from the Edit
menu, or by moving the cursor to the Con column (for port address 14)
and double-clicking the mouse.  Enter port address 18 in the Dedicated to
Address field and click the OK button.

Figure 149.  Name and States Dialog Box
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Note: Prohibit and block attributes can also be set from the dialog box.

The dedicated attribute (green bar) appears, and port addresses 14 and
18 appear in the Con column in blue characters.  Any other address
connections for these port addresses are not allowed. Figure 150 shows
the New Matrix window with the dedicate attribute set.

Figure 150.  Matrix Window (FICON, Dedicate Attribute)

Configure Block Attribute  - The block attribute is configured next.  This attribute
disallows all communication with the blocked port address.

10. Move the cursor to the Con column for port address 16. Set the block attribute
for port address 16 using one of the following:

— Select the Blocked option from the Edit menu

— Press the B key

— Simultaneously press the Ctrl  and B keys

— Simultaneously press the Ctrl  key and double-click the cell cursor
(with the cursor in the Con column)

— Set the attribute from the Name and States dialog box (Figure 149). Open
the dialog box by selecting the Name and States option from the Edit
menu or double-clicking the mouse.  Enter port address 16 in the Blocked
field and click the OK button.

Note: Prohibit and dedicate attributes can also be set from the dialog box.
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— Set the attribute for a range of port addresses from the Block Address
Range dialog box (Figure 151).  Open the dialog box by selecting the
Block Range option from the Edit menu or simultaneously pressing the
Ctrl  and R keys.  Click the Range radio button, enter From and To port
address values, and click the Block button.

Figure 151.  Block Address Range Dialog Box

The cell cursor remains in the Con column and port address 16 is blocked.
Both axes for the port address are highlighted and a blue X appears in
the Con column. Figure 152 shows the New Matrix window with both the
dedicate and block attributes set.

Figure 152.  Matrix Window (FICON, Dedicate and Block Attributes)
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11. Select the Save Configuration Matrix option from the File menu. The Operator
Authorization dialog box appears.  Type an operator authorization password
(default is LEVEL003 ) and click the OK button.  The Save Configuration
Matrix As dialog box appears.  Enter a name for the new matrix and select
the OK button.

The title bar at the top of the window changes to reflect the matrix name and
the change of state from a New Matrix to a Saved Matrix. Port attributes change
color as described under "Port Attribute Symbols" on page 140, and all port
names and connections (in the Con column) change from blue to black.

12. To install port attributes, select the Activate Configuration Matrix option from
the File menu or press the F6 key. The Operator Authorization dialog box
appears.  Type an operator authorization password (default is LEVEL003 )
and click the OK button.  The Activate Configuration Matrix dialog box
appears (Figure 153).

Figure 153.  Activate Configuration Matrix Dialog Box

Note: None of the check boxes are selected because the matrix was just
saved.

13. Select the Activate All button to activate the configuration matrix with the port
attributes established in this example.

14. To view the Active Matrix for the selected Director:

— Select the Open Active Configuration Matrix option from the File menu. The
Select Active Director dialog box appears.

— Select (double-click) the Director name in the list box, or highlight the
Director name with the up or down arrow keys and click the OK button.

— The Active Matrix for the selected Director appears (Figure 154) with the
port attributes established in this example.

Prohibit symbols appear, indicating a connection between port addresses
04 and 0C is prohibited.  This attribute is set automatically by the Director
because a dynamic connection between two FCV Port cards is prohibited.
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Figure 154.  Matrix Window (FICON, All Attributes Saved and Activated)

Opening the Active Matrix for the selected Director (there can be only one
Active Matrix open per Director) automatically closes the Saved Matrix, and
any unsaved attributes are lost. An operator can close the Matrix window and
exit the Console application without affecting the selected Director’s Active
Matrix.
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Chapter 5.  Console Administrative Functions

This chapter describes administrative functions performed from the Director Console
application.  These functions include:

• Installing or deleting a Loader/Monitor Area (LMA) version or Licensed Internal
Code (LIC) version

• Adding a new password or modifying an existing password

• Creating logical partitions

• Changing Director LAN addresses

• Maintaining and using a backup or replacement Console

• Synchronizing the Director time and date with the Console time and date.

Additional administrative functions are performed from Operating System/2 (OS/2).
To perform Console administrative functions from the operating system, refer to the
Console Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033 Model
4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex Timer
(GA22-7291) for instructions.

Installing or Deleting an LMA Version

The following sections describe installation of an LMA version to the Director Console
and Director, and deleting an LMA version from the Director Console.

Note: When installing both an LMA version and a LIC version, the LMA version
must be installed first.

Installing an LMA Version

This procedure describes installation of a new LMA version to the Director Console
and attached Director.  Installation of LMA Version 4.3 (or a later release level) to
the 9032-003, 9033-004, or 9032-005 Director requires one diskette, labeled LMA
Version 04.YY.ZZ.

Installation of LMA Version 5.0 (or a later release level) to support Fibre Connection
(FICON) operation for the 9032-005 Director requires one diskette, labeled LMA
Version 05.YY.ZZ.

Attention!

LMA version 5.0 (or later) and FICON operation are not supported by
9032-003 or 9033-004 Directors.  Attempts to install LMA version 5.0
(or later) to these Director models are prevented by the Director Console.
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To install a new LMA version:

Note: When installing both an LMA version and a LIC version, the LMA version
must be installed first.

1. At the Director Console, ensure the active matrix window is open for the
selected Director to which the new LMA version is to be installed.

2. Select LMA Versions from the Advanced option from the Maintenance menu.
The Maintenance Authorization dialog box appears.

3. Type a maintenance authorization password (default is LEVEL002 ) and click
the OK button.  The LMA Versions dialog box appears (Figure 155).

Figure 155.  Blank LMA Versions Dialog Box

Note: The LMA Versions dialog box displays a list of LMA versions installed on
the Console fixed disk (up to three versions). The dialog box is blank if no
versions are installed.  If three LMA versions are installed, an old version
must be deleted before installing a new version. Refer to "Deleting an LMA
Version" on page 165 for instructions.

4. Click the New button. The New LMA Version dialog box appears (Figure 156)
with the diskette drive (A: ) selected as the default.

Figure 156.  New LMA Version Dialog Box
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5. Insert the diskette labelled LMA Version XX.YY.ZZ in the diskette drive and
click the OK button.  The Installing New LMA Version message box appears,
indicating installation progress.

6. When the installation is complete, the Edit LMA Description dialog box
appears (Figure 157).  Remove the diskette and store it in a secure location.

Figure 157.  Edit LMA Description Dialog Box

7. Type an LMA description (up to 24 alphanumeric characters).  The description
should contain the name or initials of the installer and the date of installation.
When complete, click the OK button.  The LMA Versions dialog box reappears
(Figure 158) with the new LMA version entered.

The new LMA version is installed on the Console fixed disk and available for
downloading (installation) to any attached Director.

Figure 158.  Completed LMA Versions Dialog Box

8. The Director must be set offline to install an LMA version if only one CTP
card is installed.  When a Director contains a redundant CTP card, an LMA
version is installed without disrupting port connections and Director
operation.  If the Director contains two CTP cards, continue to step 10.
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9. If the Director contains only one CTP card, perform the following:

— If theDirector isnotsupportedbySAOS/390,ensurethesystemoperatorvaries
all Director-attached FICON channels offline. If the Director is supported by SA
OS/390, ensure the system operator applies the Remove Switch command to
vary Director-attached FICON channels offline.

— At the LMA Versions dialog box, click the Set Offline button. The message box
shown in Figure 159 appears.

Figure 159.  Set Director Offline Message Box

— Click the OK button.  The Operator Authorization dialog box appears.

— Type an operator authorization password (default is LEVEL003) and click the
OK button. Ensure the message The Director is offline appears on the status
line at the bottom of the active matrix window.

10. At the LMA Versions dialog box, select (highlight) the LMA version to be
installed and click the Install button.  The message box shown in Figure 160
appears.

Figure 160.  Install LMA Version to Director Message Box
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11. Click the Install button.  The Transferring Files message box appears,
indicating percent completion of file transfer to the Director.  This process
takes several minutes.

When file transfer is complete, the Transferring Files message box closes and the
LMA Install Status message box appears, indicating the Director is saving files and
synchronizing CTP cards (if applicable). To view all status messages that appear
during file transfer, do not click the Close button on the dialog box.

As the LMA install proceeds, the link between the Director and Console drops
momentarily, then returns to normal. The Director also performs an initial machine
load (IML) for the new LMA version.

12. When the LMA install completes, the LMA Install Status message box closes
and the message box shown in Figure 161 appears.

Figure 161.  LMA Install Complete Message Box

13. Click the OK button to close the message box.  At the LMA Versions dialog
box, click the Close button to close the dialog box.

Deleting an LMA Version

This procedure describes how to delete an LMA version from the Director Console.
Because only three LMA versions can be installed on the Console, an old version
might have to be deleted before a new version is installed. To delete an LMA version:

1. At the Director Console, select LMA Versions from the Advanced option from
the Maintenance menu.  The Maintenance Authorization dialog box appears.

2. Type a maintenance authorization password (default is LEVEL002 ) and click
the OK button.  The LMA Versions dialog box appears (Figure 162).
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Figure 162.  LMA Versions Dialog Box

3. At the LMA Versions dialog box, select (highlight) the LMA version to delete
and click the Delete button.  The message box shown in Figure 163 appears.

Figure 163.  Confirm LMA Deletion Message Box

4. Click the Delete button.  The LMA version is deleted from the Director
Console and the LMA Versions dialog box reappears with the version deleted.

5. At the LMA Versions dialog box, click the Close button to close the dialog box.

Installing or Deleting a LIC Version

The following sections describe installation of a LIC version to the Director Console
and Director, and deleting a LIC version from the Director Console.

Note: When installing both an LMA version and a LIC version, the LMA version
must be installed first.
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Installing a LIC Version

This procedure describes installation of a new LIC version to the Director Console
and attached Director. Installation of LIC Version 4.3 (or a later release level) to the
9032-003, 9033-004, or 9032-005 Director requires the following Diskettes:

• One Director LIC diskette, labeled System Version 04.YY.ZZ

• One Director diagnostics diskette, labeled Diag Version 04.YY.ZZ.

Installation of LIC Version 5.0 (or a later release level) to support FICON operation
for the 9032-005 Director requires the following Diskettes.

• Two Director LIC diskettes, labeled System Version 05.YY.ZZ and System2
Version 05.YY.ZZ (containing FICON operational code)

• One Director diagnostics diskette, labeled Diag Version 05.YY.ZZ.

To install a new LIC version:

Note: When installing both an LMA version and a LIC version, the LMA version
must be installed first.

1. At the Director Console, ensure the active matrix window is open for the
selected Director to which the new LIC version is to be installed.

2. Select the LIC Versions option from the Utility menu.  The Maintenance
Authorization dialog box appears.

3. Type a maintenance authorization password (default is LEVEL002 ) and click
the OK button.  The LIC Versions dialog box appears (Figure 164).

Figure 164.  Blank LIC Versions Dialog Box

Attention!

LIC version 5.0 (or later) and FICON operation are not supported by
9032-003 or 9033-004 Directors.  Attempts to install LIC version 5.0
(or later) to these Director models are prevented by the Director Console.
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Note: The LIC Versions dialog box displays a list of LIC versions installed on the
Console fixed disk (up to three versions).  The dialog box is blank if no
versions are installed.  If three LIC versions are installed, an old version
must be deleted before installing a new version. Refer to "Deleting a LIC
Version" on page 173 for instructions.

4. Click the New button. The New LIC Version dialog box appears (Figure 165)
with the diskette drive (A: ) selected as the default.

Figure 165.  New LIC Version Dialog Box

5. Insert the diskette labelled System Version XX.YY.ZZ in the diskette drive and
click the OK button.  The Installing New LIC Version message box appears,
indicating installation progress.

6. When prompted, remove the diskette, insert the diskette labelled Diag
Version XX.YY.ZZ in the diskette drive, and click the OK button.  The
Installing New LIC Version message box indicates installation progress.

— If installing LIC Version 4.3 (or a later release level), go to step 8.

— If installing LIC Version 5.0 (or a later release level) to a 9032-005
Director, continue to the next step.

7. When prompted, remove the diskette, insert the diskette labelled System2
Version 05.YY.ZZ in the diskette drive, and click the OK button.  The
Installing New LIC Version message box indicates installation progress.

8. When the installation is complete, the Edit LIC Description dialog box
appears (Figure 166).  Remove the diskette and store all LIC installation
diskettes in a secure location.

Figure 166.  Edit LIC Description Dialog Box
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9. Type a LIC description (up to 24 alphanumeric characters).  The description
should contain the name or initials of the installer and the date of installation.
When complete, click the OK button.  The LIC Versions dialog box reappears
(Figure 167) with the new LIC version entered.

The new LIC version is installed on the Console fixed disk and available for
downloading (installation) to any attached Director.

Figure 167.  Completed LIC Versions Dialog Box

10. The Director must be set offline to install a LIC version if only one Control
Processor (CTP) card is installed.

When a Director contains a redundant CTP card, a LIC version is installed without
disruptingport connectionsandDirectoroperation. If theDirectorcontains twoCTP
cards, go to step 12.

11. If the Director contains only one CTP card, perform the following:

— If theDirector isnotsupportedbySAOS/390,ensurethesystemoperatorvaries
all Director-attached FICON channels offline. If the Director is supported by SA
OS/390, ensure the system operator applies the Remove Switch command to
vary Director-attached FICON channels offline.

— At the LIC Versions dialog box, click the Set Offline button. The message box
shown in Figure 168 appears.
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Figure 168.  Set Director Offline Message Box

— Click the OK button.  The Operator Authorization dialog box appears.

— Type an operator authorization password (default is LEVEL003) and click the
OK button. Ensure the message The Director is offline appears on the status
line at the bottom of the active matrix window.

12. At the LIC Versions dialog box, select (highlight) the LIC version to be installed
and click the Install button.  The message box shown in Figure 169 appears.

Figure 169.  Install LIC Version to Director Message Box

13. Click the Install button.  If installing LIC Version 4.3 (or a later release level),
go to step 16.  If installing LIC Version 5.0 (or a later release level) to a
9032-005 Director, continue to the next step.

14. LIC Version 5.0 (or higher) cannot be installed concurrently to a FICON-
capable 9032-005 Director if one or more FCV port cards are operating in
degraded mode.  An FCV port card is degraded if up to seven (but not all
eight) internal ESCON ports are not operating.  If an FCV port card is
degraded, the message box shown in Figure 170 appears.
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Figure 170.  Degraded Converter Port Message Box

— If an FCV port card is degraded (message box appears),  perform one of the
following procedures:

• Click the Cancel button to abort the installation, then remove and
replace the degraded FCV port card.  Refer to Chapter 3 in
Maintenance Information for the 9032 Model 5 Director (SY28-1158)
for instructions, then repeat the LIC installation procedure.

• Vary all Director-attached FICON channels offline to install LIC
nonconcurrently.  If the Director is not supported by SA OS/390,
ensure the system operator varies the FICON channels offline. If the
Director is supported by SA OS/390, ensure the system operator
applies the Remove Switch command to vary the FICON channels
offline. Click the Continue button to set FCV ports offline and proceed
with the LIC installation. The ports remain offline until a Director IML,
IPL, or power cycle is performed.  Continue to the next step.

— If an FCV port card is not degraded (message box does not appear), continue
to the next step.

15. When installing LIC Version 5.0 (or higher) to a FICON-capable 9032-005 Director,
the Console performs a dynamic inspection of the new LIC version and the current
LIC version to determine if LIC can be upgraded concurrently.  If the Director
operates at LIC Version 5.0 (or higher), LIC installs are preceded  by a data
exchange between the Director and Console to prepare for installation of
nonconcurrent LIC.

Note: A LIC install is potentially nonconcurrent only when upgrading a
FICON-capable 9032-005 Director from version 5.0 to version 5.x.
Notification of non-concurrency appears in the instructions that
accompany the new LIC version.
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— If the LIC versions are concurrent, the LIC install proceeds while Fibre Channel
Converter (FCV) ports remain online. Continue to step 16

— If the LIC versions are nonconcurrent, FCV ports must be set offline and the
message box shown in Figure 171 appears.

Figure 171.  Nonconcurrent LIC Message Box

Note: This dialog box does not appear if no FCV Port cards are installed
in the Director or if the Director is set offline.

— If theDirector isnotsupportedbySAOS/390,ensurethesystemoperatorvaries
all Director-attached FICON channels offline. If the Director is supported by SA
OS/390, ensure the system operator applies the Remove Switch command to
vary Director-attached FICON channels offline.

— Click theContinuebutton. FCVportsaresetofflineandtheLICinstallproceeds.
The ports remain offline until a Director IML, IPL, or power cycle is performed.

16. The Transferring Files message box appears, indicating percent completion
of file transfer to the Director.  This process takes several minutes.

When file transfer is complete, the Transferring Files message box closes and the
LIC Install Status message box appears, indicating the Director is saving files and
synchronizing CTP cards (if applicable). To view all status messages that appear
during file transfer, do not click the Close button on the dialog box.

As the LIC install proceeds, the link between the Director and Console drops
momentarily, then returns to normal. The Director also performs an IML for the new
LIC version and sets FCV ports online.

17. When the LIC install completes, the LIC Install Status message box closes
and the message box shown in Figure 172 appears.
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Figure 172.  LIC Install Complete Message Box

18. Click the OK button to close the message box.  At the LIC Versions dialog
box, click the Close button to close the dialog box.

Deleting a LIC Version

This procedure describes how to delete a LIC version from the Director Console.
Because only three LIC versions can be installed on the Console, an old version
might have to be deleted before a new version is installed. To delete a LIC version:

1. At the Director Console, select the LIC Versions option from the Utility menu.
The Maintenance Authorization dialog box appears.

2. Type a maintenance authorization password (default is LEVEL002 ) and click
the OK button.  The LIC Versions dialog box appears (Figure 173).

Figure 173.  LIC Versions Dialog Box
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3. At the LIC Versions dialog box, select (highlight) the LIC version to delete and
click the Delete button.  The message box shown in Figure 174 appears.

Figure 174.  Confirm LIC Deletion Message Box

4. Click the Delete button. The LIC version is deleted from the Director Console
and the LIC Versions dialog box reappears with the version deleted.

5. At the LIC Versions dialog box, click the Close button to close the dialog box.

Adding, Modifying, and Deleting Passwords

The following sections describe adding, modifying, and deleting passwords.  The
three levels of password authorization are:

• Level 1 - Password (Administrative) Authorization  - This level of
authorization allows administrators to display, add, modify, and delete
passwords for all levels of authorization, and allows access to the port
authorization function.

• Level 2 - Maintenance Authorization  - This level of authorization allows
service personnel to access maintenance and diagnostic functions, and to
make changes to a Director definition.

• Level 3 - Operator Authorization - This level of authorization allows users to
change, save, and activate  Director configuration matrices.

Adding a Password

To add a password:

1. At the Director Console, select Modify from the Passwords option from the
Utility menu.  The Administrative Authorization dialog box appears.

2. Type an administrative authorization password (default is LEVEL001 ) and
click the OK button.  The Passwords dialog box appears (Figure 175).  The
dialog box provides a radio button selection for each password level.
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Figure 175.  Passwords Dialog Box

3. Select (highlight) the radio button that corresponds to the level of password to
be added (Level 1, Level 2, or Level 3).

4. Click the Add button.  The Add New Password dialog box appears
(Figure 176).

Figure 176.  Add New Password Dialog Box

5. Type a password in the Password field. The password can be up to eight
characters in length, and can consist of any alphanumeric characters other
than an asterisk (*).

Note: Default passwords are provided when the Console is installed.  The
passwords are LEVEL001 , LEVEL002 , and LEVEL003  for the three
levels.
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6. Type a description for the password in the User Description field. The
description can be up to 24 alphanumeric characters long.

7. Click the OK button.  The Add New Password dialog box closes and the
new user description appears in the appropriate list box at the Passwords
dialog box.  Error checking ensures duplicate passwords are not entered at
any level.

Note: Up to 30 passwords can be defined for each password level. After the
30th password is defined for a level, the Add button is disabled at the
Passwords  dialog box.

8. At the Passwords dialog box, click the Close button.

Modifying a Password

To modify a password:

1. At the Director Console, select Modify from the Passwords option from the
Utility menu.  The Administrative Authorization dialog box appears.

2. Type an administrative authorization password (default is LEVEL001 )
and click the OK button.  The Passwords dialog box appears (Figure 175 on
page 175).  The dialog box provides a radio button selection for each
password level.

3. Select (highlight) the radio button that corresponds to the level of password to
be modified (Level 1, Level 2, or Level 3).

4. At the list box, select (highlight) the password and user description to be
modified, and click the Modify button.  The Modify Password dialog box
appears (Figure 177).

Figure 177.  Modify Password Dialog Box

5. Edit the password in the Password field as required. The password can
be up to eight characters in length, and can consist of any alphanumeric
characters other than an asterisk (*).

6. Edit the description for the password in the User Description field as required.
The description can be up to 24 alphanumeric characters long.
176 Using the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Directors



7. Click the OK button.  The Modify Password dialog box closes and the
modified user description appears in the appropriate list box at the
Passwords dialog box.  Error checking ensures duplicate passwords are
not entered at any level.

8. At the Passwords dialog box, click the Close button.

Deleting a Password

To delete a password:

1. At the Director Console, select Modify from the Passwords option from the
Utility menu.  The Administrative Authorization dialog box appears.

2. Type an administrative authorization password (default is LEVEL001 )
and click the OK button.  The Passwords dialog box appears (Figure 175 on
page 175).  The dialog box provides a radio button selection for each
password level.

3. Select (highlight) the radio button that corresponds to the level of password to
be deleted (Level 1, Level 2, or Level 3).

4. At the list box, select (highlight) the password and user description to be
deleted, and click the Delete button.  The following dialog box appears
(Figure 178).

Figure 178.  Delete Password Dialog Box

5. Click the Delete button.  The deleted user description disappears from the
appropriate list box at the Passwords dialog box.

6. If the password to be deleted is the last password in the list box for
the selected level, password protection is disabled for all operations
at that level.  When the Delete button is selected at the Passwords dialog
box, the following dialog box appears (Figure 179).
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Figure 179.  Delete Password Warning Dialog Box

7. Click the Delete button.  The deleted user description disappears from the
appropriate list box at the Passwords dialog box.

8. At the Passwords dialog box, click the Close button.

Creating Logical Partitions

Logical partitions (LPARs) allow an administrator to create port-level configuration
access control unique to defined operators or operator groups.  LPARs allow
operators to access only authorized ports, and restrict unauthorized operators from
changing the port connectivity configuration of any device or set of devices under
control of the Director.  LPARs offer increased security and maximize the flexibility
of a system configuration.  Three steps are required to create an LPAR:

• Define an operator password  - An administrator assigns a password for
access to ports defined by the LPAR.  This password applies to the Enable
Operator option from the Edit menu. Separate passwords are required for
other Director options (such as LIC Versions from the Utility menu).

• Authorize port access for the password  - The administrator defines
configuration access for a subset of port addresses by using the Port
Authorization option from the Utility menu. By default, port authorization is not
enabled and all operators have connectivity management authority for all ports.
By creating an LPAR, the administrator enables operator access to certain
Director ports, and disables access to the remaining ports.

• Enable the LPAR - After the LPAR is created, operators must use the Enable
Operator option from the Edit menu (with the password defined for the LPAR)
to enable access to the defined port configuration.

The following example shows how to create an LPAR for an engineering group. The
LPAR includes a FICON host channel attached to Director port 14, and three direct
access storage devices (DASDs) attached to ports 1C, 1D, and 1E.
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Defining a Password

1. At the Matrix window, select Modify from the Passwords option from the Utility
menu.  The Administrative Authorization dialog box appears.

2. Type an administrative authorization password (default is LEVEL001 )
and click the OK button.  The Passwords dialog box appears.

3. Select (highlight) the Level 3 radio button and click the Add button.  The
Add New Password dialog box appears (Figure 180).

Figure 180.  Add New Password Dialog Box (LPAR Example)

4. Type a password in the Password field. The password can be up to eight
characters in length, and can consist of any alphanumeric characters other
than an asterisk (*).  Type Engineering  in the User Description field.

5. Click the OK button.  The operator ID (L304) and description (Engineering )
appear in the list box at the Passwords dialog box (Figure 181).

Figure 181.  Passwords Dialog Box (LPAR Example)
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6. At the Passwords dialog box, click the Close button.  The Matrix window
reappears.

Defining Port Authorizations

7. Select the Port Authorization option from the Utility menu.  The Port
Authorization dialog box appears (Figure 182).

Figure 182.  Port Authorization Dialog Box (Unmodified)

Port authorization data appears in the form of a matrix, where each cell represents
the intersection of an operator ID and a logical port address. Each cell contains a
check mark, indicating personnel with any operator ID can change attributes for all
Director ports.

8. At the Port Authorization dialog box, click the Range button.  The Authorize
Range dialog box appears (Figure 183).

9. At the Authorize Range dialog box:

— At the Port Address section, click the All radio button.

— At the Operator ID section, click the All radio button.
180 Using the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Directors



— Click the Prohibit button.  The Port Authorization dialog box reappears with
all check marks deleted.

Note: At this point in the procedure, no operator has authorization to
change any port attribute.

Figure 183.  Authorize Range Dialog Box (LPAR Example)

10. At the Port Authorization dialog box, double-click the matrix cell at the
intersection of the Operator ID 304 column and the port address 14 row.  A
check mark appears in the cell.

11. At the Port Authorization dialog box, click the Range button.  The Authorize
Range dialog box appears again (Figure 183).

12. At the Authorize Range dialog box:

— At the Port Address section, click the Range radio button.  Enter a port
address range from 1C to 1E.

— At the Operator ID section, click the Range radio button.  Enter an operator
ID range from 304 to 304.

— Click the Authorize button.  The Port Authorization dialog box reappears as
shown in Figure 184.

Note: At this point in the procedure, only operator ID L304 has
authorization to change port attributes, and only for logical
port addresses 14, 1C, 1D, and 1E.

13. At the Port Authorization dialog box, click the OK button.  The Administrative
Authorization dialog box appears.

14. Type an administrative authorization password (default is LEVEL001 ) and
click the OK button.  The Matrix window reappears with all ports restricted
and blacked out.

Note: The configuration matrix is set to a read-only state. Edit menu options
(Blocked, Dedicated, and Prohibited) are disabled and cannot be
applied, even to ports within the LPAR.
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Figure 184.  Port Authorization Dialog Box (LPAR Example)

Enabling the LPAR

15. Select the Enable Operator option from the Edit menu.  The Operator
Authorization dialog box appears.

16. Type the operator authorization password assigned in step 4 and click the OK
button.  The Matrix window reappears as shown in Figure 185.

When port authorization for this LPAR is active, L304 appears in the operator ID
area (adjacent to the System Error indicator).  If an operator is not identified, ???
appears in the operator ID area.

Note: Operators who are not authorized to configure all ports in the matrix
can only activate an active matrix or save a saved matrix. The Activate
Configuration Matrix and Save Configuration Matrix As options (from the
File menu) can only be used by operators with authorization to configure all
ports. Restricted-use operators (defined for the LPAR) typically do not have
authorization to configure all ports.  However, restricted-use operators can
merge authorized port attributes from a Saved Matrix to the Active Matrix,
then activate the result.
182 Using the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Directors



Figure 185.  Matrix Window (LPAR Example)

Changing Director LAN Addresses through the Console

This section describes the procedures to change a Director’s Internet Protocol (IP)
or Media Access Control (MAC) address from the Director Console’s Terminal
window.  Each procedure temporarily drops the Director-to-Console communication link.

Director IP and MAC addresses are set by the original equipment manufacturer.
However, the addresses may require change if:

• The Director is not installed on an isolated LAN used specifically for Directors
and the Director Console

• The Director addresses do not conform to the customer’s LAN addressing
scheme

• Another device on the LAN has the same IP or MAC address as the Director.

• The LAN uses locally-administered addresses.

Prior to changing a Director’s LAN addresses, determine the current IP and MAC
addresses. Verify any address changes with the customer’s LAN administrator. For
information about determining a Director’s IP and MAC address, or changing the IP
and MAC address at the Director’s operator panel, refer to Chapter 6 of the one of
the following Director-specific maintenance publications:

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)
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• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

Changing the Director IP Address

1. At the Director Console:

— If the Director Console application is open (Startup or Matrix window appears),
go to step 2.

— If the OS/2 desktop is displayed, simultaneously press the Ctrl and Esc keys.
The Window List  appears (Figure 186).

Figure 186.  Window List

— Double-click the Director Console - Director Console selection.  The Director
Console application opens and the Startup or Matrix window appears.

2. Select the Open Active Configuration Matrix option from the File menu.
The Select Active Director dialog box appears (Figure 187).

Figure 187.  Select Active Director Dialog Box
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3. Select (double-click) the appropriate Director name in the list box, or highlight
the Director name with the up or down arrow keys and click the OK button.
The Active Matrix window for the selected Director appears.

4. Select the Advanced option from the Maintenance menu, then select the
Terminal option.  The Maintenance Authorization dialog box appears.

5. Type a maintenance authorization password (default is LEVEL002 ) and click
the OK button.  The Terminal window appears (Figure 188).

Figure 188.  Terminal Window

6. To change the IP address, type the following on the command line and press
the Enter  key.  The IP address is in the form nnn.nnn.nnn.nnn, where nnn is
a decimal value in the range zero through 255.

lanip nnn.nnn.nnn.nnn

Note: Do not use all zeros or all 255s. Leading zeros are not required. The
IP address must be unique among all devices in the LAN.

The Director-to-Console communication link drops and the Link Status indicator
(bottom left corner of the window) changes to a red box with black slash, indicating
the link is not operational.

7. Select the Close Window option from the File menu to close the Terminal
window and return to the Active Matrix window.

8. Select the Open Active Configuration Matrix option from the File menu.
The Select Active Director dialog box appears (Figure 187 on page 184).
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9. Highlight the appropriate Director name (the same Director name selected
in step 3) with the up or down arrow keys or the mouse, and click the Modify
Definition button.  The Director Definition dialog box for the selected Director
appears (Figure 189).

Figure 189.  Director Definition Dialog Box

10. Select the IP Address field and type the new IP address (use the value
entered in step 6).  This identifies the new IP address to the Director
Console.

11. Click the OK button.  A warning box appears, indicating the modification will
temporarily drop the Director-to-Console communication link and close any
open windows for the selected Director.

12. Click the OK button.  The Maintenance Authorization dialog box appears.

13. Type a maintenance authorization password (default is LEVEL002 ) and click
the OK button.  The Select Active Director dialog box reappears (Figure 187
on page 184).

14. Click the OK button.  The Active Matrix window for the selected Director
reappears, and the Link Status indicator returns to a green lightning bolt on a
gray background, indicating the Director-to-Console communication link is
available.

Changing the Director MAC Address

1. At the Director Console:

— If the Director Console application is open (Startup or Matrix window appears),
go to step 2.

— If the OS/2 desktop is displayed, simultaneously press the Ctrl and Esc keys.
The Window List  appears (Figure 190).
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Figure 190.  Window List

— Double-click the Director Console - Director Console selection.  The Director
Console application opens and the Startup or Matrix window appears.

2. Select the Open Active Configuration Matrix option from the File menu.
The Select Active Director dialog box appears (Figure 191).

Figure 191.  Select Active Director Dialog Box

3. Select (double-click) the appropriate Director name in the list box, or highlight
the Director name with the up or down arrow keys and click the OK button.
The Active Matrix window for the selected Director appears.

4. Select the Advanced option from the Maintenance menu, then select the
Terminal option.  The Maintenance Authorization dialog box appears.

5. Type a maintenance authorization password (default is LEVEL002 ) and
click the OK button.  The Terminal window appears (Figure 192).
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Figure 192.  Terminal Window

6. To change the MAC address, type the following on the command line and
press the Enter  key.  The MAC address is in the form hh hh hh hh hh hh,
where h is a hexadecimal value.

lanmac hh hh hh hh hh hh

The Director-to-Console communication link drops and the Link Status indicator
(bottom left corner of the window) changes to a red box with black slash, indicating
the link is not operational.

7. Select the Close Window option from the File menu to close the Terminal
window and return to the Active Matrix window.

8. Select the IPL Director option from the Utility menu. The following dialog box
appears (Figure 193).

Figure 193.  Reset CTP Card Dialog Box
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9. Click the OK button.  The Operator Authorization dialog box appears.

10. Type an operator authorization password (default is LEVEL003 ) and click the
OK button.  The Active Matrix window reappears.

11. Simultaneously press the Ctrl  and Esc  keys to toggle to the OS/2 desktop.

12. Click the arrow on the TCP/IP Cnfg. drawer to open the drawer (Figure 194).

Figure 194.  OS/2 Desktop (TCP/IP Cnfg. Drawer Open)

13. Click the ARP icon.  This action clears the Address Resolution Protocol
(ARP) table, allowing the network to accept the new MAC address for LAN
communications.

Note: The Director operator panel displays the old MAC address. To display
the new MAC address, reboot the Director Console or IML the Director.

14. Click the arrow on the TCP/IP Cnfg. drawer to close the drawer.

15. At the OS/2 desktop, double-click the Director Console icon.  The Director
Console application opens and the Active Matrix window appears.
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Maintaining and Using a Replacement or Backup Console

It is recommended an additional Console be configured and provided to take over
maintenance and operation of Directors if the primary Console fails.  Depending
on customer requirements, a replacement Console or backup Console should be
provided.

Use the following procedures to configure, maintain, and use a replacement or
backup Console.  Tasks in the procedures are referenced to one of the following
Director-specific maintenance publications:

• Maintenance Information for the 9032 Model 3 Enterprise Systems
Director (SA27-3601)

• Maintenance Information for the 9033 Model 4 Enterprise Systems
Director (SA27-2638)

• Maintenance Information for the 9032 Model 5 Director (SY28-1158).

Replacement Console

This section describes the procedure to configure and use a replacement Console,
synchronize Console data with the primary Console, and install the Console on the
Token Ring LAN.

A replacement Console is not connected to the Token Ring LAN where the primary
Console is connected.  The replacement Console’s system library is periodically
updated (from a rewriteable optical cartridge (ROC) or tape) to match the primary
Console’s system library.  If the primary Console fails, it is disconnected from the
LAN and the replacement Console is connected.

Setting Up the Replacement Console

1. Perform “Task 1: Setting Up the Console” in Chapter 6 of the Director-specific
maintenance information manual.

2. If required, change the data rate for the replacement Console’s Token Ring
adapter card.  Refer to Console-specific instructions in the Console
Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033 Model
4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex Timer
(GA22-7291).

3. At the primary Console, perform “Task 10: Backing Up the System Library” in
Chapter 6 of the Director-specific maintenance information manual.

Attention!

Ensure the IP address of the replacement Console is identical to the IP
address of the primary Console. Because these addresses are identical,
the replacement Console cannot be maintained on the same LAN (during
normal operations) to which the primary Console is connected.
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4. Restore the system library for the replacement Console to synchronize
data with the primary Console.  Refer to Console-specific instructions in
the Console Installation and User’s Guide: 9032 Model 3 ESCON Director,
9033 Model 4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2
Sysplex Timer (GA22-7291).

Note: If any changes are made to the library on the replacement Console
(such as changing matrixes and Director identifications), this process
overwrites those changes.

Maintaining the Console

Periodically restore the system library for the replacement Console to synchronize
data with the primary Console. Refer to Console-specific instructions in the Console
Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033 Model 4 ESCON
Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex Timer (GA22-7291).

Using the Console

If the primary Console fails:

1. Disconnect and remove the primary Console from the Token Ring LAN.

2. At the replacement Console, perform “Task 3, Connect the Console to the
MAU” in Chapter 6 of the Director-specific maintenance information manual.

Backup Console

This section describes the procedure to configure and use a backup Console,
synchronize Console data with the primary Console, and install the Console on the
Token Ring LAN.

A backup Console is similar to a replacement Console, however a backup Console
has a different IP address than the primary Console.  Therefore, the Console can
be connected and maintained on the same Token Ring LAN as the primary Console.
A backup Console provides faster replacement of the primary Console. If the primary
Console fails, simply shut down the Console and start the Director Console
application on the backup Console.

Attention!

Synchronize the system libraries for the replacement and primary
Consoles each time a change is made to the primary Console. Establishing
a regular schedule for this procedure is recommended to properly
maintain the replacement Console.

Attention!

The Director Console application does not permit a Director to be
simultaneously operated from both a primary and backup Console. Event
and other critical data may be lost.
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Setting Up the Backup Console

1. Perform “Task 1: Setting Up the Console” in Chapter 6 of the Director-specific
maintenance information manual.

2. Ensure the Token Ring adapter card data rate is identical for the primary and
backup Consoles. If required, change the data rate for the backup Console.
Refer to Console-specific instructions in the Console Installation and User’s
Guide: 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director, 9032
Model 5 Director, and 9037 Model 2 Sysplex Timer (GA22-7291).

3. Change the IP address of the backup Console so it does not match the IP
address of the primary Console. Refer to Console-specific instructions in the
Console Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033
Model 4 ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex
Timer (GA22-7291).

4. At the primary Console, perform “Task 10: Backing Up the System Library” in
Chapter 6 of the Director-specific maintenance information manual.

5. Restore the system library for the backup Console to synchronize data with
the primary Console.  Refer to Console-specific instructions in the Console
Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033 Model 4
ESCON Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex Timer
(GA22-7291).

6. At the backup Console, perform “Task 3, Connect the Console to the MAU” in
Chapter 6 of the Director-specific maintenance information manual.

Maintaining the Console

Periodically restore the system library for the backup Console to synchronize data
with the primary Console.  Refer to Console-specific instructions in the Console
Installation and User’s Guide: 9032 Model 3 ESCON Director, 9033 Model 4 ESCON
Director, 9032 Model 5 Director, and 9037 Model 2 Sysplex Timer (GA22-7291).

Using the Console

If maintaining the backup Console as an active node on the LAN, do not attempt
to start its Console application while the primary Console is operating. This will
conflict with the primary Console’s communications with the Directors in its cluster.

If the primary Console fails:

Attention!

Synchronize the system libraries for the backup and primary Consoles
each time a change is made to the primary Console. Establishing a regular
schedule for this procedure is recommended to properly maintain the
backup Console.
192 Using the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Directors



1. Switch off the primary Console’s power.

2. At the backup Console, double-click the Director Console icon located on the
OS/2 desktop to start the Console application and to take over operation and
maintenance of Directors.

Synchronizing Director Time and Date with Console Time and Date

This section describes the procedure to synchronize the Director time and date
with the Director Console time and date.

1. At the Director Console, select the Open Active Configuration Matrix
option from the File menu.  The Select Active Director dialog box appears
(Figure 195).

Figure 195.  Select Active Director Dialog Box

2. Select (double-click) the appropriate Director name in the list box, or highlight
the Director name with the up or down arrow keys and click the OK button.
The Active Matrix window for the selected Director appears.

3. Select the Time/Date option from the Utility menu.  The Set Director Time
and Date dialog box appears (Figure 196).

Attention!

Do not simultaneously operate the Director Console application on the
primary and backup Console.  Event and other critical data may be lost.
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Figure 196.  Set Director Time and Date Dialog Box

4. Click the Read from Console button.  The New Time and New Date fields
are updated with the Console PC time and date (set through the operating
system).

5. Click the Console Sync button to set the Director time and date to the
Console time and date.  The Operator Authorization dialog box appears.

6. Type an operator authorization password (default is LEVEL003 ) and click
the OK button.  The Set Director Time and Date  and Operator Authorization
dialog boxes close, the Active Matrix window reappears, and the Director
time and date are synchronized with the Console time and date.
194 Using the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Directors



Appendix A.  Console Messages

Messages may appear in dialog boxes and may require the selection of an option
before any other operation is completed.  Icons in the dialog box indicate the severity
or nature of the message.

(?) requires selection of an option before completing the operation.

(!) are error warning messages.  Operations may not be completed in the current state.

(i) are informational only and are accompanied by an OK push button to acknowledge
the information displayed.

For some messages in this Appendix, the user is directed to contact your next
level of support .  For most Console users, this support is provided by Help Desk
or service personnel.
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Matrix Window Messages Setting Attributes

The following messages appear in dialog boxes if an invalid operation is attempted
while setting attributes in the matrix window.  The <addr>  notation in some messages
is replaced by a port address number (in hexadecimal format) in the displayed error
dialog box.

Address <addr>  is already dedicated to address <addr> . Replace with
new dedicated connection, or delete current dedicated connection? - An
attempt was made to set a dedicated connection between two port addresses
where one of the ports already has a dedicated connection. Selecting Replace
removes the current dedicated connection from the one address and replaces
it with a dedicated connection at the intersection of the selected ports. Delete
removes the existing dedicated connection without setting a new one.

An address may not be dedicated to itself! - In setting the dedicated
connection intersection address for a port address from the Names and States
dialog box, the Dedicated to address field may not contain the same address
as the one in the dialog box title.

Both addresses are already dedicated to other addresses. Replace BOTH
with a single new dedicated connection? - An attempt was made to set a
dedicated connection between two port addresses that have both already been
assigned dedicated connections to other addresses.  Selecting replace
removes the previous dedicated connections and makes a single dedicated
connection between the two selected ports.

Dedicated address must be in the range of <addr>  through <addr> . - A
dedicated address has been entered that is not valid for the Director.

Port address must be in the range of <addr>  through <addr> . - In dialog
boxes requiring an address specified in a field, the values must be within the
range of those supported by the Director.

Cannot set dedicated connection to uninstalled or unaddressable port. -
On an active matrix, dedicated connections cannot be set for addresses
associated with uninstalled or unaddressable ports. Refer to status columns
to determine uninstalled or unaddressable ports.

This name duplicates an existing name. Enter a unique name. - Two port
addresses cannot have the same port address name and this name is already
in use on this Director.  Enter a new port address name.
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Activation failed due to unauthorized changes to Port Name.  - This
message is displayed if there are changes to port names for ports that the
activating operator ID does not have authorization to change. This could occur
if one operator ID was used to perform editing operations in the matrix window
and a different operator ID password was supplied at activation time.

Activation failed due to unauthorized dedicate/undedicate request. - This
message is displayed if there are changes to the dedicated state for ports that
the activating operator ID does not have authorization to change. This could
occur if one operator ID was used to perform editing operations in the matrix
window and a different operator ID password was supplied at activation time.

Activation failed due to unauthorized block/unblock request - This
message is displayed if there are changes to the blocked state for ports that
the activation operator ID does not have authorization to change. This could
occur if one operator ID was used to perform editing operations in the matrix
window and a different operator ID password was supplied at activation time.

Activation failed due to unauthorized prohibit/allow request. - This
message is displayed of there are changes to the prohibit state for ports that
the activation operator ID does not have authorization to change. This could
occur if one operator ID was used to perform editing operations in the matrix
window and a different operation ID password was supplied at activation time.

Changes pending. Merging a saved matrix will overwrite the changes in
the Active Matrix Window.  - This message appears if the File menu Merge
Saved Configuration option is selected when changes are pending in the active
matrix window.

Cannot merge a configuration containing a dedicated connection to an
uninstalled or unaddressable port.  - This message appears if the saved
matrix being merged has a dedicated connection to an uninstalled or
unaddressable port.

Unable to merge all port attributes due to authorization conflicts.  - This
message is displayed if merging the saved matrix would add or remove a
dedicated connection where one of the ports is not authorized for the current
operator.

Converter ports must remain prohibited from other converter ports.
Continuing will preserve all prohibits between converter ports. - The user
cannot alter the prohibit attribute of intersecting FCV Port cards by merging or
activating a saved matrix. To continued the desired operation, the user must
acknowledge that prohibits between FCV Port cards are preserved.
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Status Line Messages

Messages may be displayed on the Status line during normal operation of the
Console. These messages are often informational only and usually occur without
operator action.  The messages are transient and are overwritten by subsequent
messages. The messages are cleared by normal keystrokes and double-clicking
the mouse anywhere on the matrix window. Notification messages do not require
any response action.

The following messages can be found in the Status line of a Director:

Activation of configuration failed.  - The current configuration could not be
activated on the Director. This notification should have been accompanied by
an error dialog box indicating the reason for the failure.

Address self-intersection. Prohibited or dedicated connections are not
Allowed. - An attempt was made to set a prohibited or dedicated connection
on the matrix at the intersection location of an address with itself.

Allow/Prohibit attribute copy complete. - Notification that the allowed/
prohibited data currently in the copy/paste buffer has been successfully pasted
to the currently selected row.

Allow/Prohibit attributes for current address copied to buffer. - Notification
that the allowed/prohibited data for the currently selected row has been
successfully copied to the copy/paste buffer.

Cannot activate configuration with dedicated connection to uninstalled
or unaddressable port. - On a saved or a new matrix, dedicated connections
can be set for any port address intersection, allowing pre-install configurations.
However, if a Director port is uninstalled or unaddressable, this message
appears warning that the configuration will not be activated.  Refer to status
columns to determine uninstalled or unaddressable ports.

Configuration saved.  - Notification that Save Configuration Matrix or Save
Configuration Matrix As option completed successfully.

Director data has changed. Some pending changes may have been
deleted.  - The currently displayed active matrix configuration data has been
overwritten by changes from the host application.  Some changes you had
made on the displayed matrix may have been overwritten. Only the categories
(allowed/prohibited, dedicated, or blocked) that were changed by the host
application were changed on the matrix, so some of your changes may not
have been overwritten.  Changes not overwritten are still indicated by
highlighting.
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Director is fully operational. - Notification that the Director operational status
indicates the Director is fully functional with no errors indicated. This message
may be displayed when the Token Ring link is established between the Director
and the Console, and at any time that the Director operational status is checked.

Director status conditions are not current. - Director status could not be
obtained, usually because the link to the Director is not available or an error
has occurred in obtaining the status.

Director status is degraded! - The Director is not fully operational. This may
be only because a redundant component has failed, or it may be due to a more
serious failure.

Log file contents have changed. - While viewing a log file (log window), the
log contents have changed (since the last time the log was refreshed or first
displayed). Use the Refresh option on the File menu to display the log with the
latest information.

No Allow/Prohibit data in buffer for Paste operation. - An attempt was made
to Paste a line of allowed/prohibited data without first copying the data. Refer
to "Copy and Paste" on page 85.

Port/Address mapping has been changed. - The mapping of physical ports
to logical addresses has been changed on the Director by another user (usually
the host application).  The effect of this can usually be seen by the presence
of asterisks next to affected addresses in the address column on the left of the
matrix window.

Selected configuration data activated.  - Notification that Activate
Configuration Matrix option completed successfully.

The configuration matrix is not initialized with current Director data. F4
to re-read. - A link error between the Director and the Console Software has
prevented the display of current configuration data for the active matrix window.

The Director is offline.  - Notification that the Director has been set offline.
This message accompanies the change in the Director Status indicator on the
Status line.

The hardware status field was updated. - Changes to the hardware status
column have been made by the Director.  You may wish to review the new
status for all ports.
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The mode register has been changed.  - Changes have been made by
another user (usually the host application) to the Director mode register. This
may be the Active = Saved, Remote Offline Control, or User Alert modes. The
current state of the first two modes is seen by check marks on these options
from the Utility menu. If the User Alert mode is set by the host, attempting to
activate a configuration displays a warning message.

Activation in progress... - The saved matrix is in the process of becoming the
current active matrix for this Director (activated).

Director is performing an IPL. - An IPL has been initialized for this Director.
The Director is not taken offline during this action.

File Logging Active.  - Terminal window status line message.  The Capture
command of the Terminal window File menu is active. This message remains
in the status line until the session ends or the Capture command is revoked.

Cannot set dedicated connection to converter port. - A user is not permitted
to establish a dedicated connection to a FICON port in the Active Matrix window.

Cannot activate configuration with dedicated connection to converter
port. - The user is warned that setting a dedicated connection to a FICON port
in the Saved Matrix window prevents the matrix from being activated.

Dynamic connections between converter ports are not permitted. - A user
may not directly alter the prohibit requirement between FICON ports in the
Active Matrix window.

Dynamic connections between converter ports are not permitted.
Operation successful on all other selected cells.  - Attempting to alter the
prohibit characteristic between FICON ports in the Active Matrix window
(through the Prohibit Range, Prohibit Row or Paste menu items) informs the
user that all selected prohibits may not have been removed.
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Error Messages During Director and Console Exchange

These messages may appear in abnormal circumstances during execution of a
command (such as activating a configuration). They appear in pop-up dialog boxes
if the command exchange between the Director and the Console fails.

Cannot activate a configuration containing a dedicated connection to an
uninstalled or unaddressable port.  - If a dedicated connection is set with
one address assigned to a Director port that is uninstalled or unaddressable,
the Active or Saved Matrix configuration is not activated. Check the hardware
status column for a NotInst  or Unaddr  condition for any dedicated
connections.

Could not access matrix configuration file.  - During a read or write of a
saved matrix configuration, the Console could not access the file. A secondary
message is displayed indicating the reason for the failure (such as a disk error,
or the Director rejected the command to read an IPL file).

The link is busy.  Try again later.  - The Console is currently busy with too
many other commands.  Allow traffic to diminish and try the command again.

The Director did not respond in the time allowed.  - A command was sent
to the Director, but no response was received within an acceptable time limit.
If the link is available to the Director (Link Status indicator is OK), try the
command again.

Director is in an allegiance condition. Would you like to reset allegiance?
- The Director has not responded to a command possibly because it is in
allegiance with a host user.  This only occurs if the Director is “stuck” in
allegiance with that user.  Select the Reset button to reset allegiance on the
Director, then retry the command.

The Director rejected the command. - The command exchange was
completed, but parameters in the command were not currently valid.  Verify
that configuration parameters (matrix attributes) are valid and try the command
again.  If the command continues to be rejected, record all steps taken that
cause the error and contact your support personnel.

Director is not responding. - Retry the operation; if it still fails call next level
of support.

The Director is busy.  Try again later.  - The Director is currently busy with
other commands.  Reissue the request in a few minutes.
Appendix A. Console Messages 201



Insufficient memory is available to access the Director. - Unable to allocate
sufficient memory to complete the Console operation.  Close other running
applications and reissue the command. If the problem persists, contact your
next level of support.

Insufficient buffers are available to access the Director. - The Console is
unable to allocate a buffer necessary for communication with the Director.
Close other running applications and reissue the command.  If the problem
persists, contact your next level of support.

The Director does not support the requested feature. - An unknown request
has been received by the Director.  Contact your next level of support.

The Director is in allegiance. - The Director has not responded to a command
possibly because it is in allegiance with a host user.  This only occurs if the
Director is stuck in allegiance with that user. Select the Reset button to reset
allegiance on the Director, then retry the command.

This unit is under host control.  Do you really want to activate? - This
message is displayed on the Console when trying to activate a configuration
when the host application has set the User Alert Mode (one of the mode register
controls) for the Director. It warns that configuration changes may be pending
from an operator on the host-based software.  The configuration can still be
activated on the Director by selecting the Activate button.

The link is unavailable. Try again when the link is restored. - The Director
has not responded to a command possibly because it is in allegiance with a
host user.  Try the command again.

Changes pending.  Retrieving the Active Matrix will overwrite changes
using the current configuration. - A Refresh command has been issued to
the Director with unsaved changes in the active matrix. Cancel the refresh and
save the changes to the active matrix and then retry the Refresh command.

Cannot activate a configuration containing a dedicated connection to a
converter port.  - A user is not allowed to activate an Active or Saved Matrix
containing an invalid dedication to a FICON port.

Cannot merge a configuration containing a dedicated connection to a
converter port. - A user is not allowed to merge a Saved Matrix containing a
dedicated connection to a FICON port.
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Enabled Operator is not authorized to break dedicated connection
between ports <port address 1>  and <port address 2> . - An enabled
operator must be authorized for both ports involved in a dedicated connection
to undedicate the ports.

ESCON diagnostics are unable to execute on a FICON (converter) port. -
It is invalid to attempt to execute ESCON diagnostics on an FCV Port card.

FICON port diagnostics are unable to complete. An error has occurred
processing a diagnostic request.  - Communications between the Console
and the FCV Port card on the Director is hindered.  The diagnostic is unable
to complete.  If possible, attempt to retry the diagnostic test.

Selected converter port address is invalid.  - The user entered an invalid
FCV Port card address while attempting to execute an online diagnostic test.

FICON port diagnostics are unable to execute on an inactive FCV card. -
Diagnostics are not supported on inactive FCV Port cards.

FICON port diagnostics are unable to execute on an FCV card requiring
service. - Diagnostics are not supported on FCV Port cards that are in service
required mode.
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Director Definition Dialog Messages

The following messages appear in pop-up dialog boxes when performing an
operation involving modification to the Director Definition.

This IP address is already used for Director <Directorname> . IPaddresses
must be unique.

Invalid IP address.  Address must be in the format “ nnn.nnn.nnn.nnn ,”
where nnn is a decimal byte in the range 0 through 255. All 0s or all 255s are
also not allowed.

Director name <Director name> already exists. Delete this Director, or use
a different name.

This modification will temporarily drop the link to the Director. Any open
windows for this Director will be closed.

This will delete the definition of the selected Director from the Console’s
library.  You will no longer be able to access this Director.
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Copy Matrix Messages

The following messages appear in dialog boxes when performing a copy matrix
operation.

Copy Matrix Configuration File operation successful.  - Informational
message; no response required.

Unable to copy to the destination path/file name. - Check the path and/or
file name, correct it, and retry.

The source path/file name is not valid.  - Check the path and/or file name,
correct it, and retry.

The destination path/file name is not valid. - Check the path and/or file name,
correct it, and retry.

The destination matrix name is not valid. - Check the path and/or file name,
correct it, and retry.

Unable to copy to the destination library.  - Disk error; call next level of
support.

Unable to copy to the destination IPL matrix because the destination
Director is not responding. - The link to the Director is either down or busy.
Check the link and retry the operation.

The FAF service is busy. Try again later.  - The link to the Director is either
down or busy. Check the link and retry the operation.

The destination matrix configuration file is locked. - The Host currently has
control of the file.  Wait and retry the operation.

The matrix configuration file is not compatible with the destination
Director model. - The matrix being copied is for the other model of Director.
Copy file to the correct Director model.

Insufficient memory is available to copy the matrix.  - Save any open
matrixes and close the Console application. Free up resource memory, restart
the Console application and retry the operation.

The content of the file is not a valid matrix configuration. - The source file
is damaged; call next level of support.
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The maximum number of matrix configuration files already exist for the
destination Director.  - Delete an existing matrix and retry the operation.

The file is not a matrix configuration file.  - Check the file name and retry.

Unable to copy from the source path/file name. - Check the path and/or file
name, correct it, and retry.  If the problem persists, call next level of support.

Unable to copy from the source library. - Check the path and/or file name,
correct it, and retry.  If the problem persists, call next level of support.

Unable to copy from the IPL matrix because the source Director is not
responding.  - The link to the Director is either down or busy. Check the link
and retry operation.

Unable to copy to open destination matrix. Please close destination
matrix and try again.  - Close the destination matrix and retry.
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Matrix Window File Access Messages

The following messages appear in pop-up dialog boxes when performing an
operation involving accessing matrix files.

The name cannot be CON, AUX, COMn (where n=1-4), LPTn
(where n=1-3), NUL, or PRN.  - Rename the file.

Changes pending.  Retrieving the Saved Matrix will overwrite changes
with the last configuration saved.  - Informational message; cancel or
continue with operation.

File key in use from previous command.  - Call next level of support.

Could not access Matrix configuration file.  - Call next level of support.

Disk error or invalid file data.  - Call next level of support.

Internal error.  - Call next level of support.

Director rejected IPL file request.  - Retry the operation; if it fails, call next
level of support.

Maximum number of files already in use.  Delete an unused item first.  -
Delete a matrix file and retry the operation.

File is already locked by another user.  - Retry the operation later.

No Directors are defined.  Add a ‘New Director’ from the ‘New
Configuration Matrix’ menu item under ‘File’. - Define a new Director.

Configuration name <name> already exists for this Director.  Replace
existing configuration?  - Cancel and rename matrix or continue with the
operation.

The Active = Saved mode is on for this Director.  The IPL file cannot be
saved in this mode.  - Retry operation with Active = Saved mode off.
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The link to the Director is busy. Try again later. - Cancel the operation and
retry later.

The selected configuration matrix will be deleted from the Console
Library.  - Informational message; no response required.

Configuration file has been updated since matrix was displayed. Saving
configuration will overwrite changes. - Informational message; no response
required.

Error during file transfer on FCV card. - The data collection procedure was
unable to retrieve a file from the FCV Port card.
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Port Authorization Messages

The following messages appear in dialog boxes when performing a port
authorization operation.

Operator ID must be between 301 and 330.  - This message appears if the
user enters and invalid operator ID in the Range dialog box in the port
authorization matrix.

Changes Pending. Changing the authorized operator will discard the
changes in the Active Matrix Window.  - This message appears if the user
selects the Edit menu Enable Operator option while there are pending changes in
the active matrix window.

Changes Pending. Changing the Port Authorization will discard the
changes in the Active Matrix Window.  - This message appears if the user
selects the Utility menu Port Authorization option while there are pending changes
in the active matrix window.

This function may only be performed by an Operator with authorization
to all ports.  - This message appears if the operator level password supplied
for certain operations does not correspond to a fully authorized operator. These
operations include activating a saved matrix, saving an active matrix, copying
a matrix, deleting a matrix, saving a saved matrix to a new name, and editing
a new matrix.

Enabled Operator is not authorized to remove a dedicated connection
from port <port address> . - This message appears if an operator is not
enabled and attempts to remove a dedicated connection between two
unauthorized ports at the Name and States dialog box.

Enabled Operator is not authorized to create a dedicated connection to
port <port address> . - This message appears if an operator is not enabled
and attempts to create a dedicated connection between two unauthorized ports
at the Name and States dialog box.

Cannot swap to uninstalled or unaddressable port. - It is invalid to swap to
an uninstalled or unaddressable port.

Converter ports may only be swapped with other converter ports.  - It is
invalid to attempt to swap a FICON port with an ESCON port.
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LIC Install Messages

The following messages appear in pop-up dialog boxes when installing Licensed
Internal Code (LIC).

The selected LIC version is not concurrent.  Continuing will cause all
converter ports to transmit offline.  - If converter ports can be set offline,
continue with the LIC install. If converter ports cannot be set offline, defer the
LIC install and notify the customer.

One or more converter ports are degraded.  Continuing will cause all
converter ports to transmit offline.  - If converter ports can be set offline,
continue with the LIC install. If converter ports cannot be set offline, defer the
LIC install until the degraded FCV port card can be removed and rep[laced,
and notify the customer.

The selected version may not be installed while FCV cards are present
in the Director. Remove all converter cards and retry LIC/LMA install. - It
is not permitted to downgrade LIC versions (from 5.x to 4.x) with FCV Port
cards installed in the Director.

The selected version does not support FICON operation.  Continuing
will result in the loss of Director FICON capabilities.  - Downgrading LIC
versions (from 5.x to 4.x) results in the loss of FICON-capable software for the
Director.
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Command List Error Messages

The Command List - Operational Status dialog box is created during execution of
the Command List option from the Edit menu, and provides operator feedback as
each command is applied to the active matrix for the selected Director. The dialog
box displays initialization strings, completion strings, and if applicable, error
messages.  If a command fails, it appears in the dialog box along with one of the
following error messages.

Notice - Ports out of range <port addresses>  - One or more of the port
addresses specified in the Range parameter for this command do not exist for
the Director.

Fail - Port(s) out of range <port addresses>  - One or more of the port
addresses specified for this command do not exist for the Director.

Notice - Operator <operator ID> is not authorized - The operator with this
identification is not authorized to change port attributes for one or more port
addresses specified in the Range parameter for this command.

Fail - Operator <operator ID>  is not authorized  - The operator with this
identification is not authorized to change port attributes for one or both port
addresses specified in this command.

Notice - Unmodifiable converter port attribute  - An Allow Range attribute
is not valid at the intersection of two converter ports.

Fail - Unmodifiable converter port attribute  - An Allow Port attribute is not
valid at the intersection of two converter ports.

Fail - Uninstalled/Unaddressable - A dedicated connection is not allowed to
uninstalled or unaddressable ports.

Fail - Operator <operator ID>  is not authorized to break dedicated
connection - The operator with this identification is not authorized to change
the Dedicate attribute for one or more of the port addresses specified in this
command.

Notice - Required break of dedicated connection  - An existing dedicated
connection was replaced during execution of this command.

Fail - Port name <port name> not unique  - The command was rejected
because the specified port name is being used by another port in the Director.
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Notice - Partial completion due to port attribute conflicts  - A merge of a
dedicated connection to an uninstalled port, a merge of a dedicated connection
to a converter port, or application of an Allow attribute to a converter port
intersection was attempted.

Fail - Port attribute violations - A merge of a matrix containing a change to
a pair of dedicated (or undedicated) ports was attempted by an operator with
an identification that is not authorized to change port attributes for one or more
port addresses specified.

Fail - File not found  - The indicated file does not exist.
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Alert Dialog with Error Code

An alert dialog box may occur in more severe error conditions on the Console. This
dialog displays an error code in the form nn:nnnn (where n is a decimal digit) and logs
the error in the Console error log.  If such an error occurs multiple times in the same
situation, copy down the error code for use by service personnel. The operation causing
the error is retried unless the message indicates a memory error or other major fault
condition.

If a memory error is indicated, exit the Console application, try to free up system
memory and resources (close other applications, etc.), and try the Console
application again.  If the error persists, perform the following:

1. Accurately document the following:

— The condition and steps used to cause the error (including previous
sequence of steps)

— The error codes that appear

— The full version level of the software (available from the Product
Information option from the Help menu).

2. Print or copy the Console error log and preserve it for use by service
personnel.

3. Contact your next level of support.

Alert dialog with error code messages are:

Insufficient memory for internal operation!

Insufficient memory for allocation.

Memory corruption detected!

Invalid internal parameter (possible memory corruption).

File read error.

File write error.

Error during print operation.

Could not establish link to Director.

Communications link internal error.
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Console Library internal error.

File Access Facility internal error.

User Interface internal error.

Could not initialize item.

Could not create window.

Could not create dialog box.

Could not create list box.

Could not read resource string.

Could not read selected item in list.

Could not select current list item.

Duplicate IP address activated.

Could not read Director data from library.  File access or memory error.

Could not create new Director definition to add to library.

Could not rename Director in Library.

Could not delete Director definition from library.

Could not update Director definition data in library.

Could not convert IP address.

Error loading list from resources.

File Transfer internal error.

The LIC Library is corrupted.

Error writing Matrix Option item to DCONSOLE.INI file.
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Error writing Load Director item to DCONSOLE.INI file.

File open error.

Invalid path name.

TCP/IP kernel is inaccessible.  No links will be activated.

Director library is unreadable!  Partial restore from backup may be
required.

LICA library is unreadable! Partial restore from backup may be required.

Passwords are unreadable!  Contact your next level of support.

Director library has been corrupted! Restore from backup required. Call
your next level of support.

An incident of the console application is already open.

Exchange Service internal error.

Console Library is not compatible with this version of the Console.

The LMA Library is corrupted.

LMA library is unreadable! Partial restore from backup may be required.

Data Collection internal error.
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Miscellaneous Messages

Miscellaneous messages are:

Only <number>  characters allowed in field.

Could not read selected item in list.

Could not select current list item.

Password not accepted.  Try again.

Matrix window is open for <Director name>  with changes pending.  Close
window and discard changes?

Password is already in use for <Director name> . Enter a different password.

Invalid number of arguments entered!

Link operation in progress.  Closing window will abort operation.

Invalid time!

Invalid date!

The part number file is invalid.

Please Insert the disk labeled <label> . If the files on this disk can be found
at a different location, for example, on another drive, type a new path below.

All ports will transmit offline sequences before Director power is cycled.
Power cycle performs a cold start, resetting all Director cards and
activating the IPL configuration when complete.

Delete selected password from this level?

WARNING: Deleting the last password will remove password protection
from this level!
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All ports will transmit offline sequences, placing the Director in an offline
state. To restore normal operation, IPL or IML the Director, or cycle the
Director’s power.

This will close all windows and exit the Console application.

Existing configuration files will be converted for the new model selected.

The Director will reset the CTP (including CUP) and token ring.  The
Director will then reload the current LIC version. The active configuration
remains intact and switching operations continue.
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Glossary

This glossary includes terms and definitions
from:

• The IBM Dictionary of Computing
(ZC20-1699).

• The American National Standard
Dictionary for Information Systems
(ANSI X3.172-1990), copyright 1990 by
the American National Standards Institute
(ANSI).  Copies can be purchased from
the American National Standards
Institute,1430 Broadway, New York, New
York 10018.  Definitions from this text are
identified by the symbol (A).

• ANSI/EIA Standard - 440A: Fiber Optic
Terminology, copyright 1989 by the
Electronic Industries Association (EIA).
Copies can be purchased from the
Electronic Industries Association, 2001
Pennsylvania Avenue N.W., Washington,
D.C. 20006.  Definitions from this text are
identified by the symbol (E).

• The Information Technology Vocabulary,
developed by Subcommittee 1 (SC1),
Joint Technical Committee 1 (JTC1), of
the International Organization for Stan-
dardization (ISO) and the International
Electrotechnical Commission (IEC).
Definitions of published parts of this
vocabulary are identified by the symbol (I).
Definitions taken from draft international
standards, committee drafts, and working
papers developed by ISO/IEC SC1/JTC1
are identified by the symbol (T), indicating
that final agreement has not been reached
among the participating national bodies of
SC1.

The following cross references are used in
this glossary:

Contrast with  - Refers to a term with an
opposite or substantively different
meaning.

See - Refers the reader to multiple-word
terms in which this term appears.

See also - Refers the reader to terms with a
related, but not synonymous, meaning.

Synonym for  - Indicates the term has the
same meaning as a preferred term defined
in the glossary.
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A

ac. See alternating current.  Contrast with dc.

accelerator.   A short-cut keystroke method to
perform a menu operation. Menu options may
have accelerator keys listed to the right of the
menu option.  Use the listed accelerator to
perform the menu option’s function when no
menu is selected for the window.

active configuration.   In an ESCON or
FICON environment, the Director configuration
that is determined by the status of the
connectivity attributes.  Contrast with saved
configuration.

adapter.   (1) Hardware that provides
transitional functions between multiple
devices.  (2) In a fiber-optic environment, the
link hardware used to join different optical fiber
connector types.  Contrast with coupler.

address. (1) To refer to a device or an item of
data by its address (I, A). (2) The location in a
computer where data is stored.  (3) In data
communication, the unique code assigned to
each device or workstation connected to a
network.  (4) The identifier of a location,
source, or destination.

address name.  See port name.

address resolution protocol (ARP). The
protocol by which a host computer maintains a
cache of address translations, allowing the
physical address of the computer to be derived
from the Internet address.

administrative password authorization.
The level-one password authorization that
allows access to a Director to perform
administrative, maintenance, and operator
functions.  Contrast with maintenance
password authorization and operator
password authorization.

allowed connection.   In a Director, the
attribute that when set, establishes dynamic
connectivity capability.  Contrast with
prohibited connection.

alternating current (ac).  Electric current
that reverses direction at regular sinusoidal
intervals.  Contrast with direct current.

American National Standard Code for
Information Interchange (ASCII). A standard
character set consisting of 7-bit coded
characters (8-bit including parity check) used
for information exchange between systems
and equipment.

American National Standards Institute
(ANSI).  A national organization consisting of
producers, consumers, and general interest
groups that establishes procedures by which
accredited organizations create and maintain
industry standards in the United States (A).

ANSI. See American National Standards
Institute.

AOC/MVS. See Automated Operations
Control for MVS.

application.   (1) The use to which a data
processing system is put, for example, a
payroll application, an airline reservation
application, or a network application.  (2) A
collection of software components used to
perform specific types of work on a computer.

application-specific integrated circuit
(ASIC).  A circuit designed for a specific
application or purpose, such as implementing
the lower-layer Fibre Channel protocol (FC-0).
ASICs differ from general-purpose devices
such as memory chips or microprocessors.

AR. IBM parts list acronym for As Required.
AR indicates the parts quantity is not the same
for all machines.

ARP. See address resolution protocol.
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ASCII. See American National Standard
Code for Information Interchange.

ASIC. See application-specific integrated
circuit.

attribute. The connection status of the
address on a configuration matrix; allowed,
blocked, dedicated, or prohibited.

Automated Operations Control for MVS
(AOC/MVS).  An IBM-licensed program that
automates routine processor management
tasks, including, shutdown, recovery, startup,
and initialization procedures, and automates
operator responses to messages.  AOC/MVS
functions are now integrated into SA OS/390.

B

backup diskette.   A diskette that contains
duplicate information from an original
diskette.  The backup diskette is used in
case information on the original diskette is
unintentionally changed or destroyed.

bit. Acronym for binary digit, the smallest unit
of data in computing, with a value of zero or
one.  Abbreviated as lowercase b.

blocked. In a Director, the attribute that when
set, removes the communication capability of a
specific port.  Contrast with unblocked.

bridge. (1) An attaching device that connects
two LAN segments to allow the transfer of
information from one LAN segment to the
other.  A bridge can connect the LAN
segments directly by network adapters and
software in a single device, or can connect
network adapters in two devices through
software and use of a telecommunication link
between the two adapters.

(2) A functional unit that connects two LANs
that use the same logical link control protocol,
but may use different media access control
protocols (T). Contrast with router.

British Thermal Unit (BTU).   The quantity of
heat required to raise the temperature of one
pound of water by one degree Fahrenheit.

BTU.  See British Thermal Unit.

button. On a graphical user interface, a virtual
display element (a rectangle containing text)
that is selected with an input device and
programmed to operate as a function key (T).

byte. An 8-bit quantity that computers treat as
a single unit, often called an octet or word.
Abbreviated as uppercase B.  See also octet.

C

cascade.   Windows on a console cascade to
show all open windows in a way that allows
any window to be viewed by clicking its title
(window is brought to the front).  Cascaded
windows are overlapped.  To cascade
windows, use the Window pull-down menu
and select Cascade.  Contrast with Tile.

CBY. Acronym for channel operations running
in byte mode (ESCON channel attached to
ESCON converter), and specifies the I/O
operation mode for the channel path under the
IOCP CHPID statement Type parameter.
Contrast with CVC.

CD-ROM.  See compact disk read-only
memory.

cell.   On the Director matrix window, a cell is
the intersection point between a horizontal
port address and a vertical port address.  A
selected cell is indicated by the cell cursor.
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cell cursor.  A white square on the Director’s
matrix window indicating the selected
intersection cell.  Attribute modifications that
require two port addresses, such as prohibit or
dedicate, are performed on the selected cell.

chained.   In an ESCON environment, means
that two Directors are physically attached.

channel.   A system element that controls one
channel path, and whose mode of operation
depends on the type of hardware attached.
Each channel controls an I/O interface
between the channel control element and the
attached control units.

channel-attached.   (1) Pertaining to direct
attachment of devices by data I/O channels to
a computer. (2) Pertaining to devices attached
to a control unit by cables, not telecommunica-
tion lines.

channel path (CHP).   A single interface
between a central processor and one or more
control units, along which signals and data is
sent to perform I/O requests.

channel path identifier (CHPID).   In a
channel subsystem, a value assigned to each
channel path of the system that uniquely
identifies the path.

channel subsystem (CSS).   A collection of
subchannels that direct the flow of information
between I/O devices and main storage, relieve
the processor of communication tasks, and
perform path management functions.

CHP.  See channel path.

CHPID.  See channel path identifier.

Class 3 Fibre Channel service.  Class 3
service duplicates the functions of a packet-
switched network and allows multiple nodes to
share links by multiplexing transmitted data.
Class 3 service does not acknowledge data

frame delivery.  Class 3 service is supported
by the 9032-005 Director.

CNC. Acronym for ESCON channel-attached
to ESCON-capable device, and specifies the
I/O operation mode for the channel path under
the IOCP CHPID statement Type parameter.

column.   Vertical arrangement of data.
Contrast with row.

command.   (1) A character string from an
external source to a system that represents a
request for system action.  (2) A request from
a terminal to perform an operation or execute a
program.  (3) A value sent through an I/O
interface from a channel to a control unit that
specifies the operation to be performed.

compact disk read-only memory (CD-ROM).
High capacity read-only memory in the form of
an optically read disk.

component.   (1) Hardware or software that is
part of a functional unit.  (2) A functional part
of an operating system; for example, the
scheduler or supervisor.

concurrent maintenance.   The ability to
perform maintenance tasks, such as the
removal and replacement of FRUs, while the
Director is operating.  In addition, fiber-optic
cables can be connected or disconnected from
ports while the Director is operating. See also
hot pluggable and nondisruptive installation.

configuration matrix.  A configuration matrix
defines a Director’s address configuration.
The three matrix types are new matrix, saved
matrix, and active matrix.  Synonym for matrix.

connectivity attribute. The characteristic that
determines port status for the Director.  See
allowed connection, dedicated connection,
prohibited connection, blocked, and
unblocked.
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connectivity capability.   (1) The capability
that allows attachment of a device to a system
without requiring physical reconfiguration of
either the device or the interconnections.
(2) The Director capability that allows logical
manipulation of link connections to provide
physical device attachment.  See also
configuration matrix, connectivity control,
and dynamic connection.

connectivity control.   In a Director, the
method used to change port connectivity
attributes and determine the communication
capability of the link attached to the port.

connector.   See optical fiber connector.

Console. The Director device used to perform
administrative, maintenance, and operations
tasks.  Synonym for display device or terminal.

Console Audit log.   A log that tracks and
records Director Console operator activities,
including changing passwords, adding or
deleting LIC versions, adding or deleting
Director definitions, and entering or exiting the
application.  Each log entry contains a
description of the action, an action identifier,
and the date and time the action occurred.

Console Error log.   A log of abnormal errors
that were encountered by the Director Console
software during operations, but did not cause
Console failure.  For example, errors caused
by insufficient PC memory are logged.

Console library.   An information database for
the Director, maintained by the Console
application.  The library is stored on the PC
platform running the Console application, and
contains logs, LIC versions, and saved
configurations.

Control Processor (CTP) card.   In the
Director, the circuit card that provides the
processor and associated logic.  The card

initializes hardware after power on.  While in
operation, the card supports the switch CUP,
maintenance port, and operator panel, and
supports port exception handling and error
recovery.  It also contains the fiber channel
controller for I/O requirements.

control program.   A computer program that
schedules and supervises execution of
programs in a computer system (I).

control unit. Hardware that controls the read-
ing, writing, or display of data at one or more
I/O units.

Control Unit Port (CUP). An internal Director
port (on the CTP card and labelled FE) that
communicates with channels to report error
conditions and link initialization.

converter.   In an ESCON environment, a
device that allows attachment of parallel
channel (bus and tag) I/O control units to
ESCON channels.

coupler.  In a fiber-optic environment, the link
hardware used to join optical fiber connectors
of the same type.  Contrast with adapter.

CSS.  See channel subsystem.

CTC.  Acronym for an ESCON channel
attached to another ESCON channel (channel-
to-channel), and specifies the I/O mode of
operation for the channel path under the IOCP
CHPID statement Type parameter.

CTP.  See Control Processor card.

CUP.  See Control Unit Port.

CVC. Acronym for channel operations running
in block mode (ESCON channel attached to
ESCON converter), and specifies the I/O
operation mode for the channel path under the
IOCP CHPID statement Type parameter.
Contrast with CBY.
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D

DASD.  See direct access storage device.

dB. See decibel.

dBm. Decibels referenced to one milliwatt.
Zero dBm equals one milliwatt, with a
logarithmic relationship as the value increases.

dc. See direct current.  Contrast with ac.

DCAF. Acronym for IBM-licensed Distributed
Console Access Facility software. Through
DCAF, the Director Console is accessed and
controlled by a remote PC.

decibel (dB). A standard unit used to express
gain or loss of optical power, expressed as the
ratio of input power to output power on a
logarithmic basis.

dedicated connection.  A connection
between two Director ports not affected by
information in the transmission frames.  The
connection restricts those ports from
communicating with any other port, and can
be established only as a result of actions
performed by a host control program or at the
Director Console. Contrast with dynamic
connection.

default.   Pertaining to an attribute, value, or
option assumed by a system when none is
specified (I).

destination.   A point or location, such as a
processor, Director, or Console, to which data
is transmitted.

device.   Mechanical, electrical, or electronic
hardware with a specific purpose.

device number. In a channel subsystem, four
hexadecimal digits that uniquely identify an I/O
device.

device port (DVP) card.   The Director’s
hardware interface for ESCON fiber-optic
media.  Each port card contains either LED or
XDF laser port interfaces.  See also port card.

dialog box.   A pop-up window on a console
with information messages or fields to be
modified or completed with desired options.

diagnostics.   (1) The process of investigating
the cause or nature of a problem in a product
or system.  (2) Modules or tests used by
computer users and service personnel to
diagnose hardware problems.

direct access storage device (DASD).   A
storage device that provides direct access to
data, and in which access time is independent
of data location.

direct current (dc).  Electric current that
continuously flows in one direction.  Contrast
with alternating current.

Director.   A device that provides dynamic
switching of fiber-optic connections between
ESCON channel paths and control units, and
FICON channel paths and ESCON control
units.  The Director also extends the
operational distance between processors
(ESCON or FICON) and ESCON control units.

Director Audit log.   A log containing
summaries of actions taken by the Console
operator or the host-based software, recording
an audit trail of changes affecting the
Director.  For example, prohibiting or dedicat-
ing an address intersection is recorded (with
the date and time).

Director Event log.   A log of abnormal
hardware or software incidents that are
reported by the Director during operations.
For example, a CTP card failure is logged as a
hardware incident. A corrupt configuration file
is logged as a software incident.
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Director LIN log.   A log of abnormal link
incidents reported by the Director during
operations.  For example, a loss of synchroni-
zation condition or a bit error rate threshold
exceeded condition is reported as a link
incident.

disconnected. In a Director, the attribute that
when set, disables a dedicated connection.
Contrast with connected.

diskette.   A thin magnetic disk enclosed in a
plastic jacket, which is removable from a
computer and is used to store and transport
data.

diskette drive.   The hardware mechanism by
which a computer reads data from and writes
data to removable diskettes.

display device.   A computer peripheral that
presents information on a screen. A synonym
for Console or terminal.

distribution panel.   In an ESCON environ-
ment, a panel that provides a central location
to attach trunk and jumper cables, and is
mounted in a rack, wiring closet, or on a wall.

DRAM. See dynamic random access
memory. See also RAM and contrast with
SRAM.

duplex.   In data communication, pertaining to
transmission in which data is sent and
received at the same time.  Contrast with
half-duplex and simplex.

duplex connector.   An optical fiber
component that terminates jumper cable fibers
in one housing and provides physical keying
for attachment to a duplex receptacle.  See
also Fibre Channel Standard connector,
multimode connector, and subscriber
connector.

duplex receptacle.   A fixed or stationary
optical fiber component that provides a keyed
attachment method for a duplex connector.

DVP card.   See device port card.

dynamic connection.   In a Director, a
connection between two ports established by
the Director that appears as one continuous
link when active. The duration of the connec-
tion depends on the protocol defined for the
frames transmitted and on the state of the
ports.  Contrast with dedicated connection.

dynamic connectivity.  The Director
capability that allows connections to be
enabled or disabled at any time.

dynamic random access memory (DRAM).
Random access memory that resides in a cell
comprised of a capacitor and transistor.
DRAM data deteriorates (i.e. is dynamic)
unless the capacitor is periodically recharged
by the controlling microprocessor.  DRAM is
slow, but relatively inexpensive.  See random
access memory and contrast with static
random access memory.

E

EAF. See enhanced availability feature.

EBCDIC. See extended binary-coded decimal
interchange code.

EC. See engineering change.

EIA.  See Electronic Industries Association.
See also TIA.

electromagnetic interference (EMI).   Refers
to undesirable electromagnetic emissions
generated by solar activity, lightning, and
electronic devices.  The emissions interfere
with or degrade the performance of another
electronic device.

Electronic Industries Association (EIA).
The governing body that publishes
recommended standards for physical devices
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and associated interfaces.  For example,
RS-232 is the EIA standard that defines
computer serial port connectivity.  See also
TIA.

electrostatic discharge (ESD).   The undesir-
able discharge of static electricity that can
damage or degrade electronic circuitry.

ELP.  See establish logical path.

EMI.  See electromagnetic interference.

engineering change (EC).   A change to the
design, construction, or operation of a
hardware or software system that improves the
operation, reliability, or serviceability of the
system.  The EC process involves submission
of a formal proposal that is reviewed and
authorized.  Implementation of an authorized
EC is carefully tracked and controlled.

Enhanced Availability Feature (EAF).
Enhanced availability features are backup
FRUs that are ordered and installed in the
Director to provide redundancy and reduce
disruption in case of failure.

Enterprise Systems Architecture (ESA).   A
computer architecture introduced by IBM in
1988 as ESA/370.  The architecture added
access registers to improve virtual memory
management and increase storage from 2
gigabytes to 16 terabytes.  The architecture
was enhanced with the introduction of
ESA/390 in 1990.

Enterprise Systems Connection (ESCON).
An IBM architecture, technology, and set of
products and services introduced in 1990 that
provides a dynamically connected
environment using fiber-optic cables as the
data transmission medium.

erase.   To remove electrically or magnetically
stored data, leaving the space where the data
was stored unoccupied.

EREP. Acronym for IBM’s Environmental
Record Editing and Printing software. Through
EREP, data contained in a system recorder file
is made available for maintenance analysis.

error message.   An indication an error is
detected.  See also information message and
warning message.

ESA.  See Enterprise Systems Architecture.

ESCON.  See Enterprise Systems
Connection.

ESCON channel.   A data communications
channel that uses ESCON technology with
fiber-optic cables as the transmission medium,
rather than copper bus and tag cables.
Contrast with FICON channel and parallel
channel.

ESCON Converter.   See converter.

ESCON Manager.   An IBM-licensed program
that provides host control and intersystem
communication with the Director connectivity
operations.  ESCON Manager was discontin-
ued in 1998 and its functions are now
integrated into SA OS/390.

ESD.  See electrostatic discharge.

establish logical path (ELP) .  An ESCON
protocol command issued from host to
establish a connection between host and port
or between two ports on a Director.  The
command frame contains a destination and
source address.

event code. A multi-digit code that displays at
the operator panel or Director Event log.  The
code is used by maintenance personnel to
determine corrective actions to be taken.

extended binary-coded decimal inter-
change code (EBCDIC).  A coded character
set comprised of 256 8-bit characters.
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Extended Distance Feature (XDF). A means
to extend the propagation distance of a fiber-
optic signal.  Essentially a singlemode laser
ESCON port.

F

fabric.   A network of one or more switch
elements that can transmit, route, and receive
data using the Fibre Channel protocol.  A
fabric can support multiple, concurrent Fibre
Channel connections.

fabric port (F_port).  A port on a switch to
which N_ports are directly connected.
Contrast with node port.  See also thin fabric
port.

FC-0.  The Fibre Channel layer that describes
the physical link between two ports, including
the transmission media, transmitter and
receiver circuitry, and interfaces.

FC-1.  The Fibre Channel layer that describes
the IBM-patented 8B/10B transmission code
that provides DC balance in the transmitted bit
stream, separates control bytes from data
bytes (for simplification), and detects transmit
and receive errors.

FC-2.  The Fibre Channel layer that specifies
the signaling protocol, rules, and mechanisms
required to transfer data blocks.  The FC-2
layer is very complex, and provides different
classes of service, packetization, sequencing,
error detection, segmentation, and reassembly
of transmitted data.

FC-3. The Fibre Channel layer that provides a
set of services common across multiple
N_ports of a Fibre Channel node.  The
services are not commonly used and are
essentially reserved for Fibre Channel
architecture expansion.

FC-4.  The Fibre Channel layer that provides
mapping of Fibre Channel capabilities to upper
level protocols, including IP and SCSI.

FC-PH.  See Fibre Channel Physical and
Signaling Interface.

FCS.  See Fibre Channel Standard.

FCS Connector. See Fibre Channel Standard
connector.

FCV. (1) Acronym for Fibre Channel Converter
port card, the Director’s hardware interface for
FICON fiber-optic media. See also port card.
(2) Acronym for FICON channel-attached
converted to ESCON-capable device, and
specifies the I/O operation mode for the
channel path (using an FCV port card) under
the IOCP CHPID statement Type parameter.

feature.   A part of an IBM-licensed product
that may be ordered separately or as an option
by the customer.

fiber.   See optical fiber.

fiber-optic cable.   See optical cable.

fiber optics . The branch of optical technology
concerned with the transmission of radiant
power through fibers of transparent materials
such as glass, fused silica, or plastic (E).
Telecommunication applications of fiber
optics use optical fibers.  A single fiber or a
nonspatially aligned fiber bundle is used for
each information channel.  Such fibers are
often called optical fibers to differentiate them
from fibers that are used in noncommunication
applications.

Fiber Transport Services (FTS). An IBM
service that provides installation of fiber-optic
cable trunk lines and strategically-located
distribution panels in a data center.  Optically-
connected equipment can then be installed
with either short jumper cables, harnesses, or
factory-terminated trunk cables.
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Fibre Channel Converter (FCV) port card.
The Director’s hardware interface for FICON
fiber-optic media.  See also port card.

Fibre Channel Standard (FCS). ANSI
standard that provides a common, efficient
data transport system that supports multiple
protocols.  The architecture integrates both
channel and network technologies, and
provides active, intelligent interconnection
among devices.  All data transmission is
isolated from the control protocol, allowing use
of point-to-point, arbitrated loop, or switched
fabric topologies to meet the needs of an
application.

Fibre Channel Standard (FCS) connector.
A connector that terminates fiber-optic jumper
cables in a pair of connected housings (one
transmit and one receive), and provides
physical keying for attachment to an SC
receptacle. An FCS connector is synonymous
with an SC connector. An FCS connector can
attach to an FCV port card or XDF Laser port
card.  See also multimode connector and
subscriber connector.

Fibre Channel Physical and Signaling
Interface (FC-PH). The ANSI document that
specifies the FC-0 (physical signaling), FC-1
(data encoding), and FC-2 (frame construct)
layers of the Fibre Channel protocol.

Fibre Connection (FICON).   An IBM set of
products and services introduced in 1999 that
is based on the Fibre Channel Standard.
FICON technology uses fiber-optic cables
as the data transmission medium, and signifi-
cantly improves I/O performance (including
one Gbps bidirectional data transfer).  FICON
is designed to coexist with ESCON channels,
and FICON-to-ESCON control unit
connections are supported.

FICON.  See Fibre Connection.

FICON channel.   A data communications
channel that uses FICON technology (rather

than ESCON technology) with fiber-optic
cables as the transmission medium.  Contrast
with ESCON channel and parallel channel.

Field Replaceable Unit (FRU). An assembly
that is removed and replaced in its entirety
when any one of its components fails.  A logic
card is an example of a FRU.

FLASH memory.  Reusable nonvolatile
memory that is organized as segments for
writing, and bytes or words for reading.
FLASH memory is faster than read-only
memory, but slower than random access
memory.

FLOGI.  Acronym for the fabric login
command.  The command establishes the
initial operating parameters and topology for a
fabric.  The command is accepted by an
F_port or thin F_port.

F_port. See fabric port. See also thin F_port.

FRU.  See Field Replaceable Unit.

FTS.  See Fiber Transport Services.

G

GB.  See gigabyte.

Gbps.   Acronym for gigabits per second.

GHz.  See gigahertz.

gigabyte (GB).   A unit of measure for data
storage, equal to 1,073,741, 824 bytes.
Generally approximated as one billion bytes.

gigahertz (GHz).   One billion cycles per
second (hertz).

GND. Acronym for ground (e.g. that portion of
a conducting circuit connected to the earth).

graphic display.  The Director’s configuration
matrix may be displayed in a graphic mode on
the Console. This mode shows all connection
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types as unique graphic symbols in the matrix
region of the window.  When graphic display
mode is disabled, only prohibited connections
are displayed.

graphical user interface (GUI).  A GUI is a
visually oriented interface where the user
interacts with representations of real-world
objects displayed on the computer screen.
Interactions with such objects produce actions
that are intuitive to the user.

GUI.  See graphical user interface.

H

half-duplex. In data communication, pertain-
ing to transmission in only one direction at a
time.  Contrast with duplex, synonym for
simplex.

hardware.   Physical equipment (Director or
Console) as opposed to computer programs,
procedures, rules, and associated
documentation.  Contrast with software.

Hardware Audit log.   A log that records all
configuration changes for Director FRUs.
Each entry contains a FRU name, position,
status, part number, serial number, and date
and time a change was detected.

Hardware Configuration Definition (HCD).
A program that defines all available I/O
devices and channel paths to a processor
system and the MVS operating system.  This
program replaced the Input Output Configura-
tion and MVS Configuration Programs starting
with MVS/ESA Version 4.0.

hardware information block (HIB).   A Direc-
tor status register that defines if a port is
installed, has a dynamic connection, has a link
failure, is blocked, or is offline.  The MXC

reads the register in response for connection
requests to the port.

HCD.  See Hardware Configuration Definition.

Hertz (Hz).   A unit of frequency equal to one
cycle per second.

hexadecimal. A numbering system with base
of sixteen; valid numbers use the numbers 0
through 9 and characters A through F, where A
represents 10 and F represents 15.

HIB.  See hardware information block.

host-based software.  Pertains to ESCON
Manager, the software used in configuring and
managing multiple Directors on the network.

host processor. (1) A processor that controls
all or part of a user application network (T).
(2) In a network, the processing unit in which
resides the access method for the network.

hot pluggable.   Pertains to a FRU that is
removed and replaced from a device while the
device is powered on and operational.  See
also concurrent maintenance and nondisrup-
tive installation.

Hz.  See Hertz.

I

ID.  See identifier.

identifier (ID).   (1) One or more characters
used to identify or name a data element and
possibly to indicate certain properties of that
data element (T).  (2) A sequence of bits or
characters that identifies a program, device, or
system to another program, device, or system.

(3) A user-defined symbolic name of 24
characters or less that identifies a Director.
See also password identifier and port name.
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IEEE.  See Institute of Electrical and
Electronics Engineers.

IML.  See Initial Machine Load.

information message.   A message informing
a user that a function is performing normally or
has completed normally.  User acknowledg-
ment may not be required, depending on the
message.  See also error message and
warning message.

Initial Machine Load (IML).   Process of
loading the operating system and applications
software from secondary storage to a central
processor after machine power-on.  Some-
times referred to as booting the machine.

Initial Program Load (IPL).   (1) Initialization
procedure causing an operating system to
commence operation.  (2) Process by which a
configuration image is loaded into storage at
the beginning of a work day or after a system
malfunction.  (3) Process of loading system
programs and preparing a system to run jobs.

Initial Program Load (IPL) file.   Information
stored in Director’s nonvolatile memory that
contains default connection configurations.
The Director loads the file for operation when
powered on.  The file can be modified or
another file can be specified as the IPL file.

input/output (I/O).  (1) Pertaining to a device
whose parts can perform an input process
and an output process at the same time (I).
(2) Pertaining to a functional unit or channel
involved in an input process, output process,
or both, concurrently or not, and to the data
involved in such a process.  (3) Pertaining to
input, output, or both.

input/output configuration.   A collection of
channel paths, control units, and I/O devices
that attaches to a processor.

input/output configuration data set
(IOCDS).  A data set that contains an I/O
configuration definition built by the IOCP.

Input/Output Configuration Program
(IOCP).  A program that defines all available
I/O devices and channel paths to a processor
system. Replaced by the Hardware Configura-
tion Definition Program starting with MVS/ESA
Version 4.0.

input/output controller (IOC).  A functional
unit in a data processing system that controls
one or more devices or units of peripheral
equipment.

Institute of Electrical and Electronics
Engineers (IEEE).   A technical professional
society that promotes the development and
application of electrotechnology and allied
sciences.

interface.  (1) A shared boundary between
two functional units, defined by functional,
signal, or other characteristics.  The concept
includes the specification of the connection of
two devices having different functions (T). (2)
Hardware, software, or both, that link systems,
programs, or devices.

Internet Protocol (IP).  Network layer for the
TCP/IP protocol used on Ethernet networks.
IP provides packet routing, fragmentation, and
reassembly through the data link layer.

I/O.  See input/output.

IOC.  See input/output controller.

IOCDS.  See input/output configuration data
set.

IOCP.  See Input/Output Configuration
Program.

IP.  See Internet Protocol.
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IP address.   A unique string of numbers that
identifies a device on the Internet.  The
address consists of four groups of numbers
delimited by periods (dotted quad).  All
resources on the Internet must have an IP
address.

IPL.  See Initial Program Load.

ISA.  See Industry Standard Architecture.

ITE.  Acronym for Information Technology
Equipment.

J

jack.   A hardware-connecting device to which
the wire or wires of a circuit are attached, and
that is arranged for the insertion of a plug.

jumper cable.   In a fiber-optic environment, a
cable having two conductors that provide a
physical connection between two devices, or
between a device and a distribution panel.
Contrast with trunk cable.

K

kB.   See kilobyte.

kilobyte (kB).   A unit of measure for data
storage, equal to 1,024 bytes.  Generally
approximated as one thousand bytes.

L

LAN.   See Local Area Network.

LAN Adapter Installation and Diagnostics
(LANAID).   An IBM-licensed installation tool
providing a graphical and command-line inter-
face for manual installation and configuration
of a Token Ring LAN or LAN devices.

LAN Adapter and Protocol Support (LAPS).
IBM - licensed software that manages and
controls network adapter cards in a device,
including the device drivers for those cards as
well as the protocols that are used to commu-
nicate with other devices on the network.

LANAID.   See LAN Adapter Installation and
Diagnostics.

LAPS.   See LAN Adapter and Protocol
Support.

laser.   Acronym for Light Amplification by
Stimulated Emission of Radiation.  A device
that produces optical radiation using a popula-
tion inversion to provide amplification and an
optical resonant cavity to provide positive
feedback.  Laser radiation is highly coherent
temporally, or spatially, or both (E).

LCD.  See liquid crystal display.

LED.  See light-emitting diode.

LIC.  See Licensed Internal Code.

Licensed Internal Code (LIC).   Software
provided for use on IBM machines and
licensed to customers under the terms of lBM’s
customer agreement.

light-emitting diode (LED). A semiconductor
chip that emits visible or infrared light when
activated.  Often used as an indicator light on
computer hardware.

LIN.  See link incident.

link. In a fiber-optic environment, the physical
connection and transmission medium between
an optical transmitter and receiver.  A link con-
sists of two conductors, one used for sending
and the other for receiving, thereby providing a
duplex communication path.
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link address.  In an ESCON environment, an
address assigned at initialization that identifies
a channel or control unit and allows it to send
and receive transmission frames and perform
I/O operations.  See also port address.

link incident. A failure associated with a link,
rather than a hardware or software failure
associated with the Director. Examples of link
incidents include an invalid sequence,
sequence timeout, bit error rate threshold
exceeded, loss of signal or synchronization,
or a not-operational sequence recognized.

LMA Code.   See Loader/Monitor Area Code.

Loader/Monitor Area (LMA) Code .  Code
that resides in the loader/monitor area of the
CTP card, and provides input/output functions
(through a maintenance port, operator panel,
or Console), terminal window command
functions, power-on diagnostics, FRU power-
on hours, data read/write control, and LMA/LIC
download functions.

local .  Synonym for channel-attached.

Local Area Network (LAN).   A computer
network in a localized geographical area (e.g.
a building or campus), and whose communica-
tions technology provides a high-bandwidth
medium to which many nodes are connected.

log.   (1) To record or print all messages on a
system printer.  (2) A record or compilation of
system events that have occurred.

logical partition (LPAR).   A processor hard-
ware subset defined to support the operation
of a system control program, and can be used
without affecting any of the applications in
another partition.

logical switch number (LSN).   A two-digit
number used by the IOCP to identify a
Director.

LPAR.   See logical partition.

LSN.  See logical switch number.

M

MAC.  See Media Access Control.

MAC Address.   The hardware address of a
device connected to a shared network.

Maintenance Agreement Qualification
(MAQ). After a period of equipment service by
another vendor, the MAQ is the verification
procedure that ensures the equipment is
eligible for maintenance by IBM customer
engineers.

Maintenance Analysis Procedure (MAP). A
written or online set of procedures that guide
maintenance personnel through step-by-step
instructions for hardware fault isolation, repair,
and verification.

maintenance password authorization.   The
level-two password authorization that allows
access to a Director to perform maintenance
and operator functions. Contrast with
administrative password authorization and
operator password authorization.

management information system (MIS). (1)
management performed using automatic data
processing (I, A).  (2) An information system
that aids in performing management functions
(A).

MAP. See Maintenance Analysis Procedure

MAQ.  See Maintenance Agreement
Qualification.

matrix.  A matrix defines a Director’s address
configuration.  The three matrix types are
new matrix, saved matrix, and active matrix.
Synonym for configuration matrix.

Matrix Controller-2 (MXC2) card.  A Director
circuit card that replaces a standard MXC card
and upgrades the Director to support FICON
operation.
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Matrix Controller/Matrix Switch (MXC/MXS)
card. A set of Director circuit cards that makes
decisions on dynamic connection requests
between channels, control units attached to
the Director, and provides for connection paths
between ports.

MAU.  See Multistation Access Unit.

MB.  See megabyte.

Mbps.   Acronym for megabits per second.

MBps.   Acronym for megabytes per second.

MCL.  See microcode level.

Media Access Control (MAC).   In LANs, the
sublayer of the data link control layer that
supports media dependent functions and uses
the functions of the physical layer to provide
services to the logical link control sublayer.
The MAC sublayer includes a method of
determining when a device has access to the
transmission media.

megabyte (MB).   A unit of measure for data
storage, equal to 1,048,576 bytes.  Generally
approximated as one million bytes.

menu.   A list of items displayed on the
Console from which a user can make a
selection.  See also pull-down menu.

menu bar.   The menu bar is located across
the top of a Console window.  Pull-down
menus are displayed by clicking on the menu
bar option with the mouse, or by pressing Alt
with the underlined letter of the name for the
menu bar option.

MES.  See miscellaneous equipment
specification.

microcode level (MCL).   The release level
(1.0, 1.2, 2.0, etc.) of a set of developed and
tested microcode instructions that is made
public.

micrometer.   One millionth of a meter.

MIF.  See Multiple Image Facility.

MIS.  See management information system.

miscellaneous equipment specification
(MES).  A set of stand-alone instructions
provided by IBM that supports the installation
of a hardware or software replacement or
upgrade.

modem. Acronym for modulator/demodulator.
A device that converts digital computer data to
an analog signal that is transmitted over a tele-
communication line and converts a received
analog signal to digital data for the computer.

mouse.   In computer graphics, a hand-held
locating, pointing, and selection device.  A
mouse usually contains a control ball, and is
operated by moving it on a flat surface.

MTP.  See multifiber terminated push-on.

multifiber terminated push-on (MTP).   A 12-
fiber quick-disconnect push-on connector that
provides fast and effective reconnection of
processors and devices without disturbing
channel hardware configurations.

multimode optical fiber.   A graded-index or
step-index optical fiber that allows more than
one mode (light path) to propagate.  Contrast
with singlemode optical fiber.

Multiple Image Facility (MIF).   An IBM-
licensed program that allows multiple logical
partitions to concurrently share native ESCON
or FICON channels. This reduces the number
of channel paths required to support a
configuration.

Multiple Virtual Storage (MVS). The generic
name for an IBM-licensed operating system
used on System/370 and later mainframe pro-
cessors. See also virtual storage and OS/390.

Multistation Access Unit (MAU).   A cabling
or wiring attachment device that can connect
up to eight nodes to an IBM Token Ring
network.

MVS.  See Multiple Virtual Storage.
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MVS Configuration Program (MVSCP).  A
program that defines all available I/O devices
and channel paths to the MVS operating
system. Replaced by Hardware Configuration
Definition Program starting with MVS/ESA
Version 4.0.

MVSCP.  See MVS Configuration Program.

MVS/ESA.  Acronym for Multiple Virtual
Storage/Enterprise Systems Architecture.
See also MVS and ESA.

MXC2 card.  See Matrix Controller-2 card.

MXC/MXS card.  See Matrix Controller/Matrix
Switch card.

N

network.   An arrangement of hardware,
software, nodes, and connecting branches that
comprises a data communication system. The
ISO seven-layer specification partitions a
computer network into independent modules
from the lowest (physical) layer to the highest
(application) layer.

new matrix. A Director’s saved matrix that is
blank (contains default configuration attributes)
but does not have a saved name. It is used for
creating a new configuration, and updating a
saved matrix the first time configuration
changes are saved. Contrast with saved
matrix.

node. (1) In a network, a point at which one or
more functional units connect channels or data
circuits (I). In network topology, the point at an
end of a branch (T).

node port (N_port).  A port on a computer,
storage system, or other end device through
which the device performs Fibre Channel
communication. Contrast with fabric port. See
also thin fabric port.

nondisruptive installation.   The installation
of units or FRUs while normal equipment
operation continues without interruption.
Contrast with nondisruptive removal. See also
concurrent maintenance and hot pluggable.

nondisruptive removal. The removal of units
or FRUs without interrupting normal equip-
ment operation.  Contrast with nondisruptive
installation. See also concurrent maintenance
and hot pluggable.

nonvolatile.   A term used to describe a data
storage device or memory chip that retains its
contents when power is removed or off.

NP. IBM parts list acronym for Not Procurable.
NP indicates the part is not procurable and the
next higher assembly should be ordered.

N_port.  See node port.

NR. The IBM parts list acronym for Not
Recommended.  NR indicates the part is
procurable but is not recommended, and the
next higher assembly should be ordered.

O

octet.   An 8-bit quantity, often called a byte
or word, and often used to explain specific
segments of a LAN address.  A LAN address
is a 32-bit number in decimal format, normally
represented as four 8-bit octets with each byte
or octet separated by a decimal point.  See
also byte.

ohm.   A unit of electrical resistance equal to
that of a conductor in which a current of one
ampere is produced by a potential of one volt
across the conductor terminals.

Open Systems Interconnection (OSI).   A
model that represents a network as a hierar-
chical structure of functional layers.  Each
layer provides a set of functions that can be
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accessed and used by the layer above. Layers
are independent, in that implementation of a
layer can be changed without affecting other
layers.

operating system (OS).   Software that
controls execution of applications and provides
services such as resource allocation, schedul-
ing, I/O control, and data management.  Most
operating systems are predominantly soft-
ware, but partial hardware implementations
are possible (T).

operator password authorization.   The
level-three password authorization that allows
access to a Director to perform operator
functions only.  Contrast with administrative
password authorization and maintenance
password authorization.

optical cable. A single fiber, multiple fibers, or
a fiber bundle in a structure constructed to
meet certain optical, mechanical, or environ-
mental specifications (E).  See also jumper
cable, optical cable assembly, and trunk cable.

optical cable assembly.   A connector-
terminated optical cable.  The cable is
generally terminated by the manufacturer and
is ready for installation (E).  See also jumper
cable and optical cable.

optical drive backup .  A data backup system
that uses rewriteable optical cartridges
(ROCs) as the storage medium.

optical fiber connector.   A hardware compo-
nent that transfers optical power between two
optical fibers or bundles, and is designed to be
repeatedly connected and disconnected.

optical waveguide.   (1) A structure capable
of guiding optical power (E).  (2) In optical
communications, a fiber designed to transmit
optical signals.  See also optical fiber.

OS.  See operating system.

OS/2.  Acronym for Operating System 2, the
operating system developed by IBM for
personal computers.  The OS/2 licensed
program can perform multiple tasks at the
same time.

OS/390.  Acronym for Operating System 390,
an integrated, open-enterprise server operat-
ing system developed by IBM that incorporates
a leading-edge and open communications
server, distributed data and file services,
Parallel Sysplex support, object-oriented
programming, distributed computing environ-
ment, and open application interfaces.

OSI.  See Open Systems Interconnection.

P

parallel channel.   A data communications
channel that uses copper bus and tag cables
as a transmission medium, rather than fiber-
optic cables.  Contrast with ESCON channel
and FICON channel.

parameter.   (1) Variable that is given a con-
stant value for a specified application and that
may denote the application (I, A). (2) Item in a
menu for which the user specifies a value, or
for which the system provides a value when
the menu is interpreted.  (3) Data passed
between programs or procedures.

password.   A unique string of characters
known to a computer system, and to a user
who must specify the password to gain full
or limited access to the system and the
information stored within.

password identifier.   In a Director, a user-
defined symbolic name of 24 characters or
less that identifies the password user.
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path.   (1) In a network, any route between
two nodes (T).  (2) In systems network
architecture, the series of path control network
components (path control and data link con-
trol) traversed by the information exchanged
between two network-addressable units.

PC.  See personal computer.

PDCM.  See port dynamic connect mask.

personal computer (PC).   A portable
computer that consists of a system unit, dis-
play, keyboard, mouse, one or more diskette
drives, and internal fixed-disk storage.  PCs
are designed to give independent computing
power to a single user.

point-to-point. A Fibre Channel topology that
provides a single, direct connection between
two communication ports.  The Director
supports only point-to-point topology.

POR.  See Power-on Reset.

port. (1) An access point for data entry or exit.
(2) A receptacle on a device to which a cable
for another device is attached.

port address. In a Director, the address used
to specify port connectivity parameters and to
assign link addresses for attached channels
and control units.

port authorization.   Feature of the password
definition function that allows an administrator
to extend operator-level passwords to specific
port addresses for each Director definition
managed by a Console.  Port authorization
affects only operator-level actions for active
and saved matrices.

port card. In a fiber-optic environment, a FRU
that provides an optomechanical attachment
method for fiber cables, and performs specific
device-dependent logic functions.  See also
Device port card and FCV port card.

port dynamic connect mask (PDCM) .
Register that controls blocking between two
ports and defines the blocked status between
the ports. This provides information about
blocked status of two ports with a static
connection so requests can be denied for
dynamic connections.

port name.  In a Director, a user-defined
symbolic name of 24 characters or less that
identifies a port.

POST.  See Power-on Self-Test.

Power-on Reset (POR).   Method by which a
device is set to a prescribed or clear state.
The device is powered off, then powered on
and re-IPLed.

Power-on Self-Test (POST).   A series of
diagnostic tests that are automatically
executed by a device when the power is
switched on.

processor.   A computer’s functional unit
that interprets and executes instructions.  A
processor consists of an instruction control
unit and an arithmetic and logic unit. (I, A).

prohibited connection.   In a Director, the
attribute that when set, removes dynamic
connectivity capability.  Contrast with allowed
connection.

protective plug. In a fiber-optic environment,
a type of duplex connector (or cover) that
provides physical protection.  Contrast with
wrap plug.

protocol.  (1) Set of semantic and syntactic
rules that determines the behavior of
functional units in achieving communication
(I).  (2) In systems network architecture, the
meanings of and sequencing rules for
requests and responses for managing the
network, transferring data, and synchronizing
network component states. (3) A specification
for the format and relative timing of data
exchanged between communicating devices.
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pull-down menu.   A menu that is displayed
below, or pulled down from a menu bar at the
top of a window.

Q

quadrant.   One of four areas in a Director
where device port cards are installed.  The
quadrants are designated A through D.

query.   (1) The process by which a master
device asks a slave device for identification
and status (T). (2) For interactive systems, an
operation at a Console that elicits a response
from the system. (3) A request for information
from a file based on specific conditions.

queue.   (1) A list constructed and maintained
so the next data element to be retrieved is the
one stored first.  This method is characterized
as first in-first out (T). (2) A line or list of items
that is waiting to be processed.

R

R. The IBM parts list acronym for Restricted.
R indicates the part is procurable but has a
restricted availability.

RAM. See random access memory. See also
DRAM and SRAM, and contrast with ROM.

random access memory (RAM). A group of
computer memory locations that is numerically
identified to allow high-speed access by the
controlling microprocessor.  A memory loca-
tion is randomly accessed by referring to its
numerical identifier.  See dynamic random
access memory and static random access
memory, and contrast with read-only memory.

read-only memory (ROM). An information
storage chip with permanent memory.  Stored
information cannot be changed or deleted
except under special circumstances. Contrast
with random access memory.

rewriteable optical cartridge (ROC). A
plastic cartridge with a recording medium that
uses magneto-optical read/write technology,
and is removable from a computer and used to
store and transport data.

RI. See ring-in. Contrast with RO.

ring-in (RI). In an IBM Token Ring network,
the receive or input receptacle on a multista-
tion access unit. Contrast with ring-out.

ring-out (RO). In an IBM Token Ring network,
 the transmit or output receptacle on a
multistation access unit. Contrast with ring-in.

ring topology. A logically circular, unidirec-
tional transmission path without defined ends,
in which control is distributed or centralized.
See also Token Ring.

RO. See ring-out. Contrast with RI.

ROC. See rewriteable optical cartridge.

ROM. See read-only memory. Contrast with
RAM.

router. An attaching device that connects two
LAN segments, which use similar or different
architectures, at the reference model network
layer. Contrast with bridge.

row.   Horizontal arrangement of data.
Contrast with column.

RS-232. The EIA-recommended specification
for asynchronous serial interfaces between
computers and communications equipment. It
specifies both the number of pins and type of
connection, but does not specify the electrical
signals.
Glossary      237



S

SA. See Service Agreement.

SA OS/390.  See System Automation for
OS/390.

saved configuration.   In an ESCON or
FICON environment, a stored set of connectiv-
ity attributes whose values determine a
configuration used to replace all or part of a
Director’s active configuration matrix. Contrast
with active configuration.

saved matrix.  A matrix modified for a
particular purpose, then saved to the Director
Console fixed disk.  Multiple saved matrices
are maintained in the Console library for each
Director.  Contrast with new matrix.

SC Connector.   See subscriber connector.

SCP. See System Control Program.

SCSI. See small computer system interface.

Service Agreement (SA).   A tailored hard-
ware, software, or combined support contract
between IBM and the customer.

simplex. In data communication, pertaining to
transmission in only one direction at a time.
Contrast with duplex, synonym for half-duplex.

singlemode optical fiber.   An optical fiber
that allows one wavelength-dependent mode
(light path) to propagate.  Contrast with
multimode optical fiber.

small computer system interface (SCSI).
An input and output bus that provides a
standard interface between the OS/2 operating
system and peripheral devices.

software.   Computer programs, procedures,
rules, and associated documentation pertain-
ing to the operations of a system.  See also
application, and contrast with hardware.

spare ports card.   A card feature for the
Director that contains either four LED ports
(#5245), or two LED and two XDF ports
(#5255).

SRAM. See static random access memory.
See also RAM and contrast with DRAM.

static random access memory (SRAM).
SRAM is microprocessor-cache random
access memory.  SRAM is built internal to the
microprocessor or on external chips. SRAM is
fast, but relatively expensive.  See random
access memory and contrast with dynamic
random access memory.

stop bit. In start-stop transmission, a signal at
the end of a character that prepares the
receiving device for reception of a subsequent
character (I).

subnet mask.   For internet subnetworking, a
32-bit mask used to identify the subnetwork
address bits in the host portion of the IP
address.

subscriber connector (SC). A connector that
terminates fiber-optic jumper cables in two
housings (one transmit and one receive), and
provides physical keying for attachment to an
SC receptacle. An SC connector is
synonymous with an FCS connector. An SC
connector can attach to an FCV port card or
XDF laser port card.  See also Fibre Channel
Standard connector and multimode connector.

subsystem.   A secondary or subordinate
system, or programming support, usually
capable of operating independently of or
asynchronously with a controlling system (T).

SWCH.  The acronym used in ESCON
Manager to represent a Director and identify
the Director in the UNIT parameter.

switch. A synonym used in ESCON Manager
for a Director.  Identifies the Director in the
CHPID statement.
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Sysplex Timer.   An IBM table top unit that
provides the synchronization for time-of-day
clocks in multiple central processing
complexes.

System Automation for OS/390 (SA
OS/390). IBM-licensed software that provides
System/390 Parallel Sysplex management,
automation capabilities, and integrated
systems and network management.  SA
OS/390 manages host, remote processor, and
I/O operations.  SA OS/390 integrates the
functions of Automated Operations Control for
MVS, ESCON Manager, and Target System
Control Facility.

system configuration.   A process that
specifies the devices and programs that form
a particular data processing system.

System Control Program (SCP).   An IBM-
supplied program that is fundamental to the
operation and maintenance of a mainframe
system.  The software serves as an interface
with licensed programs and other user
programs.

T

Target System Control Facility (TSCF).   An
IBM-licensed program that designates one
processor in a Parallel Sysplex as a focal-point
system that controls target systems. The focal
point system can load, configure, start, control,
and monitor applications on target systems.
The focal point system can also coordinate
processes across systems.  TSCF functions
are now integrated into SA OS/390.

TCP.  See transmission control protocol.

TCP/IP. See transmission control
protocol/internet protocol.

Telecommunications Industry Association
(TIA).  TIA is a member organization of the
Electronic Industries Association, and is the
trade group representing the communications
and
information technology industries.  See also
EIA.

terminal.  In data communication, a device,
usually equipped with a keyboard and display,
capable of transmitting and receiving
information.  Synonym for Console or display
device.

thin fabric port (thin F_port).  The port
connection on the FCV port card that behaves
externally as an N_port, but has the F_port
ability to accept a fabric login (FLOGI)
command.  Contrast with node port.  See
also fabric port.

thin F_port.   See thin fabric port.

TIA.  See Telecommunications Industry
Association.  See also EIA.

tile.  Windows on a console are tiled to
simultaneously display all open windows
side-by-side in a reduced-size format.  No
overlapping of windows occurs.  To tile
windows, use the Window pull-down menu
and select Tile.  Contrast with Cascade.

TKRG.  See Token Ring Controller Adapter
card.

toggle. A procedure to change the state of a
feature. If the feature is On, toggling will turn it
Off, and vice versa.

token.   A sequence of bits passed from one
device to another on a Token Ring network
that signifies permission to transmit over the
network.  The token consists of a starting
delimiter, access control field, and end
delimiter.  If a device has data to transmit, it
appends the data to the token.
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Token Ring.   A LAN configuration where
devices attach to a network cable in a closed
path or ring. A token (unique sequence of bits)
circulates on the ring to allow devices to
access the LAN for data transmission.  See
also ring topology.

Token Ring Controller Adapter (TKRG)
card.   The circuit card that provides a port to
connect a Director to a 4/16 Mbps Token Ring
LAN. The card is labelled TKRG.

topology.   The physical or logical arrange-
ment of nodes in a computer network.

TPF.  See Transaction Processing Facility.

Transaction Processing Facility (TPF).
IBM-licensed software that supports
interactive applications in which requests
submitted at terminals are processed upon
receipt.  TPF provides a message-based,
real-time, high-capacity transaction processing
environment.

transmission control protocol (TCP).   The
transport layer for the TCP/IP protocol widely
used on Ethernet networks and any network
that conforms to U.S. Department of Defense
standards for network protocol. TCP provides
reliable communication and control through
full-duplex connections.

transmission control protocol/internet
protocol (TCP/IP).   A layered set of protocols
(network and transport) that allows sharing of
applications among devices on a high-speed
LAN communication environment.  See also
TCP and IP.

trunk cable.  In an fiber-optic environment, a
cable consisting of multiple fiber pairs that
does not directly attach to an active device.
The cable usually exists between distribution
panels and can be located within, or external
to, a building.  Contrast with jumper cable.

TSCF.  See Target System Control Facility.

U

UL.  See Underwriters Laboratories.

ULP.  See upper level protocol.

unblocked.   In a Director, the attribute that
when set, establishes communication capabil-
ity for a specific port.  Contrast with blocked.

Underwriters Laboratories (UL).   A
laboratory organization accredited by the
Occupational Safety and Health Administra-
tion, and authorized to certify products for use
in the home and workplace.

uninterruptable power supply (UPS).   A
buffer between public utility power or an other
power source, and a system that requires
precise, uninterrupted power.

URL. Acronym for Uniform Resource Locator.
A URL is the address of a document or other
resource on the internet.

upper level protocol (ULP).   Protocols that
map to and run on top of Fibre Channel FC-4
layer.  Upper level protocols include IP and
SCSI.

UPS.  See uninterruptable power supply.

V

Vac.  Acronym for volts alternating current.
See alternating current.

Vdc.  Acronym for volts direct current.  See
direct current.

Virtual Machine (VM).   (1) A virtual data
processing system that appears to be at the
exclusive disposal of a single user, but whose
functions are accomplished by sharing the
resources of a real data processing system.
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(2) A functional simulation of a computer
system and its associated devices, multiples of
which can be controlled concurrently by one
operating system.

Virtual Storage (VS).  (1) Storage space that
may be regarded as addressable main storage
by the user of a computer system in which
virtual addresses are mapped to real
addresses.  The size of virtual storage is
limited by the addressing scheme of the
computer system and by the amount of
auxiliary storage available, not by the number
of main storage locations.  (2) Addressable
space that is apparent to the user as proces-
sor storage space, from which the instructions
and the data are mapped to the processor
storage locations.

Virtual Storage Extended (VSE).  An
IBM-licensed software operating system that
controls the execution of programs.

VM.  See Virtual Machine.

VM/ESA.  Acronym for Virtual Machine/
Enterprise Systems Architecture.  See also
VM and ESA.

volt.   A measure of the difference in electrical
potential between two points in a conductor,
equal to one ohm resistance carrying a
constant current of one ampere, with a power
dissipation of one watt.

VS.  See Virtual Storage.

VSE.  See Virtual Storage Extended.

W

watt.   A unit of power in the International
System equal to one joule (Newton-meter) per
second.

warning message.   An indication that a
system error or other problem has been
detected.  See also error message and
information message.

window. A portion of the Director Console
screen in which one of several concurrent
applications or data sets can display informa-
tion.  The user sees what appears to be
several sheets of paper, much as the sheets
would appear on a desktop. See also cascade
and tile.

Windows. A graphical user interface and
windowing system introduced by Microsoft
Corporation in 1985.  Windows runs on top of
the MS-DOS operating system.

Win-OS/2. Win-OS/2 is the Windows compo-
nent of IBM’s OS/2 Version 2.0 operating
system.  It is based partially on Windows 3.0
and Windows 3.1.  Win-OS/2 is the operating
system used by the Director Console
application.

wrap plug.   (1) A connector attached to the
plug end of a cable that connects input and
output pins together for testing. See wrap test.
(2) In a fiber-optic environment,  a type of
duplex connector used to wrap the optical
output signal of a device directly to the optical
input.  Contrast with protective plug.

wrap test.   A test that checks attachment or
control unit circuitry, without checking the
mechanism itself, by returning the output of the
mechanism as input. A wrap test can transmit
a specific character pattern through a system,
and compare the pattern received with the
pattern transmitted.

X

XDF.  See Extended Distance Feature.
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Index

Numerics
9032-003 Director

ac line filters, 24
compared with 9032-002 Director, 5
compared with 9033-004 and

9032-005 Directors, 3
components, 21
description, 9
ESD components, 24
fan, 22
fiber-optic cable routing, 24
logic board assembly, 25
logic cards, 22
operator panel, 21
power cables, 24
power sense cables, 25
power supply, 22
power switch, 21
safety labels, 24
storage compartment, 24

9032-005 Director
ac line filters, 35
compared with 9032-003 and

9033-004 Directors, 3
components, 30
description, 10
ESCON-only operation, 11
ESD components, 36
fan, 31
fiber-optic cable routing, 36
FICON converter, 11
FICON upgrade features, 4
logic board assembly, 36
logic cards, 32

operator panel, 31
power cables, 35
power sense cables, 37
power supply, 31
power switch, 31
safety labels, 36
storage compartment, 36

9033-004 Director
ac line filter, 30
compared with 9032-003 and

9032-005 Directors, 3
compared with 9033-001 Director, 4
components, 26
description, 10
ESD components, 30
fan, 27
fiber-optic cable routing, 30
logic board assembly, 29
logic cards, 28
operator panel, 26
power cord, 30
power supply, 27
power switch, 27
safety labels, 30
storage compartment, 30

A
ac line filters

9032-003 Director, 24
9032-005 Director, 35
9033-004 Director, 30

accelerator keys (keyboard), 43

Activate Configuration Matrix dialog box, 80

activate configuration matrix option
(File menu), 80
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active = saved option
Activate Configuration Matrix

dialog box, 80
Utility menu, 109

active configuration matrix
active = saved option, 80
address selection highlight, 140
description, 78
invalid cell locations, 140
merge with saved configuration matrix, 79
opening, 57
port attribute symbols, 140
storing, 15

Add New Password dialog box, 175, 179

adding passwords, 174

administrative authorization password, 62

administrative functions
adding a password, 174
changing Director IP address, 184
changing Director MAC address, 186
creating an LPAR, 178
deleting a LIC version, 173
deleting a password, 177
deleting an LMA version, 165
installing a backup console, 191
installing a LIC version, 167
installing a replacement console, 190
installing an LMA version, 161
modifying a password, 176
synchronizing time and date, 193

advanced option (Maintenance menu)
LMA versions option, 134
terminal option, 133

allowed attribute
allow row option (Edit menu), 86
description, 3
hierarchy, 142

arrange icons option (Window menu), 69

Authorize Range dialog box, 111, 181

B
back up data files, 15

backup console
description, 42
installing, 192
maintaining, 192
using, 192

Block Address Range dialog box, 87

blocked attribute
block range option (Edit menu), 87
blocked option (Edit menu), 86
configuring, 150, 157
description, 2
hierarchy, 142
Matrix window symbols, 141

C
cables

fiber-optic
9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

power
9032-003 Director, 24
9032-005 Director, 35

power sense
9032-003 Director, 25
9032-005 Director, 37

cascade option (Window menu), 68

clear system error option (Utility menu), 113

close window option (File menu), 84

Collect Maintenance Information
dialog box, 136

collect maintenance information option
(Maintenance menu), 136
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Command List - Copy dialog box, 99

Command List - Edit dialog box, 97

Command List - Execute dialog box, 94

Command List - Information dialog box, 99

Command List - Operational Status
dialog box, 95

Command List - View/Modify dialog box, 96

command list function
adding commands, 97
command lists option (Edit menu), 92
copying command lists, 99
deleting command lists, 98
deleting commands, 98
error messages, 95, 211
executing, 94
modifying commands, 98
save to file, 95
valid commands, 92

Command Lists dialog box, 93

configuration matrix
active, 57
creating (ESCON), 145
creating (FICON), 153
new, 51
saved, 55

connectivity matrix (Matrix window), 73

Console Audit log
Console Audit log option

(Utility menu), 63, 111
description, 63
maximum number of entries, 65

Console Error log
Console Error log option

(Utility menu), 64, 111
description, 64
maximum number of entries, 65

Console Link Statistics dialog box, 137

Console link statistics option
(Maintenance menu), 137

contents option (Help menu), 69

control buttons
9032-003 Director, 22
9032-005 Director, 31
9033-004 Director, 27

control unit port
CUP name option (Edit menu), 89
default CUP name, 90

Copy Matrix Configuration File dialog box, 83

copy matrix configuration file option
(File menu), 83

copy option (Edit menu), 85

creating an LPAR, 178

CTP card
9032-003 Director, 22
9032-005 Director, 32
9033-004 Director, 28
enhanced availability, 23, 32

D
date

synchronizing Director and Console, 193
time/date option (Utility menu), 108

DCAF software, 40

dedicated attribute
configuring, 148, 156
dedicated option (Edit menu), 86
description, 2
hierarchy, 142
Matrix window symbols, 141
Index      245



deleting
LIC version, 173
LMA version, 165
passwords, 177

description
9032-003 Director, 9
9032-005 Director, 10
9033-004 Director, 10
Director Console, 12

dialog boxes
Activate Configuration Matrix, 80
Add New Password, 175, 179
alert messages, 213
Authorize Range, 111, 181
Block Address Range, 87
Collect Maintenance Information, 136
Command List - Copy, 99
Command List - Edit, 97
Command List - Execute, 94
Command List - Information, 99
Command List - Operational Status, 95
Command List - View/Modify, 96
Command Lists, 93
Console Link Statistics, 137
Copy Matrix Configuration File, 83
Director Definition, 52, 186
Director Information, 54
Director Operational Status, 106
Display Options, 104
Edit LIC Description, 168
Edit LMA Description, 163
Enter Address Position, 102
Enter Filename, 134
LIC Versions, 58, 167
LMA Versions, 135, 162
Matrix Map, 101
Merge Saved Configuration, 79
Modify Password, 176
Name and States, 88
Name for Address, 90
Name for CUP, 89
New LIC Version, 168
New LMA Version, 162

Node Descriptor, 107
Online ESCON Port Diagnostics, 131
Online FICON Port Diagnostics, 132
Passwords, 60, 175
Port Authorization, 110, 180
Port Swapping, 130
Product Information, 70
Prohibit Address Range, 86
Save As, 96
Save Configuration Matrix As, 81
Saved Matrix Information, 56, 82
Select Active Director, 57, 184, 187, 193
Select Director for New Matrix, 51
Select Saved Configuration Matrix, 55
Set Director Time and Date, 108, 194

Director
description, 9
dynamic connectivity, 6
introduction, 1
LAN addresses, 183
model comparison, 3
monitoring multiple Directors, 77
purpose, 2
system configuration, 5

Director Audit log
description, 120
Director Audit log option

(Maintenance menu), 119
maximum number of entries, 119

Director Console
back up data files, 15
backup console, 42
considerations for using, 14
DCAF software, 40
introduction, 12
keyboard, 42
messages, 195
mouse, 42
operations, 41
PC platforms, 14, 39
remote console, 40
replacement console, 41
TCP/IP software, 40
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Director Console application
Matrix window, 44
starting, 49
Startup window, 44, 49

Director Definition dialog box, 52, 186

Director Event log
description, 121
Director Event log option

(Maintenance menu), 120
maximum number of entries, 120

Director Information dialog box, 54

Director LIN log
description, 118
Director LIN log option

(Maintenance menu), 117
maximum number of entries, 117

Director Operational Status dialog box, 106

Director operational status option
(Utility menu), 106

Director status indicator (Matrix window), 74

display options (View menu), 103

Display Options dialog box, 104

DVP card
9032-003 Director, 24
9032-005 Director, 33
9033-004 Director, 29
determine type, 19
LED, 18
XDF laser, 18

dynamic connectivity
changing, 8
description, 6
functions, 7
hierarchy, 8

E
Edit LIC Description dialog box, 168

Edit LMA Description dialog box, 163

Edit menu options
allow row, 86
block range, 87
blocked, 86
command lists, 92
copy, 85
CUP name, 89
dedicated, 86
enable operator, 91
name and states, 87
names, 90
paste, 85
prohibit range, 86
prohibit row, 86
prohibited, 86

electronic emission notices, xix

enable operator option (Edit menu), 91

enhanced availability
CTP card

9032-003 Director, 23
9032-005 Director, 32

description, 4
MXC/MXS card

9032-003 Director, 24
9032-005 Director, 35

TKRG controller adapter card
9032-003 Director, 24
9032-005 Director, 33

Enter Address Position dialog box, 102

Enter Filename dialog box, 134

enter position option (View menu), 101

error messages
alert dialog boxes, 213
attribute settings, 196
command list, 95, 211
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copy matrix, 205
Director definition, 204
Director/Console communications, 201
file access, 207
LIC install, 210
miscellaneous, 216
port authorization, 209
status line, 198

ESCON
creating a new configuration matrix, 145
definition, 1
Director operation, 11
port diagnostics, 130

ESD components
grounding point

9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

static pad
9032-003 Director, 24
9032-005 Director, 36

exit option (File menu), 57, 84

F
fan

9032-003 Director, 22
9032-005 Director, 31
9033-004 Director, 27

FCV port card
9032-005 Director, 34
description, 17

fiber-optic cable routing
9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

FICON
converter feature, 11
creating a new configuration matrix, 153
definition, 1
port diagnostics, 132
upgrade features, 4

field-replaceable units
9032-003 Director

fan, 22
logic board assembly, 25
logic cards, 22
operator panel, 21
power supply, 22
power switch, 21

9032-005 Director
fan, 31
logic board assembly, 36
logic cards, 32
operator panel, 31
power supply, 31
power switch, 31

9033-004 Director
fan, 27
logic board assembly, 29
logic cards, 28
operator panel, 26
power supply, 27

File menu options
activate configuration matrix, 80
close window, 84
copy matrix configuration file, 83
exit, 57, 84
for Console log windows, 65
for Director log windows, 116
merge saved configuration, 79
new configuration matrix, 51
open active configuration matrix, 57
open saved configuration matrix, 55
print matrix to text file, 84
save configuration matrix, 81
save configuration matrix as, 81
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Font menu options
for Console log windows, 67
for Director log windows, 117

G
graphic display mode

description, 102
graphic display option (View menu), 102

grounding point
9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

H
Hardware Audit log

description, 123
Hardware Audit log option

(Maintenance menu), 123

Hardware Configuration window
9032-003 Director, 122
9032-005 Director, 123
9033-004 Director, 122
description, 121
hardware configuration option

(Maintenance menu), 121

hardware status indicators (Matrix window), 72

Help menu options
contents, 69
keyboard, 69
mouse, 69
product information, 70
using help, 69

I
IML button

9032-003 Director, 21
9032-005 Director, 31
9033-004 Director, 27

IML function
9032-003 Director, 21
9032-005 Director, 31
9033-004 Director, 27
description, 16

installing
backup console, 192
LIC version, 167
LMA version, 161
replacement console, 190

introduction
Director Console, 12
ESCON Director, 1

IP address
changing, 184
description, 183

IPL function
description, 16
IPL Director option (Utility menu), 111
IPL matrix, 79

IPL matrix, 79

K
keyboard

accelerator keys, 43
Matrix window navigation, 144
navigation keys, 42

keyboard option (Help menu), 69
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L
labels

9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

LAN addresses
changing Director IP address, 184
changing Director MAC address, 186

laser compliance statements, xiii

LED port card
9032-003 Director, 24
9032-005 Director, 34
9033-004 Director, 29
description, 18

LIC Versions dialog box, 58, 167

licensed internal code
deleting, 173
installation error messages, 210
installing, 167
LIC versions option (Utility menu), 58, 109

link status indicator (Matrix window), 74

LMA Versions dialog box, 135, 162

loader/monitor area code
deleting, 165
installing, 161
LMA versions option

(Maintenance menu), 134

log windows
Console Audit, 63
Console Error, 64
description, 45
Director Audit, 120
Director Event, 121
Director LIN, 118
File menu, 65
Font menu (Console), 67

Font menu (Director), 117
Hardware Audit, 123
Node Descriptor list, 124
operation of, 65, 116

logic board assembly
9032-003 Director, 25
9032-005 Director, 36
9033-004 Director, 29

logic cards
9032-003 Director

CTP card, 22
DVP card, 24
MXC/MXS card, 24
TKRG controller adapter card, 23

9032-005 Director
CTP card, 32
DVP card, 33
FCV port card, 34
MXC/MXS card, 34
spare ports card, 34
TKRG controller adapter card, 32

9033-004 Director
CTP card, 28
DVP card, 29
MXC/MXS card, 29
TKRG controller adapter card, 28

logical partitions
creating, 178
defining operator password, 179
defining port authorizations, 180
enabling an LPAR, 182
LPAR capability, 20

logical port addresses (Matrix window), 71

M
MAC address

changing, 186
description, 183
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maintenance authorization password, 62

Maintenance menu options
advanced

LMA versions, 134
terminal, 133

collect maintenance information, 136
Console link statistics, 137
Director Audit log, 119
Director Event log, 120
Director LIN log, 117
Hardware Audit log, 123
hardware configuration, 121
Node Descriptor list, 124
port diagnostics (Port Maintenance

window), 130
port maintenance, 127
swap ports (Port Maintenance

window), 129

Matrix Map dialog box, 101

matrix map option (View menu), 101

Matrix window
address selection highlight, 140
connectivity matrix, 73
description, 71
Edit menu, 84
File menu, 77
hardware status indicators, 72
invalid cell locations, 140
logical port addresses, 71
Maintenance menu, 114
menu bar, 44
menu options, 76
port attribute symbols, 140
port names, 71
status line, 73
Utility menu, 104
View menu, 99

menu bar
Matrix window, 44
Startup window, 44

menu options
Edit menu, 84
File menu, 50, 77
Help menu, 69
Maintenance menu, 114
Startup window, 50
Utility menu, 58, 104
View menu, 99
Window menu, 67

Merge Saved Configuration dialog box, 79

merge saved configuration option
(File menu), 79

message area (Matrix window), 75

messages
alert dialog boxes, 213
attribute setting errors, 196
command list errors, 95, 211
copy matrix errors, 205
Director definition, 204
Director/Console communication

errors, 201
file access errors, 207
LIC install errors, 210
miscellaneous, 216
port authorization errors, 209
status line, 198

Modify Password dialog box, 176

modifying passwords, 176

monitoring multiple Directors, 77

mouse option (Help menu), 69

mouse usage
Director Console, 42
Matrix window, 142

MXC/MXS card
9032-003 Director, 24
9032-005 Director, 34
9033-004 Director, 29
enhanced availability, 24, 35
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N
Name and States dialog box, 88

name and states option (Edit menu), 87

Name for Address dialog box, 90

Name for CUP dialog box, 89

names option (Edit menu), 90

navigation keys (keyboard), 42

new configuration matrix
creating (ESCON), 145
creating (FICON), 153
description, 52
new configuration matrix option

(File menu), 51

new configuration matrix option (File menu), 51

New LIC Version dialog box, 168

New LMA Version dialog box, 162

Node Descriptor dialog box, 107

Node Descriptor list
9032-003 Director, 125
9032-005 Director, 126
9033-004 Director, 126
description, 124
Node Descriptor list option

(Maintenance menu), 124

node descriptor option (Utility menu), 106

nongraphic display mode
description, 103
graphic display option (View menu), 103

notational conventions, xxv

notices
electronic emission, xix
laser compliance, xiii

O
Online ESCON Port Diagnostics
dialog box, 131

Online FICON Port Diagnostics dialog box, 132

open active configuration matrix option
(File menu), 57

open saved configuration matrix option
(File menu), 55

operator authorization password, 62

operator panel
9032-003 Director, 21
9032-005 Director, 31
9033-004 Director, 26

OS/2 desktop, 189

P
passwords

adding, 174
administrative authorization, 62
deleting, 177
maintenance authorization, 62
modifying, 176
operator authorization, 62
passwords option (Utility menu), 60, 109

Passwords dialog box, 60, 175

paste option (Edit menu), 85

port attributes
description, 2
hierarchy, 8, 142
symbols, 140
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port authorization
creating an LPAR, 180
description, 92
enable operator option (Edit menu), 91
error messages, 209
port authorization option (Utility menu), 109

Port Authorization dialog box, 110, 180

port cards
determine type, 19
FCV, 17
LED, 18
spare ports, 19
XDF laser, 18

port diagnostics option (Port Maintenance
window)

ESCON, 130
FICON, 132

Port Maintenance window
9032-003 Director, 127
9032-005 Director, 128
9033-004 Director, 128
description, 47, 127
port diagnostics option

ESCON, 130
FICON, 132

port maintenance option
(Maintenance menu), 127

swap ports option, 129

port names (Matrix window), 71

Port Swapping dialog box, 130

power cables
9032-003 Director, 24
9032-005 Director, 35

power cord, 9033-004 Director, 30

power indicator
9032-003 Director, 21
9032-005 Director, 31

9033-004 Director, 26

power sense cables
9032-003 Director, 25
9032-005 Director, 37

power supply
9032-003 Director, 22
9032-005 Director, 31
9033-004 Director, 27

power switch
9032-003 Director, 21
9032-005 Director, 31
9033-004 Director, 27

print matrix to text file option (File menu), 84

Product Information dialog box, 70

product information option (Help menu), 70

Prohibit Address Range dialog box, 86

prohibited attribute
configuring, 147
description, 3
hierarchy, 142
Matrix window symbols, 142
prohibit range option (Edit menu), 86
prohibit row option (Edit menu), 86
prohibited option (Edit menu), 86

publications
intended audience, xxiii
related, xxiv

R
related publications, xxiv

remote console, 40

remote offline control option (Utility menu), 109
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replacement console
description, 41
installing, 190
maintaining, 191
using, 191

S
safety

grounding point
9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

labels
9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

laser compliance statements, xiii
static pad

9032-003 Director, 24
9032-005 Director, 36

Save As dialog box, 96

Save Configuration Matrix As dialog box, 81

save configuration matrix as option
(File menu), 81

save configuration matrix option
(File menu), 81

saved configuration matrix
active = saved option, 80
address selection highlight, 140
description, 78
invalid cell locations, 140
IPL matrix, 79
merge with active configuration matrix, 79
opening, 55
port attribute symbols, 140

Saved Matrix Information dialog box, 56, 82

Select Active Director dialog box, 57, 184,
187, 193

Select Director for New Matrix dialog box, 51

Select Saved Configuration Matrix
dialog box, 55

set Director offline option (Utility menu), 112

Set Director Time and Date
dialog box, 108, 194

software
DCAF, 40
deleting a LIC version, 173
deleting an LMA version, 165
installing a LIC version, 167
installing an LMA version, 161
TCP/IP, 40

spare ports card
9032-005 Director, 34
description, 19
feature, 4

start Director Console application, 49

Startup window
description, 44
File menu, 50
Help menu, 69
menu bar, 44
menu options, 50
Utility menu, 58
Window menu, 67

static pad
9032-003 Director, 24
9032-005 Director, 36

status display
9032-003 Director, 21
9032-005 Director, 31
9033-004 Director, 26
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status line
Director status indicator, 74
link status indicator, 74
message area, 75
messages, 198
system error indicator, 75

storage compartment
9032-003 Director, 24
9032-005 Director, 36
9033-004 Director, 30

swap axis option (View menu), 100

swap ports option (Port Maintenance
window), 129

system configuration with Directors, 5

system error indicator
9032-003 Director, 22
9032-005 Director, 31
9033-004 Director, 27
clearing, 113
Matrix window, 75

T
TCP/IP software, 40

terminal option (Maintenance menu), 133

Terminal window
changing Director IP address, 185
changing Director MAC address, 188
description, 46
terminal window option

(Maintenance menu), 133

tile option (Window menu), 67

time
synchronizing Director and Console, 193
time/date option (Utility menu), 108

time/date option (Utility menu), 108

TKRG controller adapter card
9032-003 Director, 23
9032-005 Director, 32
9033-004 Director, 28
enhanced availability, 24, 33

trademarks, xxi

U
upgrade 9032-005 Director for FICON, 4

using help option (Help menu), 69

Utility menu options
active = saved, 109
clear system error, 113
Console Audit log, 63, 111
Console Error log, 64, 111
Director operational status, 106
IPL Director, 111
LIC versions, 58, 109
node descriptor, 106
passwords, 60, 109
port authorization, 109
remote offline control, 109
set Director offline, 112–113
time/date, 108

V
View menu options

display options, 103
enter position, 101
graphic display, 102
matrix map, 101
swap axis, 100
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W
window list, 184, 187

Window menu options
arrange icons, 69
cascade, 68
tile, 67

windows
Hardware Configuration window, 121
log windows, 45
Matrix window, 44, 71
OS/2 desktop, 189
Port Maintenance window, 47, 127

Startup window, 44, 49
Terminal window, 46, 133
types of application windows, 43

X
XDF laser port card

9032-003 Director, 24
9032-005 Director, 34
9033-004 Director, 29
description, 18
256 Using the 9032 Model 3, 9033 Model 4, and 9032 Model 5 Directors



Communicating Your Comments to IBM

S/390
Using the 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director,
and 9032 Model 5 Director

Publication Number SA22-7296-01

If you especially like or dislike anything about this book, please use one of the
methods listed below to send your comments to IBM. Whichever method you choose,
please send your name, address, and telephone number if you would like a reply.

Feel free to comment on specific errors or omissions, accuracy, organization, subject
matter, or completeness of this book.  However, the comments you send should
pertain to only the information in this manual and the way in which the information
is presented.  To request additional publications, or to ask questions or to make
comments about the functions of IBM products or systems, you should talk to your
IBM representative or to your IBM-authorized remarketer.

When you send comments to IBM, you grant IBM a nonexclusive right to use or
distribute your comments in any way it believes appropriate without incurring any
obligation to you.

If you are mailing a reader’s comment form (RCF) from a country other than the
United States, you can give the RCF to the local IBM branch office or IBM
representative for postage-paid mailing.

• If you prefer to send comments by mail, print, complete, and mail the RCF
(two pages) provided at the back of this publication.

• If you prefer to send comments by FAX, use this number:

— FAX:  (International Access Code)+1+914+432-9405

• If you prefer to send comments electronically, use one of these network IDs:

— IBM Mail Exchange:  USIB6TC9 at IBMMAIL

— Internet e-mail:  mhvrcfs@us.ibm.com

— World Wide Web:  http://www.ibm.com/s390/os390/

Include the following in your note:

• Title and publication number of this book.

• Page number or topic to which your comment applies.

Optionally, if you include your telephone number, we can respond to your comments
by phone.



ut
long
ine

ut
long
ine
Reader’s Comments - We’d like to Hear from You

S/390
Using the 9032 Model 3 ESCON Director, 9033 Model 4 ESCON Director,
and 9032 Model 5 Director

Publication Number SA22-7296-01

You may use this form to communicate your comments about this publication, its organization, or
subject matter, with the understanding that IBM may use or distribute whatever information you
supply in any way it believes appropriate without incurring any obligation to you.  Your comments
will be sent to the author’s department for whatever review and action, if any, are deemed
appropriate.

Note: Copies of IBM publications are not stocked at the location to which this form is addressed.
Please direct any requests for copies of publications, or for assistance in using your IBM system,
to your IBM representative or to the IBM branch office serving your locality.

Today’s date: ____________________________________

What is your occupation?

Newsletter number of latest Technical Newsletter (if any) concerning this publication:

How did you use this publication?

[   ]    As an introduction [   ]    As a text (student)

[   ]    As a reference manual [   ]    As a text (instructor)

[   ]    For another purpose (explain)

Is there anything you especially like or dislike about the organization, presentation, or writing in
this manual?  Helpful comments include general usefulness of the book; possible additions,
deletions, and clarifications; and specific errors and omissions.

Page Number: Comment:

Name Address

Company or Organization

Phone Number

C
A
L

C
A
L



ut
long
ine

ut
ong
ine
Reader’s Comments - We’d Like to Hear from You

SA22-7296-01

Fold and Tape Please do not staple Fold and Tape

BUSINESS REPLY MAIL
FIRST-CLASS MAIL   PERMIT NO. 40   ARMONK, NEW YORK

POSTAGE WILL BE PAID BY ADDRESSEE

IBM Corporation
Department 55JA, Mail Station P384
522 South Road
Poughkeepsie, NY  12601-5400

Fold and Tape Please do not staple Fold and Tape

SA22-7296-01

NO POSTAGE
NECESSARY
IF MAILED IN THE
UNITED STATES

R

C
A
L

C
Al
L



R

SA22-7296-01


	Notices
	Laser Compliance
	Electronic Emission Notices
	Trademarks and Service Marks

	About This Publication
	Who Should Use This Publication
	How To Use This Publication
	What Is Included in This Publication
	Related Publications
	Notational Conventions

	Chapter 1. lntroduction
	Enterprise Systems Connection Directors
	Purpose of the Director
	Comparing 9032-003, 9033-004, and 9032-005 Directors
	Comparing 9033-001 and 9033-004 Directors
	Comparing 9032-002 and 9032-003 Directors

	System Configuration and ESCON Directors
	Dynamic Connectivity and Directors
	Dynamic Connectivity
	Change Dynamic Connectivity
	Dynamic Connectivity Hierarchy

	ESCON Director Description
	9032-003 Director
	9033-004 Director
	9032-005 Director

	Director Console
	Console Considerations
	Automatic Backup of Data Files
	Storing Active Configuration Matrices
	IML and IPL Functions

	Port Cards
	FCV Port Cards
	LED Port Cards
	XDF Laser Port Cards
	Spare Ports Card
	Determine Port Type

	Logical Partition Capability
	9032-003 Director Components
	Power Switch
	Operator Panel
	Power Supply and Fan Assemblies
	Logic Cards
	Power Cables and Line Filters
	Fiber-Optic Cable Routing, Labels, Static Pad, and Storage
	Cabling and Labels - Rear Access
	Logic Board Assembly

	9033-004 Director Components
	Operator Panel
	Power Supply and Fan Assemblies
	Logic Cards
	Logic Board Assembly
	Storage Compartment
	Power Cord and Line Filter
	Cable Routing, ESD Ground Point, and Safety Label

	9032-005 Director Components
	Power Switch
	Operator Panel
	Power Supply and Fan Assemblies
	Logic Cards
	Power Cables and Line Filters
	Logic Board Assembly
	Fiber-Optic Cable Routing, Labels, Static Pad, and Storage
	Cabling and Labels - Rear Access


	Chapter 2. The Director Console
	Console Platforms
	Console Operations
	Mouse
	Keyboard
	Accelerator Keys

	Menu and Window Types
	Startup Window Menu Bar
	Matrix Window Menu Bar
	Log Windows
	Terminal Window
	Port Maintenance Window

	Startup Window Menu Options
	Startup File Menu
	New Configuration Matrix
	Open Saved Configuration Matrix
	Open Active Configuration Matrix
	Exit

	Startup Utility Menu
	LIC Versions
	Passwords
	Console Audit Log
	Console Error Log
	Console Log Operation

	Window Menu
	Help Menu

	Chapter 3. Matrix Window Operations
	Matrix Window
	Port Addresses and Names
	Status Columns
	Connectivity Matrix
	Scrolling and Matrix Map
	Status Line
	Link Status Indicator
	Director Status Indicator
	System Error Indicator
	Message Area
	Matrix Window Menu Options
	Monitoring Multiple Directors

	Matrix File Menu
	Matrix Types
	Merge Saved Configuration
	Activate Configuration Matrix
	Save Configuration Matrix
	Save Configuration Matrix As
	Copy Matrix Configuration File
	Print Matrix to Text File
	Close Window
	Exit

	Matrix Edit Menu
	Copy and Paste
	Blocked, Dedicated, and Prohibited
	Prohibit Row and Allow Row
	Prohibit Range
	Block Range
	Name and States
	CUP Name
	Names
	Enable Operator
	Command Lists

	Matrix View Menu
	Swap Axis
	Matrix Map
	Enter Position
	Graphic Display
	Display Options

	Matrix Utility Menu
	Director Operational Status
	Node Descriptor
	Time/Date
	Active = Saved
	Remote Offline Control
	LIC Versions
	Passwords
	Port Authorization
	Console Audit Log
	Console Error Log
	IPL Director
	Set Director Offline
	Clear System Error
	Reset Installation Defaults

	Matrix Maintenance Menu
	Director Log Operation
	Director LIN Log
	Director Audit Log
	Director Event Log
	Hardware Configuration
	Hardware Audit Log
	Node Descriptor List
	Port Maintenance
	Advanced
	Collect Maintenance Information
	Console Link Statistics


	Chapter 4. Configuring Port Connections
	Matrix Highlights and Symbols
	Address Selection Highlight
	Invalid Cell Locations
	Port Attribute Symbols

	Connectivity Hierarchy
	Using the Mouse
	Matrix Keyboard Support
	Creating a New Configuration Matrix (ESCON Only)
	Creating a New Configuration Matrix (ESCON and FICON)

	Chapter 5. Console Administrative Functions
	Installing or Deleting an LMA Version
	Installing an LMA Version
	Deleting an LMA Version

	Installing or Deleting a LIC Version
	Installing a LIC Version
	Deleting a LIC Version

	Adding, Modifying, and Deleting Passwords
	Adding a Password
	Modifying a Password
	Deleting a Password

	Creating Logical Partitions
	Changing Director LAN Addresses through the Console
	Changing the Director IP Address
	Changing the Director MAC Address

	Maintaining and Using a Replacement or Backup Console
	Replacement Console
	Backup Console

	Synchronizing Director Time and Date with Console Time and Date

	Appendix A. Console Messages
	Matrix Window Messages Setting Attributes
	Status Line Messages
	Error Messages During Director and Console Exchange
	Director Definition Dialog Messages
	Copy Matrix Messages
	Matrix Window File Access Messages
	Port Authorization Messages
	LIC Install Messages
	Command List Error Messages
	Alert Dialog with Error Code
	Miscellaneous Messages

	Glossary
	Index
	Communicating Your Comments to IBM
	Reader’s Comments - We’d like to Hear from You

